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1. PI System 基础知识 

1.1 什么是 PI System？ 

目标 

• 定义 PI System 的组件。  

• 绘制 PI System 的体系结构示意图。 

1.1.1 PI System 简介 

PI System 可收集、存储和管理您的工厂或流程中的数据。您可将数据源连接到一个

或多个 PI 接口节点。PI 接口节点从您的数据源收集数据并将其存储到 PI Data 

Archive。 

Asset Framework (AF) 整理和增强数据。用户通过使用诸如 PI Vision 等 PI 

Visualization Suite (PVS) 工具来使用数据。 

 

下面是简单的 PI System 组件的示意图： 
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1.1.2 PI System 组件 

更详细地来说，以下组件构成了 PI Server： 
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Data Archive 

PI Data Archive 是 PI Server 的组件，可以高效存储

和归档时间序列数据，从而实现客户端软件的高性

能数据检索。  

注意：传统上，PI Data Archive 被称为“PI Server”。 

Asset Framework 

PI Asset Framework (PI AF) 是以资产为中心的模

型、层次结构、对象和设备的单个存储库。它可以

集成、构建上下文关系、精确化、引用以及进一步

分析来自多个来源的数据，包括一个或多个 PI Data 

Archive 以及诸如外部关系数据库等非 PI 源。 

资产分析 

PI Asset Framework (PI AF) 中的一项功能，可用于

创建和管理分析。分析读取 PI AF 属性的值，执行

计算并将结果写入其他属性或创建事件框架。 

事件框架 

事件框架帮助您捕获、跟踪、比较或分析重要的流

程或业务事件及其在重复时间段内的相关数据。事

件框架表示您希望了解的事件在流程中重复发生的

情况，例如资产停机时间、流程偏移、设备启动或

关闭、环境偏移、产品跟踪批次、产品运行或操作

员轮班。 

通知 

当发生关键事件时，PI System 可以向用户或系统发

送通知。您可以设置定义这些事件的条件，并为它

们指定通知，包括收件人和要采取的操作，例如收

件人联系不到时要执行的操作。在操作中，PI 

System 会检测您指定的事件，然后自动生成并发送通知。 
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1.1.3 PI System 中的机器友好端和用户友好端 

 

机器友好端： 

• PI Interface 和 PI Connector 

• PI Data Archive 

• PI Tag 

 

 

 

 

 

 

PI Interface 和 PI Connector 

PI Interface 从外部数据源收集数据，为 PI System 提供实时的容错数据。 

PI Connector 与 PI 接口类似。它们从传感器和控制系统收集数据。与 PI 接口不同的

是，PI Connector 还会自动为您的资产创建 PI Asset Framework (AF) 模型。（在这

方面也属于用户友好端） 

 

PI Tag 

PI System 中数据的唯一存储标记点。它只是一个度量标记点。标记点表示来自仪

器、设备或传感器的一个指定数据流（-> 时间序列数据）。 

注意：PI tag 和 PI 标记点是一样的。  
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用户友好端： 

• PI Asset Framework 

• 资产和属性 

• 可视化工具 

 

 

 

 

 

 

资产  

在 AF 中，您要监控的设备和流程被称为资产。资产表示流程的

逻辑或物理组成部分。例如，资产包括公司位置、办公场所和设

备部件。  

资产在 AF 中配置为元素。您的所有资产和流程的统一 AF 表示

称为资产模型，它采用层次机构。  

 

 

属性 

属性表示与资产相关联的唯一特性。 
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属性可以包含表示固定信息的简单值，如泵的制造商。属性也可以引用 PI 标记点、公

式、关系数据库或内部 AF 表中的值以及其他信息。 

1.1.4 典型 PI System 的体系结构 

有时，体系结构可以非常简单。有些客户只有一个或两个 PI 接口将数据馈送到 Data 

Archive，这些数据可供各种应用程序使用。以下是开发完整的 PI System 的示例，其

中包括大多数广泛使用的 OSIsoft 产品。 

 

 

 

在上图中，显示的两台 PI Data Archive 计算机表示一个 PI Data Archive 集合。集合

是多个服务器的配置，这些服务器在 PI System 中可用作逻辑 PI Data Archive 服务

器，以提供高可用性 (HA)、灾难恢复、负载分布和更高的可扩展性。集合由一台主服

务器和一台或多台辅助服务器组成。 

有关 PI Asset Framework 的高可用性选项的更多信息，请参阅 KB 文章：KB00634 - 

PI Asset Framework (PI AF) 的高可用性 (HA) 选项 
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注意：在计算机安全中，非军事区（得名于该词的军事用途，通常缩写为 DMZ）也称为数据管理

区、分界区或边界网络，它是一种物理或逻辑子网，其中包含机构的外部服务并将它们公开至更

大的非受信网络（通常为 Internet）。DMZ 的用途是为机构的局域网 (LAN) 额外增加一个安全

层；外部攻击者仅对 DMZ 中的设备具有访问权限，而非整个网络。[参考：

http://en.wikipedia.org]  
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1.2 PI System 中的基本构造块 

 

 

1.2.1 标记点属性   

Data Archive 标记点拥有定义它们的一组属性（这些属性被称为 tag 的属性）。在下

面的段落中已经定义了一些常用的属性。 

 

标记点名称 

这是用来创建存储在 Data Archive 中的标记点的唯一名称。例如：P294H.FI.PV，

M03_E1P1_MOTDRV1202_RUNSTAT  

 

描述符 

它是 Data Archive 标记点的人性化描述。描述符往往是一个搜索条件，因为标记点名

称并非总是很直观。标记点名称往往是某种约定的缩写，描述符则指示“完整名称”。 

 

标记点源 

可以将标记点关联至其接口以通过名为 pointsource 的标记点属性收集数据。按标记

点源分组后，可以通过搜索某些标记点源的所有标记点来标识与特定设备相关联的所

有标记点。这假设用户知道正在使用的标记点源，然而某些情况下该假设并不成立。 

 

标记点类型 

它是一种属性，用于指定标记点存储的值的数据类型。可能的标记点类型包括： 
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int16、int32、float16、float32、float64、digital、string、BLOB、timestamp 

1.2.2 属性数据引用类型 

属性表示与资产有关的唯一特性。属性的数据引用类型定义获取该属性数据的位置。

有以下数据引用类型： 

•  PI 标记点  

•  PI 标记点数组  

• 公式  

•  表查找  

•  字符串创建器  

•  URI Builder  

注意：<none> 表示存在此属性的静态值。 

数据引用类型（设置示例） 
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1.2.3 单独或分组活动 — 定义的资产：数据引用类型 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领域的学习效

果。您的讲师会向您介绍相关说明，并在活动期间提供必要的指导。 

 

问题描述 

标识 AF 服务器中属性数据引用的类型。 
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问题 

确定以下属性相应的数据引用类型： 

 

1. 标称功率：存在泵房内所有泵的标称压力列表，从该列表中可以读取相关信

息。 

_____________________________ 

2. 流速：从数据源接收实际测量值。PI Data Archive 中存在相关 tag。  

_____________________________ 
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3. 泵的位置：指定泵的位置。位置与父元素的名称对应。 

_____________________________ 

4. 电流：泵的最大安培数。根据泵的标称功率和电压 (220 V) 计算出该泵的电

流。 

_____________________________ 

5. 制造商：泵的品牌。此信息绝不会发生变更。 

_____________________________ 

6. 即席压力趋势：通过参数链接到 PI Vision，以指定元素和属性以及趋势的开始

和结束时间。 

_____________________________ 
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1.3 时间与 PI System 

目标 

• 定义 PI System 中的时间缩写。 

• 定义 PI System 中的时间表达式。 

• 未来数据简介。 

• 介绍 PI System 处理时区和夏令时 (DST) 的方式。 

 

指定时间戳和时间间隔的输入时，您可以使用名为 PI System 时间的特殊语法。PI 

System 时间采用特定的缩写形式，您可通过组合使用这些缩写来创建时间表达式。  
 

1.3.1 PI System 时间缩写 

在指定 PI System 时间时，可以使用特定缩写来代表时间单位和参考时间。 

 

缩写 时间单位 

秒 second 

m minute 

h hour 

日 day 

w week 

mo month 

y year 

 

指定时间单位时，可指定缩写形式、完整时间单位或复数形式的时间单位，如 s、

second 或 seconds。您必须在任何时间单位中包含一个有效值。如果指定秒、分钟或

小时数，则可以指定小数值。但对于其他单位则不能指定小数值。 

 

缩写 Full 参考时间 

*  当前时间。 

t（或 T） Today 当天的 00:00:00（午夜） 

y（或 Y） yesterday 前一天的 00:00:00（午夜） 
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缩写 Full 参考时间 

sun Sunday 最近一个星期日的 00:00:00（午夜） 

mon Monday 最近一个星期一的 00:00:00（午夜） 

tue Tuesday 最近的星期二的 00:00:00（午夜） 

wed Wednesday 最近一个星期三的 00:00:00（午夜） 

thu Thursday 最近一个星期四的 00:00:00（午夜） 

fri Friday 最近一个星期五的 00:00:00（午夜） 

sat Saturday 最近一个星期六的 00:00:00（午夜） 
 

1.3.2 PI System 时间表达式 

PI System 时间表达式可以包含一个参考时间、一个时间偏移量（由 + 或 - 表示）和

一个带值的时间单位。PI System 时间表达式可： 

• 仅包含参考时间，如“y”  

• 仅包含时间偏移量，如“+3h”  

• 包含时间偏移量的参考时间，如“y+3h”  

参考时间可以是固定时间，如“24-aug-2012 09:50:00”，也可以是一个有效的参考时间

缩写，如“t”。 

表达式中可以仅包含一个时间偏移量。包含多个偏移量会导致不可预期的结果。例

如，以下时间表达式无效： 

 
 

1.3.3 时间戳规范 

要指定时间戳输入，您可以输入包含以下内容的时间表达式： 

固定时间  

固定时间始终代表同一时间，不受字段或当前时间影响。 

输入 含义 

23-aug-12 15:00:00 2012 年 8 月 23 日下午 3 点 

25-sep-12 2012 年 9 月 25 日 00:00:00（午夜） 
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参考时间缩写  

参考时间缩写代表一个相对于当前时间的时间。  

输入 含义 

*  当前时间（现在） 

3-1 或 3/1 当年的 3 月 1 日 00:00:00（午夜） 

2011 2011 年当月当天的 00:00:00（午夜） 

25 当月第 25 天的 00:00:00（午夜） 

t 当日（今天）的 00:00:00 

y 前一天（昨天）的 00:00:00 

tue 最近一个星期二的 00:00:00 

 

带时间偏移量的参考时间缩写或固定时间 

当固定时间或参考时间缩写带有一个时间偏移量时，将会从该固定时间或参考时间缩

写中增加或减去指定时间。  

输入 含义 

* - 1h 一小时以前 

t+8h 今天 08:00:00（上午 8:00） 

y-8h 前天 16:00:00（下午 4:00） 

mon+14.5h 最近一个星期一的 14:30:00（下午 2:30） 

sat-1m 上周五 23:59:00（晚上 11:59） 

 

时间偏移量 

时间偏移量需要在时间字段中单独输入，可指定一个相对于暗示的参考时间的时间。

暗示的参考时间取决于您在哪个字段中输入表达式： 

• 对于开始时间，参考时间为当前时钟时间。  

• 对于结束时间，参考时间为开始时间。 

• 对于单个时间戳，参考时间为当前时钟时间。 

 

时间字段 输入 含义 

Start time -1d 当前时钟时间的前一天（当前时钟时间的前 

24 小时） 
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时间字段 输入 含义 

End time +6h 开始时间后的六个小时 

End time -30m 开始时间之前的 30 分钟 

Time stamp -15s 当前时钟时间的前 15 秒 

1.3.4 未来数据 

未来数据是与未来时间戳关联的数据。Data Archive 2015 可以存储和检索时间戳晚于

当前时间的数据，因此允许您存储时间范围在 1970 年 1 月到 2038 年 1 月内的数

据。使用 Data Archive 2015，您可以捕捉和分析具有未来时间戳的数据，并使用 PI 

可视化工具以图形方式为您的业务创建可能的预测和预告。 

如同使用历史数据一样，要指定时间戳的输入，可以输入先前讨论的固定时间、参考

时间以及带有一个时间偏移量的参考时间缩写或固定时间的时间表达式。差异是时间

戳将是未来的时间。下面是一些示例表达式： 

 

输入 含义 

*+1h 从现在起一小时 

t+3d 从今天午夜起三天 

Y+1y 从昨天起一年 

 

1.3.5 PI System 如何调整时区和 DST？ 

答案非常简单：我们不调整！ 

在收集数据时，我们将其转换为 UTC（协调世界时），或以前称为格林威治标准时间 

(GMT) 的格式。这意味着每天正好有 24 小时。如果时间有调整，由查看数据的用户

的本地计算机时钟执行（如时区或 DST）。 

如果您的地区进入了 DST，每年都会出现一次一天好像有 23 个小时，另一天好像有 

25 个小时的情况，但 PI Server 只知道每天有 24 个小时。 

此外，由于客户端和 PI Server 知道它们所处的时区，因此可按服务器时间或客户端

时间查看数据。这由客户端工具中的设置确定。 
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1.3.6 单独或分组活动 – PI System 时间 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领域的学习效

果。您的讲师会向您介绍相关说明，并在活动期间提供必要的指导。 

问题描述 

确定下表中由 PI System 时间指示的“实际”日期和时间： 

（假设现在：2014 年 5 月 20 日，星期二，上午 10:12:23） 

 

缩写 答案 

* - 30m  

T-1d  

y + 8h  

12 8:  

Tuesday – 2d  
 

 

用有效的 PI System 时间缩写表示以下时间： 

 
 

缩写 答案 

今天上午 6:30  

星期一上午 5:45  

12 小时以前  

当月第一天  

明天早上 7:00  

从现在起 2 小时  
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2. Asset Framework 简介 

2.1 PI AF Server 

2.1.1 AF Server 安装及软件要求 

在生产环境中，AF Server 组件通常安装在专用的 Windows 服务器计算机上。 

在数据库管理方面，AF Server 使用必须已在安装 AF Server 过程中定义的 Microsoft 

SQL Server。用于 AF 的 SQL 数据库的默认名称为 PIFD。 

AF 的客户端程序是 PI System Explorer (PSE)，用于配置和维护资产结构。 

AF Server 与多个 SQL Server 版本兼容（SQL Server 2008 或更高版本；要获取完整

列表，请参阅 AF Server 软件要求）。PI AF Server 适用于 32 位或 64 位 SQL 

Server 版本。 

支持多个 SQL Server 版本：Express、Standard、Business Intelligence、

Enterprise、Datacenter。Express 版本是免费版，但存在一些限制。Express 版本可

能无法满足您的需要，具体取决于您的 AF 资产结构规模和您使用的 AF 功能（如审

计跟踪功能）。请参阅相关的 OSIsoft 硬件系统大小建议。  

SQL Server 可以与 AF Server 位于同一计算机上，也可以位于不同计算机上。可以使

用也用于其他应用程序的现有 SQL Server。 

SQL Server 的 PI AF 高可用性要求 

要利用 PI AF 高可用性（HA 集合）功能，主要集合成员必须运行 SQL Server 

Standard 版、SQL Server Business Intelligence、SQL Server Enterprise 版或 SQL 

Server Datacenter 版。SQL Server 不需要与 PI AF Server 位于同一台计算机上。 

SQL Server 的 PI AF 审计跟踪功能要求 

对于支持的 SQL Server 版本（SQL Server 2014 及更早版本）来说，要使用 PI AF 

审计跟踪功能，需要采用 SQL Server Enterprise 版。 

在以下版本中也支持 PI AF 审计跟踪功能： 

• SQL Server 2016（需要 Windows 更新或 Microsoft KB 3164398） 

• SQL Server 2016 SP1 Enterprise 或 Standard 版 

• SQL Server 2017 Enterprise 或 Standard 版（仅 Windows 版） 
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有关 AF Server 的系统要求的完整信息，请参阅 AF Server 软件要求。 
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2.1.2 Asset Framework 的主要特点 

Asset Framework 在 PI System 中提供一个额外的数据层。它基于客户定义的工厂资

产模型。该模型包含元素和属性。  

该模型按照客户最熟悉的对象（如其过程中的反应器、变压

器、计量器等物理对象）对数据进行组织排列和结构化设

置。  

由于 AF 资产模型可以扩展 PI Data Archive，因此它允许客

户在多个 PI Data Archive 中组织排列和搜索 PI System 信

息。  

 

资产模型的基础是元素，它包含可以引用 PI System 数据、设计数据或其他系统中的

数据的属性： 

   

 

AF 事件框架允许用户关联在某一时间范围内发生在这些资产当中的事件或对这些事件

加书签。 

Asset Analytics 提供实时计算引擎，用户可以配置、调度和运行使用性能方程式语

法编写的对其 AF 属性起作用的计算。计算结果可以作为时间序列数据存储在 PI 标记

点中或创建事件框架，如有必要，可以为它们自动发出通知。 

客户端应用程序（包括但不限于 PI Vision、PI DataLink、PI ProcessBook 和 PI 

Integrators）可利用资产模型提供上下文驱动的显示、报告和分析。  
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2.2 PI System Explorer 组件 

2.2.1 讲师指导活动 – 熟悉 PI System Explorer 组成部分 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

问题描述 

讲师将展示并说明 PI System Explorer 组成部分及其一般用途。 

方法 

单击任务栏中的 PI System Explorer 图标  启动程序。 

注意：首次启动 PI System Explorer 可能需要一些时间。一开始不显示任何对话框。随后的启动

要快得多。 
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导航器面板 

PI System 对象分为多个部分，显示在导航器面板中。默认情况下，显示的分组包括

元素、事件框架、库、度量单位和管理。  

菜单栏 / 工具栏 

在打开/创建数据库、搜索元素或联系人、应用和检入更改、设置视图选项等等的时

候，可以使用这些选项。菜单和工具栏是上下文关联的，根据导航面板中所选部分的

不同，将显示不同的选项。 

浏览器 

浏览器用于选择您想要处理并显示在查看器面板上的对象。浏览器显示已添加到 AF 

数据库的 PI System 对象，如元素、模板、通知等。根据在导航器面板中所选部分的

不同，浏览器中将具有以下项目： 
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• 元素：元素表示您的流程中的物理实体或逻辑实体。可以按多种层次结构组织

元素。另外，也可以从模板创建元素或从零开始创建元素。当以模板为基础

时，元素从模板中衍生出其初始属性配置。后来对模板所作的修改将适用于基

于之前模板的所有元素。 

 

• 事件框架：事件框架是指通过开始时间、结束时间和上下文定义的事件。事件

框架也拥有包含支持数据的属性。事件框架可以表示停机事件、流程和环境偏

移、材料转移事件、设备维护事件、批处理步骤、安全事件和对于贵公司而言

非常重要的其他事件。转移是一种特殊类型的事件框架，以离散量标志材料的

运动。 

 

• 库：这是可以在整个 AF 层次结构中重复使用的对象集合。库中显示的对象类

型包括类别、元素模板、枚举集、引用类型和表。 

 

• 度量单位 (UOM)：度量单位数据库可提供在同一度量单位类属性的度量单位之

间进行简单换算的自动处理能力。度量单位类由其度量的基本尺度定义。例

如，度量单位类可以为质量、体积和密度。度量单位数据库预设了多个标准度

量单位类和换算系数。您可以通过添加新的度量单位及度量单位类扩展这些

类。在执行度量单位时采用国际单位制 (SI)。 

 

• 管理：此部分提供在当前 AF 数据库中配置的所有分析和通知规则的汇总。它

可用于执行管理任务，如启动、停止、回填。 

查看器 

这是主要工作区。它用于创建和编辑元素、属性、模板、表、联系人、通知、分析

等。当通过查看器配置属性时，配置面板将会显示一个可用于更改配置的视图。 

配置面板 

配置面板用于配置与属性相关联的特性。这些特性包括静态属性的类别、属性引用、

单位、数据类型和值。  

调色板 

调色板显示可以与在查看器中定义的对象相关联的模板、数据引用和联系人。通常会

隐藏调色板以优化屏幕分辨率。 

状态栏 
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在浏览器中单击一个项目后，可在状态栏中查看其状态。例如，上次修改时间（如果

该对象被检出或者当前正在加载通知）。 
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2.3 连接到 PI System 

目标 

• 描述连接到 PI System 的不同方式。 

• 连接到 AF Server。 

• 检查您的连接身份凭证。 

• 连接到 Data Archive。 

• 创建指向 Data Archive 的新连接。 

2.3.1 我们怎么连接数据？ 

在学习本课程时，将主要使用 PSE 检索 PI System 数据。指向 AF Server 的连接用

于访问与您的资产相关联的所有元数据，而指向 Data Archive 的连接用于访问 Data 

Archive 标记点的流程数据。 

2.3.2 连接到 AF 服务器 

要连接到 AF 服务器，只需打开 PSE。安装时会设置默认 AF 服务器，因此您将自动

与其相连。如果已经定义默认 AF 数据库，PSE 也可以自动连接到该数据库。如果没

有定义默认 AF 数据库，将会弹出一个窗口，您将能够创建新的 AF 数据库。 

可以通过选择工具栏上的  按钮查看用户连接的 AF 服务器。Select 

Database 对话框将在“AF Server”下拉列表顶部显示当前服务器名称。 
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要连接到不同的可用 AF 服务器，只需从“AF Server”下拉菜单中选择所需的服务器，

然后单击 Connect 按钮。 

2.3.3 讲师指导活动 – 在连接到 AF 服务器时检查凭据 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

问题描述 

在讲师演示如何验证与 Data Archive 和 AF 服务器的连接状态时，您可以跟着操作。 

方法 

单击任务栏中的 PI System Explorer 图标  启动程序。 

要找到用于连接到 AF 服务器的凭据，请转到 File > Connections…  
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2.3.4 讲师指导活动 – 连接到 Data Archive 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

您可以通过 PSE 验证与 Data Archive 的连接状态。请注意，AF 服务器图标 ( ) 与 

Data Archive 服务器图标 ( ) 不同。 

PI SDK 工具为您提供了多个功能来配置和诊断 Data Archive 的连接状态。 

打开 PI SDK 工具（PI System > PISDKUtility（64 位））。在 PI-SDK > 

Connections 部分，将会显示在本地计算机上配置的 Data Archive 服务器。要验证 

Data Archive 的连接状态，只需选中其名称或 IP 地址旁边的复选框。如果连接成功，

则将显示连接信息。 

 

 
 

在状态栏右侧的连接信息部分中会显示在 Data Archive 上执行身份验证的用户。 

注意：PI SDK 工具是一个对权限问题的故障排除特别有用的工具。 
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2.4 查找数据 

目标 

• 演示在 Asset Framework (AF) 层次结构中查找元素数据的功能。 

• 演示在 PI System Explorer (PSE) 内搜索标记点的功能。 

• 检查标记点属性。 

2.4.1 讲师指导活动 – 查找元素和属性 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

PI System Explorer 具有两个元素搜索选项：快速搜索和具有多种搜索条件的高级搜索。 

 

活动目标 

• 根据名称模式执行快速元素搜索 

• 执行具有多种搜索条件的元素搜索。 

• 执行属性搜索。 

 

方法 

快速元素搜索 

1. 在 PSE 中打开 PI Big Tires Co. AF 数据库，在导航器中选择 Elements。 

2. 浏览元素层次结构：它包含 3 个位置（休斯顿、蒙特利尔和费城 (“Philly”)），

每个位置中有四台压力机。 

3. 在快速搜索中输入 HOU 并按 Enter 键。 
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4. 在快速搜索中输入 HOU*Press 并按 Enter 键。 

注意：该搜索上显示一个小星号 。从上下文菜单中选择 Save 后，下次您登录 PI 

System Explorer 时将可以使用该搜索。从上下文菜单中选择 Rename，该搜索将重命名

并保存。 

 

高级元素搜索（多种搜索条件） 

5. 在 PSE 菜单中，选择 Search – Element Search… 

6. （可选）如果搜索条件是在上次搜索中缓存的，单击顶部搜索行中的蓝色“x”可

重置。 

7. 输入位于蒙特利尔的轮胎硫化机的搜索条件（元素搜索根 Element Search 

Root= Montreal，模板 Template= PressTemplate），单击 Search 可获得结

果。 

8. 在名称字段中输入 *1 以指定另一个条件，单击 Search 可获得结果。 

注意：所有后代(All Descendants)指定该搜索是否返回选定层级以及所有以下层级中的元

素。在大多数情况下，应将此选项设置为 True。Name 字段可以使用通配符（* 和 ?）。 

9. 重置条件。指定模板（例如 PressTemplate）时，您可以为某一属性值添加条

件。搜索轮胎硫化机状态 Press Status= “Running”的所有轮胎硫化机。 

 

 

属性搜索 

10. 在 PSE 菜单中，选择 Search – Attribute Search… 
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11. 选择 PI Big Tires Co. AF 数据库。 

12. 在属性名称字段中输入 Press Status。确保选中 Search Sub-Elements 选

项。单击 Search。结果：列出所有 12 个轮胎硫化机的轮胎硫化机状态属性。

单击 OK。 
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2.4.2 讲师指导活动 – 在 PSE 中查找标记点 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

可以从 PSE 访问 Tag Search（Tag 搜索）窗口，查找要映射到 PI 标记点元素属性的相应标记

点。可从 Search – Tag Search… 菜单项访问此 Tag 搜索窗口。 

 

活动目标 

• 了解 PSE Tag 搜索的搜索功能和选项。 

方法 

1. 在 PSE 菜单中，选择 Search – Tag Search… 

2. （可选）如果搜索条件是从上次搜索中缓存的，单击顶部搜索行中的蓝色“x”可

重置。 

3. 搜索与名称模式 CD*158 匹配的 Tag 

4. 搜索与名称模式 CD?158 匹配的 Tag。与先前的搜索结果有何不同？ 

5. 默认情况下，此窗口允许使用标记点名称掩码进行搜索。如果您单击控件以显

示额外的搜索功能，则可以获得更多选项来使用其他常见的标记点属性（如描

述符）来进一步优化搜索。 

 

 
 

输入条件以搜索标记点源=R，名称= sinus* 的所有 Tag。 
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3. 了解 AF 

3.1 Asset Framework (AF) 有什么作用？ 

 

PI Data Archive 专注于标记点数据库，并且非常擅长于存储接口收集的大量数

据。它可以轻松高效地检索时间序列数据。PI Data Archive 架构具有可扩展

性、可维护性和高可用性。  

 

Asset Framework (AF) 通过为组织中的所有数据（“数据目录”）提

供元数据结构来补充架构。Asset Framework (AF) 具有丰富的功

能，可以整理和增强 PI Data Archive 中的数据。由于它提供对数

据的用户友好访问，因此是用户在与其 PI System 数据交互时的首

选方式。  

 

 

Asset Framework 有哪些优势？ 

 

在系统中进行导航的简单方式 

具有层次结构的资产结构提供了一种便捷的导航方式，也可供那些不熟悉如何从数据

源检索数据的技术细节的用户使用。 

 

统一来自不同源系统的数据 

PI 标记点属性从 PI Data Archive 获取其数据。AF 不限于一个 PI Data Archive。属性

可以引用多个 PI Data Archive 服务器（独立或集合）  

数据来源也可以是关系数据库。虽然表示反应器的元素的某些属性来自 PI tag 的时间

序列数据（如温度），但某些其他属性的数据可能来自外部数据库（例如物理特征或

库存数据）。  

所有属性并排列出，以让用户全面了解资产的所有相关数据。 
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支持不同的度量单位 

PI Asset Framework (PI AF) 属性与特定度量单位相关联。AF 根据国际单位制 

(SI) 预加载了多个标准度量单位类和换算系数。它还支持用户定义的类和度量单

位。例如，美国反应器中温度传感器属性的源单位可以与华氏度相关联，而意大

利反应器的相应属性可以与摄氏度相关联。处理数据（进行计算或显示数据）

时，应适当考虑这一点。  

 

模板标准化 

许多工厂对标记点没有严格的命名标准。也可能缺少描述符和/或工程单位。PI 

System 通常用于集成来自不同来源的信息，而这些来源的配置可能不一致： 

 

AF 中的元素模板提供了标准化的基础。当应用表示同类型设备的元素时，所有元素都

具有相同的属性集，并采用用户友好且一致的命名方式。这些属性具有相同的度量单

位、相同的数据类型、相同的描述等。这将使您的系统具有协调一致的表示形式。 

使用模板的另一个好处是快速创建相同类型的多个元素。 

 

强大的计算选项（资产分析） 

对于 PI Asset Framework (PI AF) 属性，用户可以配置、调度并运行使用 PI 性能方程

式 (PE) 语法编写的计算结果。基于触发条件的 PE 表达式、汇总计算和 PI 事件框架

生成均为受支持的分析类型。此外，分析模板使用户能够以标准化和一致的方式管理

他们的分析。典型的应用包括关键绩效指标 (KPI) 计算和基于条件的维护 (CBM)。  
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3.2 元素和属性简介 

3.2.1 讲师指导活动 – Velocity Terminals 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的

不同概念。您可以观看讲师执行的操作，也可以同时执行相同的步

骤。您的讲师会提供指导。 

活动目标 

• 使用 PI 标记点、表查找和公式数据引用创建包含属性的 AF 元素。 

• 在元素和元素模板中定义属性的值类型和度量单位。  

• 创建和填充 AF 表。 

• 根据元素创建 AF 元素模板。 

• 使用新属性扩展模板并查看它们影响原始元素的方式。 

• 创建 AF 枚举集并在模板中用来验证数据。 

• 从模板创建元素。 

• 在父元素下移动 AF 元素。 

• 使用 PI Builder Excel 加载项创建多个元素。 

问题描述 

您在 Velocity Terminals 工作，它是一个生产各种化学品的化学公司。公司在不同的

国家/地区拥有许多可以监控的存储罐。现在向您分配了在 AF 中为这些存储罐创建资

产模型的任务。 

方法 

跟随讲师的指导，观看他/她执行步骤来创建各种 AF 对象，从而创建一个单一的 PI 

ProcessBook 显示来监控所有 Velocity Terminals 存储罐。 

稍后，您将有机会独立完成课程。现在，请详细了解初步探索 AF 的相关信息。 
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3.2.2 讲师指导活动 – 创建和选择 AF 数据库 

从“开始”菜单打开 PSE，必要时请连接到 AF Server PISRV01。 

如果 PSE 正常打开，可选择 File > Database。如果 PSE 没有打开并显示一个弹出窗

口，单击 Select 选项可以显示 Select Database 窗口。 

要创建新数据库，请右键单击数据库列表中的任意位置，然后选择 New Database 或

单击工具栏上的 New Database 按钮。  

要选择用于输入 Velocity Terminals 结构的现有数据库，请选择 AF Startup 并单击 

OK 按钮或双击以打开该数据库。  

 

 

 

 

关于数据库 

用于培训的 PISRV01 设置包含多个专门用于课堂练习的 AF 数据库。在实际使用中，不要创建太

多大型数据库。这是因为 AF 中的引用只在同一数据库内有效；不能比较数据库之间的元素和

值。公司可能会发现在企业单位级别（而非工厂级别）可以更好地组织他们的数据库。  

“配置”数据库 

作为管理员，可以查看名为“配置”的数据库。不要使用此数据库组织您的资产，因为它只向管理

员显示且仅用于存储 PI System 软件的配置数据。 
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3.2.3 讲师指导活动 – 创建 AF 元素 

确保已从导航器面板选择“元素”部分，并创建名为 Tank01 的新元素。 

在浏览器中，右键单击  并选择 New Element，或单击工具栏中的 

 按钮并选择 <None> 作为元素模板。 

在查看器的 General 选项卡下，将元素的名称更改为 Tank01。 

关于元素 

元素是 AF 的基本构造块。它是一项组织功能，可以将其视为一个文件夹。它已经与其他元素建

立关系且拥有可搜索的特征。元素没有数据引用并且没有值。通常按层次结构组织元素，尽管没

有必要。 

元素表示流程中的物理实体或逻辑实体，可以是：设备、生产线、产品、系统、企业或场所。可

以根据模板创建元素或者在没有元素的情况下创建元素，尽管后面的部分会强烈推荐使用模板。 

AF 数据库中的元素必须使用唯一的名称以指向其路径。名为“转换器”的元素可以在名为“系统 A”

的元素下方，而名为“转换器”的另一个元素可以在名为“系统 B”的元素下方。但是，两个名为“转

换器”的元素不能同时在名为“系统 A”的元素下方。我们建议必须考虑所有元素的唯一名称，不论

它们在层次结构中的什么位置。 

元素的名称可以包含除控制字符或下列字符之外的任何字符：( ; ? ` ‘ “ \ | {} [] )。 
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3.2.4 讲师指导活动 – 创建 AF 属性 

在查看器中，选择 Attributes 选项卡，然后右键单击空白区域，选择 New Attribute 以

定义属性或单击工具栏中的  按钮。  

属性与元素一样，它在所属的元素中也必须使用唯一的名称及其路径。属性可以配置

有常数值，也可以从数据引用动态获取值。 

 

值类型 

属性的 Value Type 字段用于定义值本身的格式。拥有编程经验的用户将会非常熟悉

各种类型。通常，双精度值类型可用于大多数模拟/数字值，字符串值类型可用于其他

任何值。在某些情况下，也可以使用其他值类型。例如，布尔值类型可以为 0 或 1，

表示 False (0) 或 True (1)。 

 

显示位数 

Display Digits 字段（AF 2018 中的新功能）可用于控制您想要查看的属性的位数：

零或整数表示小数点右侧显示的位数。负值表示要显示的有效位的数目。这种情况

下，Display Digits 的绝对值是有效位的数目。 

如果您的 AF Server 版本低于 2018，此功能的作用类似于 Display Digits = -5 

示例（值= 23.45） 

显示位数 格式 

3 23.450 

2 23.45 

1 23.5 

0 23 

-1 2E+001 

-2 23 

-4 23.45 
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-5（默认） 23.45 

开始按下表所示配置 Tank01 的前三个属性： 

属性 

名称 
默认 

度量单位 

值 

类型 

 

值 
显示 

位数 

数据 

引用 

Capacity US gal（体积） Double 20,000 -5 <None> 

Level %（比率） Double 无 2 PI 标记点 

Volumn m3（体积） Double 无 3 公式 

注意：在 Level 和 Volume 的 Value(值) 列，将存在一些误差，我们将通过完成后续步骤中的配

置进行修复。 

 

属性的度量单位 

通常会为属性分配度量单位 (UOM)。可以将这些度量单位组织成可比较的类。“默认度量单位”配

置字段用于定义要用来显示属性的值的默认度量单位。此默认度量单位不需要与仪表的度量单位

相同。后面的部分将会介绍其使用方式。 

注意：始终要分配一个度量单位！请勿将其保留为未定义状态。这样可以避免在随后的所有操作

中对度量产生误解。 

 

• 要输入 UOM，请从相应的 UOM 类中选择该 UOM（此处：UOM 类 = 比率，

UOM = 百分比）。或者，输入第一个字符（如 per），然后从匹配的 UOM 列

表中进行选择。 
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Level 属性 

• 选择 Attributes 选项卡后，选择 Level 属性，然后单击 Settings 按钮。 

 

• 在顶部检查是否已为数据服务器选择正确的 Data Archive 服务器 (PISRV01)。 

 

• 输入 TANK01LI.PV（或使用 Tag 搜索 ( )）。将源单位从“<Default> (%)”更

改为“%”。单击 OK。 

 

 

注意：确保始终分配度量单位 (UOM)，而不是仅保留默认设置。这可以防止在稍后更改 

UOM 属性时，PI 标记点值被曲解。 

 

• TANK01LI.PV 的当前值将显示在 Level 属性的 Value 列中。 
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Volume 属性 

• 选择 Volume 属性。 

 

• 单击 Settings… 以显示 Formula Configuration 窗口。 

 

• 使用公式数据引用可以通过使用液位 (%) 和容量 (m3) 计算体积。 

 

• 使用新建按钮 ( ) 添加要在公式中使用的参数。 

 

• 展开 Equations 部分 ( ) 中的函数列表以勾选要在公式中使用的运算符/函

数。 

 

 

公式中的度量单位 

您可以通过设置度量单位 (UOM) 来进行单位换算。可以为参数和结果明确设置度量单位。可以

通过从参数配置部分的 Unit of Measure 下拉列表中选择相应的 UOM 进行设置。同样，也可以在

左下角的 Result 部分中进行设置。 
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注意：建议您始终明确分配单位！如果将单位选择器保留为 <default>，则不发生单位换算。如果

稍后更改属性的默认 UOM，则不会进行相应的换算，这将造成结果不正确！ 

• 按工具栏上的  按钮，然后按  按钮，或从菜单中选择 

File > Check In  以保存这些更改。 

下表将帮助您评估计算是否正确。 

 

Tank01 液位 体积（美加仑） 体积 (m3) 

0% 0 美加仑 0 m3 

20 % 4,000 美加仑 ca. 15 m3 

40 % 8,000 美加仑 ca. 30 m3 

60 % 12,000 美加仑 ca. 45 m3 

80 % 16,000 美加仑 ca. 60 m3 

100 % 20,000 美加仑 ca. 75 m3 

 

关于保存修改 

AF 服务器使用沙盒概念进行修改。它可以保存更改，直到将更改发布给最终用户。按 

 按钮后，活动会话中所作的更改将会作为其他用户可以查看的单一公共版本发布。 

在您检入之前，其他用户将无法编辑已检出的对象。已检出图标将显示为 ( )。至于用户当前

正在 AF 中编辑的对象，对象图标会被标示为有尚未发布的更改 ( )。检入图标旁边的“撤消对

数据库所作的全部更改”按钮 ( ) 可用于重置沙盒更改，并将沙盒重新设置为开始使用之前的数

据库状态。 

• 要浏览 Display Digits 设置，请将容量从 20,000 更改为 200,000。输入经过修

改的值后，值将显示为 2E+05 US Gal。这是因为该值无法使用五个数位（显

示位数 = -5）进行显示，该显示会切换到科学计数法格式。2E+05 应解读为 

2.0 * 10 ^ 5 (= 200,000)。将容量重新更改为 20,000。 
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要熟悉科学计数法格式，请打开 Windows 计算器并切换到科学计数法视图。输入 200,000 并更

改为科学计数法显示（F-E 按钮）。  
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3.2.5 讲师指导活动 – 创建 AF 表 

表的构建与在具有简单的表构建功能的其他程序中基本类似。 

在 PSE 中，首先在导航器面板中导航到 Library 部分。右键单击 

Tables 项以选择 New Table，或单击工具栏上的  按钮。 

在 General 选项卡下，将表的名称更改为“Material Properties”。 

 

选择 Define Table 选项卡，然后通过右键单击空白区域以选择 Insert 

或通过选择右侧的星芒状“插入行”按钮 ( ) 添加两 (2) 行。按如下所示定义表： 

列名称 值类型 度量单位 

材料 ID String <None> 

Density Double kg/m3（密度） 

 

在 Table 选项卡下，输入下列虚拟化学品： 

材料 ID Density 

AQ4500 2,100 kg/m3 

HC1500 3,422 kg/m3 

WX1200|旧制法 8943 kg/m3 

WX1200|新制法 9213 kg/m3 

关于表 

保存在 AF 数据库中的表可以通过 Table Lookup 数据引用提供上下文信息。表可以提供有关设备

或流程实体的信息，也可以用来存储 Tag 名称或在 AF 中使用的其他配置信息。 
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可以在内部创建表（如在本练习中）、从外部关系或表格式数据源导入表或者动态链接到外部关

系数据源。这样，表可以提供有关维护、生产规划或 PI 客户端应用程序使用的设备数据库的信

息。 
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3.2.6 讲师指导活动 – 创建 AF 枚举集 

关于枚举集 

枚举集是已映射到名称的连续整数值的有序列表。它允许 AF 属性引用常用术语，而不是一个数

字。它类似于数字标记点使用的 Data Archive 数字状态集。不需要在 AF 中重建或维护数字状态

集。枚举集只是一种用于显示信息、执行数据验证和维持 AF 结构之间数据一致性的有意义的方

法。 

有层次结构的枚举值（AF 2017 R2 中的新功能）： 

枚举值可以嵌套在层次结构中。层次结构可根据需要包含尽可能多的级别。在我们的示例中，

WX1200 采用不同的制法生产，导致其具有不同的物理特性，因此密度值也有所不同。在 

WX1200 值以下的另一个级别，我们可以区分新旧制法。  

在导航器面板中，选择 Library 部分。  

右键单击 Enumeration Sets 项以创建 New Enumeration Set，或单击工具栏上的 

 按钮并将新集命名为 MaterialID。  

输入下表中的材料 ID 作为该枚举集的名称： 

值 名称 

0 AQ4500 

1 HC1500 

2 WX1200 

 

为了区分使用旧制法或新制法生产的 WX1200，我们将在 WX1200 下的一个级别中添

加两个子值： 

值 名称 

3 WX1200|旧制法 

4 WX1200|新制法 
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注意：自 AF 2017 R2 开始提供层次结构枚举值功能 

 可将新创建的对象保存到 AF 数据库。 

3.2.7 讲师指导活动 – 创建 AF 元素模板 

从导航器面板的 Elements 部分中选择 Tank01，然后右键单击它以选择 Convert > 

Convert to Template（请注意，这不会删除或更改元素，但可以将模板设置为新模

板）。转换时，您需要决定应当如何设置液位属性的 PI 标记点数据引用。选择 

Substituted，它将根据命名模式规则设置 PI 标记点的名称。 

默认命名规则为 %Element%.%Attribute%.%ID%。  

在 Suggested Point Name 下，输入 %Element%LI.PV 并单击 Apply。  

 
 

如果您基于模板为另一个油罐创建新元素，则将根据新元素的名称替换 Level 属性的

标记点引用（用 % 括起来）中的替代参数： 

命名模式：%Element%LI.PV 

元素名称 PI 标记点名称 

Tank02 Tank02LI.PV 
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Tank03 Tank03LI.PV 

Tank04 Tank04LI.PV 

等等 

替代参数将在稍后进行介绍。  

 

从 Library > Templates > Element Templates 部分中找到新元素模板，并将其名称更

改为“Tank”。  
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在 Tank 模板的 Attribute Templates 选项卡下，通过单击工具栏上的 

 按钮添加四 (4) 个新属性模板。 

属性名称 默认度量单位 值类型 数据引用 显示 

位数 

Product <None> 枚举集 > 材料 ID <None> (*) 

Density kg/L（密度类） Double 表查找 -5 

Mass kg（质量类） Double 公式 -6 

Tank Name <None> String 字符串创建器 (*) 

注意：虽然显示位数不适用于非数字值，但将出现显示位数 (-5) 的默认值，不要更改该值。 

Product 属性 

创建 Product 属性时，请启用 Configuration Item 属性。 

 

Density 属性 

使用下表配置 Density 属性的 Table Lookup 数据引用： 

表 结果列 其中 

材料属性 Density 材料 ID = @Product 

 

Mass 属性 

使用下表配置 Mass 属性的 Formula 数据引用： 

参数 方程式 

变量 属性 度量单位 

D * V D Density kg/L 

V Volumn L 
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Tank Name 属性 

要配置 Tank name 属性的 String Builder 数据引用： 

从 Data Reference 下拉选项中选择 String Builder，并单击 Settings…  

单击 Add New String  按钮，并单击  获得其他选择项，然后从替代参数中选择

“%Element%”： 

 

 

 更改。  

返回到 Elements 部分，选择 Tank01 元素并查看其属性。  

勾选 Product 属性枚举列表的材料“HC1500”，然后单击 。  

请注意 Density 属性的值。选中正确的油罐名称。 

注意：应始终从模板创建元素，即使在创建时只有一个资产可以使用该模板。这样可确保 AF 元

素创建和管理方面的一致性。 

但是，对于仅用来组织资产（文件夹）和没有任何属性的元素，不需要模板。  
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3.2.8 讲师指导活动 – 通过模板创建新元素 

根据油罐元素模板创建名为“Tank02”的新元素，并将在下表中找到的值分配给其属

性。 

属性名称 值 

Capacity 30,000 

Product AQ4500 

将这些更改提交到 AF 数据库 ( )。 

模板的强大功能 

术语模板的意思是使用一成不变的方法创建一致的新对象。AF 元素模板可以实现此目的，并且

可以提供适用于元素的更多功能。它们可确保 AF 中的类似设备保持一致。 

对模板（默认值、属性定义或结构）进行更改时，将会自动更新使用模板创建的元素。 

注意：如果在元素的属性层级进行更改，则对属性模板所作的更改将不会替换用户所作的修改。

也就是说，如果您在特定元素的属性的数据引用中特地设置值或配置字符串，则在元素模板层次

中修改的这些属性默认值不会将其覆盖。 

从模板衍生的属性在其右键单击菜单中都拥有 Reset to Template 选项，可恢复此属性的任何独

特值或配置字符串定义，并将其重置为在模板层面确定的默认值。 

您不但可以创建模板，而且也可以使用模板维护多个元素，因为已将更改应用到所有相应的相关

元素。 

模板还允许 AF 数据库在需要分析时成为分析工具。您可以随时在模板中添加计算和分析，因为

这些信息会自动传播到所有元素。没有必要在创建模板时完成分析。 

在本例中，我们根据现有元素创建了模板，但可以直接转到“库”以通过右键单击“元素模板”并选择

“新建模板”来创建新模板，或者通过单击工具栏上的  按钮创建新模板。 

AF 模板在 General 选项卡下有一个  复选框。选中此复选框允许创建该元素模

板层次的属性模板之外的其他属性。显然，这将不再保证所有元素都拥有相同的属性集。 
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在 AF 中，模板的功能不仅强大，而且独特。在构建 AF 元素时，大多数应用程序都得益于模

板。 

3.2.9 讲师指导活动 - 移动父元素下的元素 

为了表示您的应用程序要使用的逻辑层次结构，可以移动其他元素（称为父元素）下

的元素 

您可以使用鼠标和键盘在查看器中向四周移动元素。这将导致创建元素引用，或者复制元素或仅

移动元素。 

在拖动元素的同时… 操作 

按 Ctrl 键 
复制另一个父元素下的原始元素。不会建立原始元素和

元素副本之间的链接。 

按 Shift 键 移动元素。 

不按任何键 

创建元素引用。元素现在将位于层次结构中的两个位

置。在这种情况下，元素图标包含一个“链接”指示符 

( )，类似文件的快捷方式。 

 

问题描述 

您希望建立一个 AF 元素层次结构，其中 Montreal 是顶层元

素，两个罐是下面某一层级的子元素。 

方法 

1. 没有根据名为“蒙特利尔”的任何模板创建新元素。检入更改。 

2. 使用鼠标选择一个罐并进行拖放，同时按住键盘上的 Shift 键以将该元素移动

到 Montreal 元素下方，使它成为该位置下的子元素。 

为每个罐元素选择 父-子引用类型。下一章将会讨论不同的引用类型 

3. 对另一个罐重复执行相同的操作。检入更改。 
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提示 1：当元素移动不产生预期作用时（过早松开 Shift 键时会发生这种情况），请单击“Undo all 

changes to the Database”按钮 ( )。 

 

提示 2：以下操作可以替代拖动并按住 Shift 键操作：右键单击该元素，将其复制到新位置，然后

删除原始元素。 

3.2.10 讲师指导活动 - 使用 PI Builder 加载项批量创建 AF 对象 

PI Builder 是 Microsoft Excel 2007 的一个加载项，后者允许快速创建和批量编辑 AF 

对象和 PI 标记点。  

打开 Microsoft Excel，然后选择 PI Builder 功能区菜单。  

在 Connections 部分，选择 Asset Server（AF Server：PISRV01）和 AF 数据库 (AF 

Startup)。  

要连接到您的 AF 数据库，请单击数据库。 

 

 

从 AF 导入油罐元素。要执行此操作，请从 PI Builder 功能区菜单选择 Elements（元

素）> Find Elements（查找元素），然后选择 Tank Template（罐模板）以搜索和查

找两个罐。  

确保搜索子元素。 
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选择以导入元素的 Template（模板）配置。 
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选择 capacity 和 product 属性以导入其配置和值。 

 

单击 OK后，从 AF 导入的对象在电子表格上应显示如下： 
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使用 Excel 功能（查找-替换，Ctrl+H）为其他两 (2) 个油罐（Tank03 和 Tank04）创

建记录。  

对于 Level 属性定义，确保 Data Archive 名称是正确的。 

验证 Product 名称与材料属性 AF 表中的其中一种有效材料相匹配。 

名称 |容量 |产品 

Tank03 10000 HC1500 

Tank04 10000 WX1200|旧制法 

 

现在，可以将记录导出到 AF；这将会创建两个新油罐。  

单击功能区菜单中的“Publish”按钮 ( )。 

转到 PSE > Elements，然后按  按钮或键盘上的 F5 键确认。 

注意：要重命名元素，只需在 PI System Explorer > Elements 中右键单击它，然后选择 

Rename。或者，使用 Excel PI Builder 中的 NewName 列。 

由于 AF 使用元素的 GUID 保持关系，因此可以重命名元素，而不会破坏元素或元素与其属性或

其模板之间的关系。同样，在数据引用中，也会在元素的关系中使用 GUID。  
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3.2.11 属性特征 

属性特征可以保留父属性的特征信息。它们可以是限制、预测值、地理位置信息、原

因代码、资产健康状况和分析开始触发条件。它们可以定义为固定值，也可以与 PI 标

记点或表查找等数据引用结合使用。属性特征为子属性。 

限制属性特征：限制通常表示过程变量的预期范围。定义了以下限制特征：  

• Minimum 和 Maximum（可能的最小/最大值）  

• LoLo 和 HiHi（异常情况的极小/极大值，通常会发出警示）  

• Lo 和 Hi（需要注意的低值/高值，通常会发出警告）  

• Target（目标值，如设定点）  

预测属性特征：预告中包含预测值，可用于将实际值与父属性相比较。它通常来自未

来 PI 标记点。 

位置属性特征：可以使用位置属性定义资产的经度、纬度和高度信息。您可以使用此

信息确定该资产在地图上的位置。供 Integrator for ArcGIS 使用。 

原因属性特征：在事件框架和传送上使用原因属性特征可使用户能够为偏移、停机和

其他事件选择原因代码。原因属性特征必须为先前定义的枚举集或 PI AF 随附的系统

枚举集。 

分析开始触发条件特征：当用户配置分析以生成事件框架时，可以选择将开始触发条

件的名称存储在属性（字符串）的值中，并使用分析开始触发条件特征标记该属性。

这样，诸如 PI Vision 等客户端能够指示创建该特定事件框架的开始触发条件。 

运行状况属性特征：可以在元素和模型上使用运行状况属性特征设置数字运行状况得

分和运行状况（例如：正常运行、停止运行、维护中、警告或错误）。HealthStatus 

属性特征使用来自运行状况枚举集的值，该枚举集随 PI AF 一起提供。管理员可以根

据需要修改运行状况枚举集。 
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3.2.12 讲师指导活动 – 为油罐液位添加值限制 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

问题描述 

您希望使用属性特征维护罐的正常运行限值。对于所有罐，这些限值是相同的。 

方法 

1. 在 PSE 导航器中，选择库并打开罐元素模板。 

2. 从 Level 属性的上下文菜单中选择 Limits…： 

 

 

3. 按如下所示设置限制特征并单击 OK。 
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3.2.13 度量单位 (UOM) 

度量单位 (UOM) 功能用于自动换算数据值的单位。AF 使用度量的技术单位并允许使

用不同单位显示值。 

例如，假设油罐的 AF 属性表示直径和高度，并且 UOM 为米。AF 将使用选定的度量

单位。这就提供了以米之外的其他单位显示直径和高度的选项，例如，以英寸为单位

显示。另一个用法是在属性中使用公式。可以根据以米为单位提供的物理尺寸计算出

以升为单位的油罐容积。AF 会为您执行自动换算。 

UOM 之间的关系用简单或公式转换方法来定义。 

有一个包含所有度量单位 (UOM) 的存储库，由 AF 数据库

共享该存储库。换句话说，为一个 AF 数据库定义的 UOM 

可以在任何其他 AF 数据库中使用。  

将度量单位整理为 UOM 类。UOM 类表示可测量的属性，

例如温度、长度、时间和质量。为了方便分区域使用 

UOM，可将 UOM 与 UOM 组相关联，UOM 组可以是公制

或美国惯例（可定义其他 UOM 组）。 

 
 

在 PSE 导航器中单击 Unit of Measure，以编辑 UOM、UOM 类和 UOM 组。 
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3.2.14 讲师指导活动 – 了解 UOM 的整理和使用方式 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 了解 UOM 的整理、UOM 类和 UOM 组以及它们之间的关系。 

• 计算容器中的液体时应用度量单位  

问题描述 

 

您工厂的容器为圆柱形状。直径为 1 米，液

体内部的高度（PI 标记点：sinusoid）不是

固定的，以厘米数（范围 0-100 厘米）测

量。使用公式计算反应器体积，以升为单

位。正确应用度量单位。 

 

 

• 1 米 (m) = 10 分米 (dm) = 100 厘米 (cm) 

• 根据以分米为单位的尺寸来计算以升为单位的主体体积 

（1 升 = 1 分米 x 1 分米 x 1 分米）。  
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度量单位、UOM 类 和 UOM 组 

1. 导航至度量单位，从 UOM 类的列表中查找 Length（长度）的 UOM 类并显示

其属性。标准 UOM 是什么？ 

2. 从 Length 的 UOM 列表中打开厘米的属性。米和厘米之间如何换算？美国惯

例 UOM 组的对应单位是什么？  

注意：默认情况下，PI System Explorer 中将显示属性，同时显示用于定义这些属性的度量单

位。在 Tools > Options 中，您可以更改显示的属性以及来自选定 UOM 组的单位。 

3. 为分米添加新的 UOM（1 分米= 0.1 米），单击 OK 和 Check In。 

 
 

4. 查找 Area 的 UOM 类并显示其属性。注意，基本单位为长度 ^ 2。查找 

Volume（体积）的 UOM 类并显示其属性。请注意，基本单位是 Length ^ 3。 

5. 使用右侧的转换计算器，将 1 m3（立方米）换算为升。  

6. （附加题）使用右上角的 Search UOMs 控件，并搜索以 

sec 开头的单位。您获得的两个单位有何区别？ 
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7. （附加题）您汽车的马达有多少 kW？换算成马力。 

具有直径、灌注液位和液体体积属性的容器元素 

1. 选择 Demo AF 数据库，在导航器中选择 Elements。 

2. 找到 Container01 元素（在 UOM Demo 下）。 

3. 添加 Diameter 的属性，将默认 UOM 设置为米（从 UOM 类 Length 进行），

值类型 = 双精度，并将值设为 1。 

4. 添加 Fill Level 的属性，将默认 UOM 设置为米（从 UOM 类 Length 进行），

值类型 = 双精度。 

 

将数据引用设为 PI Point。单击 Settings，定义 tag 名称 SINUSOID，然后在 

Unit of Measure 下，将源单位设为 cm。 

SINUSOID 的值范围为 0 到 100，灌注液位属性的值将在哪个范围内？回答：  

0 m ….. ________ m 

5. 添加 Liquid Volume 的属性，将默认 UOM 设置为升（从 UOM 类 Volume 进

行），值类型 = Double。 

 

请记住，乘以以分米为单位的值便可计算出以升为单位的正确值。将数据引用

设置为 Formula 并按如下方式定义： 

 

 
 

提示：您将从 Functions 下拉列表中获得 pi() 

 

6. 选择 Tools > Options，并设置显示 UOM 组 = US Customary。单击 Refresh 

以显示 US Customary 组中的 UOM。将设置还原为 <None>。 
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7. （附加题）移除 Fill level 属性的只读标志，并输入最大 Fill level 为 1m。液体

体积是什么？使用 Windows 计算器来确认结果。 
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4. 建模并组织资产 

4.1 资产层次结构设计策略 

在 AF 数据库中，可以将资产组织或从结构上组织成层次结构。根据此定义，层次结

构是指“按等级顺序排列人或事物的系统”(thefreedictionary.com)。资产或人的逻辑层次

结构在任何行业的公司里都很常见。这些层次结构用来传达公司里每个实体的地点/位

置。由于 AF System 可能不是贵公司的唯一企业系统，因此部署的其他系统可能已经

利用了资产层次结构（维护系统等）。 

这些系统通常会选择将层次结构信息导出到平面文件（.csv、.txt 和 .xml 等）。然

后，可以在 Microsoft Excel 中打开此文件的内容，并用作在 AF 中使用 PI Builder 加

载项构建层次结构的起点。 

注意：无需在 AF 中对整个公司进行建模即可从中获得有价值的信息。事实上，构建 AF 结构通

常由项目所推动。这意味着首先可以构建包含用于 PI ProcessBook 显示的泵的小型结构。随着

越来越多的应用程序开始使用 AF，结构将不断扩大以包括您更多的资产。 

也就是说，在逐渐将资产添加到该层次结构之前，比较好的做法是定义将要在 AF 结构中展示的

各种层次结构级别（部门、地点、生产线和流程等）。 

 

可以通过多种方式在 AF 中设计资产模型。 

即使以下方法可以生成完整的资产模型，但在未来总是要添加更多的信息。这是可行

的折中办法，因为这意味着第一次构建 AF 模型并不需要做到十全十美。 

4.1.1 自下而上 

通常已经存在一个 Data Archive，因此一种方法是按类似的 Data Archive 标记点对资

产进行分组。这些“类似对象”组将成为 AF 元素模板，“对象”将成为 AF 元素。可以导

入任何外来的数据。接下来，可以添加可能有用的分析，最后添加使用者，如 PI 

ProcessBook 显示或 PI Datalink 报告。  
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自下而上方法具有明显的优势，即遵循基于实际情况的路径。Data Archive 标记点被

熟知且可以对其进行分析。  

但是，一个明显的缺点是此方法缺乏远见。此方法并不能保证结果有用，因为没有考

虑特定目标就已经构建资产模型。  

4.1.2 自上而下 

另一种方法是从解决理论问题开始：  

✓ 资产模型的目标是什么？  

✓ 使用者需要从 AF 获得什么？  

✓ 业务需求是什么？  

✓ 可以采用什么样的分析？  

✓ 哪些类别的外来数据可能有用？ 

在回答这些问题后，可以在层次结构中简述和组织元素模板和元素。接下来，可以添

加所需数据点的 AF 属性，即使还不知道数据的来源。第一阶段只添加数据的占位

符，即未配置的属性。如果证实这些属性是确实需要的属性，则可以添加分析、映射 

Data Archive Tag，并可以完全实现模型。 

此自上而下方法具有规划有用的 AF 模型的优势。请确保能够精心设计可重复使用的

模型。这一优势不可小觑，通常可以掩盖以下所有缺点。其中一个缺点是设计可能偏

离真实情况且很难实现，尽管可以通过简单的备用解决方案获得一点好处，但却很难

预测。另一个固有的缺点是模型忽略了“不是必要的”许多可用的原始数据。 

4.1.3 自上而下设计，然后自下而上建造  

首选方法是一种折中的方法：开始自上而下识别目标并试图识别适用于所有功能的良

好设计，然后快速移动到此理论和自下而上实验的混合。如果数据块看起来有用，可

以将其添加到模型，因为这样做很少出错。 

此计划的方法结合了自上而下和自下而上的优势：不但保证了模型有用，而且还能够

在构建时为真实情况和完整性提供良好的支持。此方法的步骤如下： 

• 定义资产。 

• 设计元素模板和继承树。 

• 添加属性模板。 
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• 配置属性指向外来数据或 Data Archive 标记点，它们全都包含适当的度量单

位。 

• 添加计算/分析。 

• 采用使用者测试模型（示例报告、显示等）。 

4.1.4 分组讨论 – 资产层次结构设计策略 

 

分组讨论可以分享学员在其案例中选择哪种设计策略的经验和看法。讲师将

主持讨论。 
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4.2 在层次结构中组织 AF 元素 

避免为不同的设备使用相同的名称 

如果在不同的环境中有多台设备，请勿为其分配相同的名称，因为这样会引起混淆。

以下结构可以实现，但不建议使用： 

 

 

要避免这种情况，请分配唯一名称（如在 Montreal 中分配 Tank1、Tank2，在 

Houston 中分配 Tank3 和 Tank4）或通过添加位置代码使名称变为唯一： 

 

 

 

 

资产的不同视图 

在 AF 中构建层次结构和定义资产后，可以在该结构下组织资产。根据所创建的层次

结构的类型，可以按物理位置、企业部门和设备类型等对设备进行组织排列。但是，

拥有一种资产组织并不意味着在同一 AF 数据库中不能使用其他类别的资产组织。 

AF 能够让系统管理员通过多种不同方式组织自己的资产。然后，就可以拥有同一信息

的不同视图，而避免重复的信息。可以使用“元素引用”( ) 实现此操作。  
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4.2.1 讲师指导活动 – 熟悉多种资产视图 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 了解如何在不同视图中组织资产，以便容纳公司中的不同 AF 用户组。 

 

问题描述 

在 Demo AF 数据库中，存在一个资产视图分支。主视

图按照设备的地理位置组织排列，第二个视图基于设备

类型进行维护，还有一个视图是一般库存列表。您希望

在所有视图中找到位于法兰克福的第一个锅炉。 

方法 

在 AF 中打开 Demo 数据库。展开 Equipment 和 Inventory 分支这两个位置，在所有

视图中找到位于法兰克福的第一个锅炉。查看资产树的这两个位置是否表示同一信

息。 
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1. 在 AF 中选择 Demo 数据库。在导航器中选择 Elements 并浏览 Asset Views 

分支。在所有三个视图中找到 FRA Boiler1。  

2. 打开 FRA Boiler1 元素的 General 选项卡。 

单击 Parents 链接：   

元素树中的三个位置通过相应的路径列出。元素本身的图标右上角有一个小对

号 ( )。 

 

 

 

3. 在 Locations - Frankfurt 下选择该元素并输入元素说明。检入更改。然后在其

他视图中选择一个元素引用并在其中验证经过修改的描述。 
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4.2.2 元素引用类型 

当您在资产树中创建一个新元素或元素引用时，系统将要求您定义与其父元素相关的

引用类型。  

复合 

复合关系可以将两个元素绑定在一起，这样每当更改或计算其中一个元素时，也会对

另一个元素执行相同的操作。删除父元素也会删除子元素。  

例如，连接到油罐的阀门可以表示为 AF 中的独立元素，但实际上该阀门是油罐资产

的一部分且无法独立存在。如果从工厂移除罐，也将移除阀。  

通常，与其父元素拥有复合关系的元素不能在其他位置被单独引用。 

父-子 

使用父-子元素引用，子元素可以拥有多个父元素。因此，子元素可以是多层次结构的

一部分。 

父-子元素引用是创建新的子元素时的默认设置。当您使用该引用类型时，元素属性中的替代参数

根据元素所属的层次结构进行解析。 

弱引用 

弱元素引用类似于父-子元素引用，但弱引用的元素无法独立存在。  

当您具有主视图（例如，按照地理位置组织排列的主视图）并且您为资产创建附加视图（例如，

按照业务职能组织排列）时，弱引用适用于元素引用。与父-子引用不同的是，附加视图中的元素

引用在从主视图中移除后将不独立存在。 
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4.2.3 讲师指导活动 – 了解引用类型（可选） 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 了解如何根据您删除元素时所发生的情况使用不同的引用类型。 

 

方法 

在 AF 中打开 Demo 数据库。展开引用类型 Demo。浏览以下结构中的元素之间的引

用类型。 

 

复合 

生产线 B 中的 HeatExchanger01 具有一个阀门，它是不能独立存在的交换器不可或

缺的一部分。因此，阀门与交换器的关系是复合。 

1. 选择 Heat Exchanger01 并单击右侧的 Child Elements 选项卡。选中 

Reference Type 选项： 

 

2. 选择 Heat Exchanger01 并从元素上下文菜单中选择 Delete…。选择 Delete 

以删除对象及该对象的所有引用。  
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3. 签入并刷新。结果：Valve 元素和所有 Valve 元素引用消失（这与阀门元素引

用具有父元素的强引用还是弱引用无关） 

 

弱引用 

Pump01 是 Production Line A - Pumps 的子项。这是 Pump01 的主视图。Pump01 

的元素引用在 Secondary View 元素之下，它是一个附加视图。对于此视图，

Secondary View 与 Pump01 元素引用之间的引用类型为弱引用。  

1. 选择 Pumps 并单击右侧的 Child Elements 选项卡。子元素 Pump01 与其父

项之间具有父-子引用。 

2. 选择 Secondary View 并单击右侧的 Child Elements 选项卡。Pump01 元素

引用与其父项之间具有弱引用。 

3. 选择 Pumps 并从元素上下文菜单中选择 Delete…。选择 Delete 以删除对象

及该对象的所有引用。签入并刷新。结果：Secondary View 下的 Pump01 

的元素引用消失，因为删除 Pumps 和 Pump01，即表示您已删除最后一个强

父项。 

通常，您将为元素引用使用弱引用，因为您通常具有一个主视图，其他视图是附加的辅助视图。

但是，本练习的下一部分是探索将父-子引用与元素引用一起使用。  

 

父-子 

Pump02 是 Production Line A - SiteABC 的子项。但是，它不被视为此泵的唯一视

图，因为 Pump02 的元素引用也在 Strong Families 元素之下，它是被视为具有同等

重要性的另一个视图。Strong Families 与 Pump02 元素引用之间的引用类型为父-

子。  
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1. 选择 Site ABC 并单击右侧的 Child Elements 选项卡。子元素 Pump02 与其

父项之间具有父-子引用。 

2. 选择 Strong Families 并单击右侧的 Child Elements 选项卡。Pump02 元素引

用与其父项之间具有父-子引用。 

3. 选择 Site ABC 并从元素上下文菜单中选择 Delete…。选择 Delete 以删除对

象及该对象的所有引用。签入并刷新。结果：Pump02 的元素引用会提升到元

素。它从元素引用图标更改为元素图标。（有时，即使在刷新后，PSE 仍无法

正常显示。请切换到另一个数据库，然后返回到 Demo 数据库以完全刷新。） 

  



Building PI System Assets and Analytics with PI AF 

 

第 76 页 

 

4.2.4 单独或分组活动 – 组织 Velocity Terminals 的罐 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在活动期间提供必要的指导。 

练习目标 

• 使用 PI Builder 构建其他元素。 

• 创建父元素以构建层次结构。 

• 使用拖放功能将元素组织到层次结构。 

问题描述 

现在已经为加拿大蒙特利尔工厂定义和组织了四 (4) 个油罐，您希望为贵公司 Velocity 

Terminals 的其他工厂进行油罐建模和组织。工厂地点为： 

• 加拿大，蒙特利尔 

• 日本，东京 

• 澳大利亚，悉尼 

您也可以将公司的油罐看作是包含接收和分配部门的单独层次结构的一部分。在企业

门户上搜索后，您可以找到下列文档： 
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方法 

在 AF 中，使用 Class 文件夹中的 VelocityTerminals_Assets.xlsx 工作表对其他油罐

进行建模。  

1. 要创建悉尼和东京油罐的元素，请打开电子表格。使用 PI Builder 发布 ( ) 

功能在 AF 数据库中创建新元素。  

2. 使用 PSE，创建新元素（而不是基于任何模板）对位置和部门进行建模。  

3. 使用之前介绍的拖放方法将油罐移动到相应的层次结构（Shift 键 = 移动元

素）。  

4. 要在 Divisions 下创建元素引用，请将油罐元素拖动到 Divisions 下相应的元素

（不按下任何键 = 创建元素引用）。 

注意：使用元素引用。使用位置下的父-子引用和部门下的弱引用。 

4.3 使用 PSE 中的导入和导出功能 

在 PSE 中，可以使用导入和导出功能将整个 AF 数据库或一个 AF 对象导出到 XML 

文件中。使用导入功能，可以将此 AF 对象导入另一个 AF 数据库。此功能还可用于

在执行可能的破坏性操作之前备份 AF 结构。 

只需右键单击 AF 对象，并选择  选项，即可导出几乎所有 AF 对象。

要导出整个 AF 层次结构以及完全重建必需的所有信息，只需使用 File > Export to 

File 选项。 
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为了能够按原样重建此结构，必须选中 Include All Referenced Objects，以使模板、

表、UOM 等内容也导出到 .xml 文件中。 
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4.3.1 讲师指导活动 – 导出和导入数据库 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 了解如何从 AF 数据库导出一个 XML 文件并将其导入到其他 AF 数据库。 

问题描述 

已在专用于培训和检出的 AF 数据库中创建 Velocity Terminals 的 AF 结构。我们希望

将其发布到另一个 AF 数据库中用于生产。为执行此操作，我们将导出 AF Startup 数

据库的内容并将其导入被称为 Velocity Terminals 的另一个 AF 数据库。 

方法 

• 在 AF Startup 数据库打开的情况下，从 PSE 菜单中选择 File > Export to 

File。 

• 单击  图标并更改设置，以将 XML 文件另存为 

C:\Class\Exercises\01_Velocity Terminals\My Velocity Terminals.xml。单击 

Save 按钮（注意：此操作实际上不会创建 XML 文件！） 

 

• 勾选 Include All Referenced Objects 选项。单击 OK。 

 

• （可选）使用编辑器并检查 XML 文件：查找度量单位、油罐模板、表、为 VT 

油罐创建的元素等。 

 

• 单击  按钮并选择 Velocity Terminals 数据库。 

 

• 在 PSE 菜单中选择 File > Import from File，然后选择最近保存的文件。 
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• 验证生产数据库中的对象是否已成功创建。 
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5. 可视化数据 

5.1 在 PI Vision 中可视化 AF 数据 

PI Vision 是一个基于 Web 的新颖直观的可视化工具，用于通过快速创建显示来定制

即席分析。PI Vision 允许您： 

• 在桌面或移动平台上搜索 PI 数据。  

• 采用符号将 PI 数据可视化，例如趋向图、表、值和计量器。  

• 配置多状态符号，为关键的进程状态创建可视警示。  

• 设计、设置格式以及保存显示，方便进行检索和实施进一步的分析。  

• 分析和比较进程事件。  

• 在显示中监控进程数据。  

• 与组中的其他成员或具备 PI Vision 访问权限的用户共享显示。  

• 查看 PI ProcessBook 显示。  

注意：在 2017 版本之前，PI Vision 之前的名称为 PI Coresight。 

PI Vision 主页： 
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PI Vision 利用高效的搜索引擎让您浏览企业的 AF 结构和快速查找感兴趣的信息。在

开始查看和分析一些数据时，PI Vision 将查找您可能也感兴趣的相关信息。  

如果您在 AF 中添加了新的数据库并希望使用 PI Vision 进行访问，则必须更新 PI 

Vision 中允许的 AF 数据库列表： 

打开 PI Vision 管理页面，然后在 Configuration 部分中选择 AF 服务器选项卡。您可

能需要展开 AF 服务器名称下的结构以查看可用数据库。要添加 AF 数据库，请选中 

AF 数据库名称旁的复选框并单击 Save。 

5.1.1 讲师指导活动：在 PI Vision 显示中直观显示 Velocity Terminal 数据 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 创建包含油罐数据的 PI Vision 显示（AF 数据库：Velocity Terminals） 

• 加入具有当前数据的对象（趋向图、表、值对象、计量器） 

• 加入图片 

• PI Vision 显示中的资产交换 

 

问题描述 

您的经理要求用以下方式在 PI Vision 显示（名称：Velocity Terminals Tank）中直观

显示油罐数据： 
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该显示是其中一个油罐的设定，通过它可在 Velocity Terminals 中的所有油罐之间切

换。 
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方法 

 

1. 单击桌面链接，打开 PI Vision。链接为 http://pisrv01/PIVision。 

收藏夹下还存在 PI Vision 的书签 。 

主页中通过显示的缩略图提供了一个概览，它是为本培训专门准备的。 

2. 要创建新显示，请单击链接  

注意：您处于修改显示操作中：操作图标的背景为橙色， 画布边框为橙色。要切换到监控操作

（您可以在任何非空显示中执行此操作），请单击操作图标，画布边框将会消失，且操作图标背

景切换为蓝色 。您可以在这两种操作模式之间来回切换。 

3. 搜索窗格显示 AF 数据库中元素和 Data Archive 中 Tag 的搜索路径。 

 

4. 展开资产结构以导航到 Tank01。选择 AF 数据库 Velocity Terminals 并深入到 

Locations > Montreal > Tank01。选择 Tank01 以获得该油罐的属性。 

 

http://pisrv01/PIVision
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5. 选择 Level 属性并将其拖动到左侧的显示画布。 

 

 

6. 单击 Level 属性的 > 以展开结构并显示特征。将 Hi、HiHi、Lo、LoLo 和 

Target 拖动到趋向图。从鼠标右键菜单中选择 Format Trend。 

在 Single or Multiple Scales 下选择 Show Single Scale。 

在 Scale Range 下选择 Use database settings。 

单击画布以关闭 Format Trend 设置。 

单击底部的时间选择器，并将时间显示范围切换为一小时。 
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7. 单击 Image 图标  并在显示画布中拖出一个矩形。在 Browse... 选项下，

导航到 C:\Class\Exercises\01_Velocity Terminals 下的 VT Tank.jpg 

 

 

8. 从对象列表中选择值对象 。将 Tank Name拖动到油罐图片顶部。  

 

9. 从值对象的鼠标右键菜单中选择 Format Value。取消选中 Label、Units 和 

timestamp。将值颜色更改为黑色。 

 

 

10. 相应地，将产品属性的值对象放置在右下角 

 

 



Building PI System Assets and Analytics with PI AF 

 

第 88 页 

 

11. 从对象列表中选择垂直计量器对象 。将 Level拖动到油罐图片中心。使用 

Format Gauge 更改外观。 

 

12. 从计量器对象的鼠标右键按钮中选择 Add Multi-State。按如下所示更改颜色： 

 

Bad data：  洋红 

HiHi – Maximum： 蓝色 

Hi – HiHi：  淡蓝色 

Lo – Hi：  淡绿色 

LoLo – Lo：  橙色 

Minimum – LoLo： 红色 
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13. 单击 Tank01 的 <，再次折叠结构。 

从对象列表中选择表对象 。选择 Capacity、Density、Product 和 Volume

（按住 Ctrl 键）。然后将其拖动到趋向图的上方。您将看到一个表，其中有一

个标题行和四个与您所选择的四个属性对应的行。 

从鼠标右键菜单中选择 Table Columns…，并取消选中 Description、Trend、

Minimum 和 Maximum。 

 

14. 单击右上角的保存图标 。将显示保存为 Velocity Terminals Tank。 

15. 使用资产选择器  切换到另一个油罐 Tank02。 

16. 可以使用底部的时间控制来更改显示范围。使用向左箭头可浏览过去的时间

段。 

17. 将光标放在趋向图的底部区域并拖动以切换时间范围。 

 

 

18. 要退回到从现在起的过去一小时，请单击 Now 按钮，然后从时间范围选择器

中选择 1h。 

19. 注意：在显示中进行更改后，显示名称的结尾将有一个星号，表示已经更改

过。 
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要保存更改，单击保存图标 。要以其他名称保存修改过的显示，请从 

Save 按钮旁的下拉列表中选择 Save As 并以其他名称保存。 

20. 将库中的符号添加到显示。单击左侧的符号  将会打开库。 

5.2 PI ProcessBook 元素相关显示（可选） 

5.2.1 讲师指导活动 – 在 PI Procesbook 显示中直观显示 Velocity Terminal 数据 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 使用其中一个 Velocity Terminals 罐中的数据创建 PI Processbook 显示 

• 允许将显示切换到另一个罐  

 

方法 

打开 PI ProcessBook，然后使用 File > New 菜单创建名为“Tank Monitoring”的 *.PDI

（独立显示文档）。 

在 View 菜单中，选择 Element Relative Display 并注意左侧显示的面板。  

将显示一个 PSE 图标 ( )，选择该图标，然后从出现的 Element Search 对话框中选

择 AF Server-AF System-Database。  

确保选中 Search Sub-Elements 复选框，然后单击 Search 按钮并选择四 (4) 个油

罐。  

将油罐添加作为 Elements of Interest。 
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从菜单中选择 Tools > Build，然后选择 Draw > Symbol Library。  

现在，在屏幕的绘制区域中，在屏幕上拖拽出约 1 ½ 英寸的正方形以从符号库添加新

符号，如下所示。 

  

这将显示一个“符号库”窗口。 

从 Tanks 类别中选择要添加到显示的油罐符号。 

确保仍然处于“构建”模式下（如果不是，请再次单击锤子 ( ) 图标）。 

在油罐旁边添加条形图来表示其液位，选择 Draw > Bar，然后在屏幕上拖拽出一个条

形。  

从 Define Bar 窗口中，打开 Tag Search 按钮旁边的下拉弹出菜单，然后选择 

Element Relative。 
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随即应显示选定的油罐及其属性。  

选择 Level 并使用向下箭头将其推送到 Selected Attributes 列表中，然后单击 OK。  

选择 Draw > Value，在绘制区域单击罐符号的

正下方以添加一个动态值。  

仍然使用 Element Relative 选项，再次选择 

Level 属性。 

选择 Draw > Trend，并拖动形成所需大小的矩

形来添加一个趋势图。  

仍然使用 Element Relative 选项，选择要在该

趋势图上显示的 Mass 属性。 

在罐上方添加另一个 Value 符号，但这次是通

过选择 Select Attributes 窗口底部的 Add 

Element Name 按钮。 

（可选）添加两个其他值符号来显示 Capacity 

和 Volume 属性。 
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从 Tools > Run 切换到“运行”模式。 

从左侧面板选择不同的油罐以确认 PI ProcessBook 显示现已元素相关；这意味着显

示的信息取决于在侧窗格上选择的油罐。  

利用 AF 结构和模板可以创建可重复使用的 PI ProcessBook 显示来表示类似设备。 

请注意，趋势图符号上显示的“质量”属性包含显示的历史记录，即使属性是不久之前

所创建。公式结果不是存储在 Data Archive 中，而是在客户端请求数据时根据需求计

算公式结果。  

AF 能够将 PI System 数据转换为信息。 

5.3 PI Processbook 中基于 AF 的符号（可选） 

使用“元素相关”显示，可以在油罐之间轻松切换，除非您不想在油罐之间切换。您是

否想要在一个显示中包含所有油罐信息（如在一个显示中包含所有蒙特利尔油罐的信

息）？ 
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要支持这种功能，Processbook 拥有基于 AF 的符号，可以分配给 AF 资产元素模板

或元素。  
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5.3.1 指导活动 — 将符号分配给模板或元素 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 演示将符号分配给模板。 

问题描述 

蒙特利尔的四个油罐都出现了问题。您的经理不想切换显示以比较油罐属性。他希望

在一个显示中查看四个油罐以解决问题。 

 

方法 

我们为其中一个油罐创建一组 PI Processbook 符号，我们可以将这些符号与 AF 中的

油罐模板相关联。然后，可以轻松地为其他油罐复制此符号。  

打开 PI ProcessBook 并打开显示 Tanks Montreal.PDI（位于 class\exercises 文件夹

中）： 
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在 Tank01 的区域中，添加 Material、Capacity 和 Current Volume 的值对象。在构建

模式下，单击 Draw > Value，然后单击显示以将符号定位在文字 Material 的右侧。在 

Define Value 对话框中，单击下拉箭头并选择 AF2： 
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注意：AF2.x 数据集提供访问 AF 数据库的权限，允许您为 PI ProcessBook 符号配置 AF 属性。 

在 Select AF attribute 对话框中，单击 AF 资产树中的 Tank01，然后选择 Product 属

性，UOM = <none>： 

 

为属性 Capacity（属性：Capacity，UOM=US Gallon）和 Current Volume（属性：

Volume，UOM = 立方米）重复同一操作。  

在构建模式中，单击 Draw > Bar，将光标定位在油罐符号上，然后单击以打开垂直条

形图的矩形。在 Define Bar 对话框中，单击下拉箭头并选择 AF2。在 Select AF 

attribute 中，单击 AF 资产树中的 Tank01，然后选择属性 Level，UOM = %。 
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现在，选择底部矩形中的对象（油罐、条形图、文本和值对象），然后选择 

Arrange > Group，将这些对象合并成一个对象。 

 

从上下文菜单中选择 Assign Symbol to Template…，然后选择油罐模板。 

注意：如果 Assign Symbol to Template… 菜单项灰显，则选择显示中的另一个对象，然后重新

选择组符号。现在应当可以选择该菜单项。 

单击 View > AF Browser。要复制其他油罐的油罐符号，选择 AF Browser 中的 

Tank02 并将其拖动到显示中的相应空间。对于 Tank03 和 Tank04，请重复上述操

作。 

5.4 PI Datalink 

PI Datalink 是一个 Microsoft Excel 加载项，可让您将数据从 PI System 导入电子表

格。PI Datalink 结合了 Microsoft Excel 的计算、图形和格式设置功能，可以提供用于

收集、监控、分析和报告 PI System 数据的强大工具。 

5.4.1 PI Datalink 对 AF 的支持情况 

使用 PI Datalink 2013+，可以创建利用 AF 模型的报告，从而可在类似资产之间重复

使用这些报告。PI Datalink 2013+ 可以利用新的集成搜索引擎，一次搜索所有 Tag 和

资产。 

PI Datalink 2014 推出了针对事件框架的支持，这将在以后的课堂上讨论。 
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5.4.2 讲师指导活动 – PI Datalink 基础知识：访问采样的 Tag 数据 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

本练习是对 PI Datalink 的简要介绍。通过本练习，可以熟悉用于创建电子表格并在其中包含 PI 

System 中动态数据的建议步骤。 

 

活动目标 

• 使用采样数据功能获得指定时间间隔内 Tag 的插值数据。 

• 了解如何引用电子表格单元格来指定 Datalink 函数的参数。 
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问题描述 

您将获得一个包含 Tag TANK01LI.PV 中的 Tag 插值的报告。此列表应当涵盖过去 4 

小时的时间段并按 15 分钟的间隔列出值。  

 

方法 

1. 打开位于 c:\class\exercises\01_Velocity Terminals 文件夹中的 AF Class 

Datalink Exercises 电子表格。 

2. 选择 PI DataLink 功能区。浏览不同的 PI Datalink 函数组（另请参阅下一页的

列表）。哪一个是您需要使用的函数？ 

 
_______________________________________________________ 
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组 函数名 功能 示例 

单个 

值 

当前值 
检索数据项当前或最近的

值 

当前外部空气温度是多少？ 

存档值 
检索指定时间点的数据项

值 

今天早上 8 点的罐液位是多少？ 

多个 

值 

压缩数据 
检索指定时间范围的数据

项值 

昨天存储在压力传感器的存档中

的值有哪些？ 

采样数据 
检索指定时间范围的均匀

分布的数据项插值 

上个星期日每个整点列出的风力

涡轮机发电量是多少？ 

定时数据 

检索与一系列指定的时间

戳相匹配的数据项插值  

昨天在压力传感器的存档中存在

值的时间点，罐中的 CO2 浓度

值是多少？ 

计算 

计算数据 

检索计算得出的数据项

值。该计算执行一段时间

的合计（如最小值、最大

值、平均值等） 

昨天反应器内部温度的每小时平

均值是多少？ 

过滤时间 计算性能方程式在指定时

间范围内计算结果为 true 

的时间。 

昨天电机处于“运行”状态的时间

有多长？ 
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3. 选择名为 Tags 的电子表格选项卡。 

4. 在单元格 B1 中输入 Tag 名称 TANK01LI.PV。 

5. 将光标放在单元格 D1 中。我们想让 Datalink 函数的结果显示在这里。 

注意：在选择 PI Datalink 函数之前，选择电子表格中的 Datalink 函数结果应当输出到的

单元格！这应当是电子表格中的空闲区域，以便不会覆盖现有内容！  

6. 从 Multiple Value 组中选择 Sampled Data 函数。结果：右侧显示 Sampled 

Data 参数窗口。将光标放在 Data Item(s) 中以选择此参数。 

注意：单击图标上半部分。如果您选择下半部分，您将选择该函数以及预定义的参数。  

7. 在选择 Data Item(s) 后，单击单元格 B1 以引用 Tag TANK01LI.PV。结果：参

数设置为 ‘Tags’!$B$1 

8. 将光标放在 Start time 中以选择该参数，然后单击单元格 B2。 

9. 将光标放在 End time 中以选择该参数，然后单击单元格 B3。 

10. 将光标放在 Time interval 中以选择该参数，然后单击单元格 B4。 

11. 选中 Show time stamps。 
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12. 单击 OK 按钮。结果：数据返回到单元格区域 D1 … E17。 

注意：如果您单击 Apply 而非 OK，则 Sampled Data 参数窗口不会关闭。 
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5.4.3 讲师指导活动 – PI Datalink 基础知识：包含 AF 中的数据的报告 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

本练习重复上一练习，但不引用 Tag，而是引用 AF 中的属性（具有 PI 标记点数据引用）。 

 

活动目标 

• 了解如何在 PI Datalink 函数中指定 AF 属性。 

 

问题描述 

应当通过引用 AF 中 Tank01 的 Level 属性构建上一练习中的报告。 

 

方法 

可以采用两种方法执行此操作： 

• 引用在 Datalink 函数的一个参数中具有完整 AF 路径的 Level 属性 

• 引用在两个参数中具有路径和属性名称的 Level 属性 
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完整 AF 路径 

1. 选择名为 Attributes (1) 的电子表格选项卡。 

2. 将光标放在单元格 B1，然后单击搜索图标的下半部分并选择 In a row。结果：

出现 Datalink Search 窗口。您可以在 AF 中搜索 Tag 或信息。选择 AF 服务

器 PISRV01。结果：上述搜索路径中显示 PISRV01。 

3. 单击 Velocity Terminals 数据库，然后进一步深入到元素 Velocity Terminals – 

Locations – Montreal。 

4. 在搜索字段中输入 Level 并单击右侧的放大镜。结果：列出四个 Level 属性，

位于蒙特利尔的每个罐一个属性，Tank01 … Tank04。 

5. 将 Data item length 的滑块拖动到左侧位置，即 Full Path。 

6. 选择上述列表中的 Tank01 行，然后单击 OK。结果：单元格 B1 中出现完整

路径： 
\\PISRV01\Velocity Terminals\Velocity Terminals\Locations\Montreal\Tank01|Level 

注意：| 符号会将路径与属性名称分隔开。 

7. 将光标放在单元格 D1 中。我们想让 Datalink 函数的结果显示在这里。从 

Multiple Value 组中选择 Sampled Data 函数。结果：右侧显示 Sampled Data 

参数窗口。将光标放在 Data Item(s) 中以选择此参数。 

8. 在选择 Data Item(s) 后，单击单元格 B1 以引用具有完整路径的单元格。  

9. 为 Start time、End time 和 Time interval 设置参数并选中 Show time 

stamps。 
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10. 单击 OK 按钮。结果：数据返回到单元格区域 D1 … E17。 
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路径和项目（属性名称）在两个参数中 

1. 选择名为 Attributes (2) 的电子表格选项卡。 

2. 将光标放在单元格 B1，然后单击搜索图标的下半部分并选择 In a row。结果：

出现 Datalink Search 窗口。  

3. 运行与上一练习相同的搜索（可能仍然存在）并获得与之前列出的内容相同的

四个 Level 属性。 

4. 将 Data item length 的滑块拖动到右侧位置，即 Name Only。 

5. 选择上述列表中的 Tank01 行，并选择 Insert root paths in: Column or Row。

单击 OK。结果：路径显示在单元格 B1 中，属性名称显示在单元格 B2 中。 

6. 将光标放在单元格 D1 中。我们想让 Datalink 函数的结果显示在这里。 

7. 从 Multiple Value 组中选择 Sampled Data 函数。结果：右侧显示 Sampled 

Data 参数窗口。将光标放在 Root path 中以选择此参数。 

8. 选中 Root path 后，单击单元格 B1。结果：参数设置为 ‘Attributes (2)’!$B$1 

9. 为 Start time、End time 和 Time interval 设置参数并选中 Show time 

stamps。 

 

 

10. 单击 OK 按钮。结果：数据返回到单元格区域 D1 … E17。 
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5.4.4 讲师指导活动 – PI Datalink：在包含 AF 中的数据的报告中切换资产上下文 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

PI Datalink 搜索窗口可以在 Excel 中生成下拉列表，可以将报告应用于多个类似资产。此练习重

复前面的练习，但介绍了如何使用下拉选项创建单元格以切换资产上下文。  

 

活动目标 

• 创建可以在不同资产间切换的 Datalink 报告。  

 

问题描述 

上一练习中的报告给出了罐的液位属性值，应当对其进行增强以允许在十二个罐之间

切换。 

 

方法 

 

1. 选择名为 Attributes (3) 的电子表格选项卡。 

2. 将光标放在单元格 B1，然后单击搜索图标的下半部分并选择 In a column。结

果：出现 Datalink Search 窗口。  

3. 展开所有位置中的罐搜索。可以通过在上面的搜索中单击 Locations（位置）

执行此操作。在搜索字段中输入 Level 并单击右侧的放大镜。结果：列出十个

液位属性，十个罐中的每个罐一个属性，Tank01 … Tank10。 

4. 将 Data item length 的滑块拖动到右侧位置，即 Name Only。 

5. 选择上述列表的所有行（可以单击该项的标题行中的复选框），并选择 Insert 

root paths in: Drop-down list。单击 OK。结果：路径显示在单元格 B1 中，属

性名称显示在单元格 B2 中。 

6. 如果单击单元格 B1，您会看到十个罐其中一个罐的下拉选择器图标。 
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7. 将光标放在单元格 D1 中。我们想让 Datalink 函数的结果显示在这里。 

8. 从 Multiple Value 组中选择 Sampled Data 函数。结果：右侧显示 Sampled 

Data 参数窗口。将光标放在 Root path 中以选择此参数。 

9. 选中 Root path 后，单击单元格 B1。结果：参数设置为 ‘Attributes (2)’!$B$1 

10. 将光标放在 Data Item(s) 中以选择此参数。选定数据项后，单击单元格 B2。 

11. 为 Start time、End time 和 Time interval 设置参数并选中 Show time 

stamps。 

12. 选中 Show time stamps。 

 

 

13. 单击 OK 按钮。结果：数据返回到单元格区域 D1 … E17。 

14. 如果切换单元格 B1 中的罐选择，报告将检索选定罐的数据。 
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5.4.5 单独或分组活动 – 罐液位报告 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

目标 

• 练习在 PI DataLink 中搜索。 

• 熟悉用于检索存档数据的 PI Datalink 功能。 

问题描述 

生产主管需要 Excel 报告来显示今天上午 8:00 至 9:00 之间位于蒙特利尔的罐的液位

变化。 

方法 

选择名为 LevelReport 的电子表格选项卡。 

使用存档值功能来检索今天上午 8:00 和 9:00 的液位变化。在获得两列的液位后，可

以使用 Excel 计算差异。在讲师创建此 PI Datalink 报告时，您可以观察并跟着操作。

使用 Excel 条件格式（Excel“开始”选项卡，“样式”组）突出显示负值变化。 
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5.4.6 单独或分组活动 – 构建元素相关 PI Datalink 报告 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

目标 

• 体验使用 PI Datalink 的资产相关功能。 

• 遵循创建适用于类似资产的报告所需的步骤。 

问题描述 

创建一个小报告，其中包含前一天其中一个 Velocity Terminals 罐中出现的液位和质

量的每小时平均值。此报告应当具有一个罐的数据，但应当允许切换到另一个罐。  

 

 

方法 

选择名为 Tank Analysis Report 的电子表格选项卡。 

哪个 Datalink 函数允许聚合数据，如获得一段时间的平均值？ 

 
_______________________________________________________ 
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提示：单元格 C8 和 F8 准备显示迷你图。下面说明了如何为液位数据添加迷你图：  

− 选择包含数据的单元格（仅选择值，不选择时间戳） 

− 从 Excel 的“插入”功能区中选择“迷你图” 

− 选择输出单元格 (C8) 

 

 

（相应地，获得质量迷你图） 
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6. 将分析添加到资产 

PI Asset Framework 提供多个选项，可通过基于 PI Data Archive 中的值执行的计算

增强数据。这些计算可将 PI System 提供的原始流程数据转换成决策信息。 

AF 计算选项 示例 

值检索方法 

（在 PI 标记点数据引用中定义） 

获得 PI 标记点在特定时间点（例如 2 小时以

前）的插值，获得 PI 标记点在定义的时间段

的汇总数据（例如过去 24 小时的最大值） 

公式数据引用 即席计算（加两个罐的容量） 

资产分析 

（表达式、汇总、事件框架生成、SQC） 

表达式：执行所有类型的简单和复杂计算，如

汇总、消耗量、指标数据、KPI 等。 

汇总：聚合/合计资产层次结构中多个级别的

数据（例如，所有反应器的最高温度、所有生

产线中的总产量） 

EF 生成：监控特定条件下的过程并在事件框

架内捕捉（停机、过程偏移） 

SQC：在线统计计算 

决定使用哪些计算选项时，请考虑以下方面： 

• 计算会对在 PI System 上造成哪些负载？ 

• 我是否需要保存计算的历史记录？ 

• 是否将对多个资产运用计算？ 

• 计算的复杂程度如何？ 

要了解相关信息，请参阅下一章结尾的比较表。 

除了 AF 中的选项外，PI System 中还有其他选项：性能方程式 (PE) 标记点和 

Totalizer Tag（PI Data Archive 中基于 Tag 的分析 (*)），Calculated Data（计算数

据）功能和 PI 表达式 (PI Datalink)、PI Calculation 数据集 (PI Processbook) 和 PI 

Advanced Computing Engine (PI ACE)。 
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(*) 注意：OSIsoft 强烈建议用户升级到支持事件框架、公式数据引用及 PI Asset Framework 的其

他新功能的资产分析，而不要使用 PI Data Archive 中基于 Tag 的分析。 

6.1 AF 计算选项概述 

本部分概括介绍 PI System 中的计算选项，稍后将更详细地单独介绍各个选项。 

 

值检索方法 

• PI 标记点数据引用内的可配置选项 

• 默认情况下显示 tag 的当前值 

• 按时间：从另一个时间点获取数据 

（例如，来自 2 小时以前的值） 

• 按时间范围：获取汇总数据 

（例如，来自过去 15 分钟的最大值，基于流入的最大材料量） 

 

 

 

公式数据引用 

• 即席计算，无需保存历史记录 

• 在一个或多个方程式中定义计算 

• 基于变量的方程式语法， 

运算符（+、* 等）和函数（sin、cos、abs、sqrt 等） 

• 示例：基于容量和级别的体积，基于商品数量和当前奖品的库存价值 
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资产分析（分析） 

• 分析类型：表达式、汇总、事件框架生成、SQC 

 

表达式分析： 

• 根据属性、变量、运算符和函数定义的计算   

• 函数包括性能方程式 (PE) 函数 

（例如，FindEq、TimeGE、TagMax、Tag Avg 等） 

• 存储在属性中的结果（分析数据引用、PI 标记点数据引用） 

 

注意：这是第一个方向。稍后将更详细地介绍表达式分析以及其他分析类型。 

比较 

为帮助您选择最佳计算选项，请使用下表。 

 值检索方法 公式数据引用 表达式分析 

（输出至非 PI 标

记点属性） 

表达式分析 

（输出至 PI 标记

点属性） 
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创建方法 Configuration 表达式 表达式 表达式 

函数 否 有限 PE PE 

历史化 否 否 否 是 

重新计算/回填 否 否 否 是 

计算负载 Server 客户端 客户端 Server 

时间意识 相关 否 是 是 

6.2 公式数据引用 

公式数据引用用于创建简单的自定义计算。计算可以是一个单一的公式或是一个序列

的计算。可以根据需求执行计算，且不能将结果存档在任何位置。可用的函数有限，

且这些函数不是时间加权函数。 

 

 

 

我们在本课的上一章中设置 Velocity Terminals 罐时使用了公式。这是为了获得一个

额外的属性和基于容量与液位百分比的罐容量的即席计算。 

6.3 值检索模式 

默认情况下，PI 标记点数据引用会检索特定标记点的当前值。可以配置 PI 标记点数

据引用的值检索方法，因此值将为 

• 特定时间的标记点值（按时间检索模式） 
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• 一段时间范围内标记点值的计算结果，例如平均值 

（按时间范围检索模式）。 

 

 

有关完整信息，请参阅《PI System Explorer 用户指南》(PI System 

Explorer User Guide)2015 版第 140 和 141 页的“PI 标记点数据引

用”(PI point data references) 一章中的“按时间配置值检

索”(Configure value retrieval by time) 和“按时间范围配置值检

索”(Configure value retrieval by time range)。 

  

http://icons.mysitemyway.com/wp-content/gallery/black-white-pearls-icons-culture/024263-black-white-pearl-icon-culture-book3-open.png
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按时间 — 检索除当前值以外的值。 

 

 

按时间模式选项有 After、At or After、At or After、

Automatic、Before、Exact Time和 Interpolated。要获得不

同于当前值的值，可以在 Relative Time 字段的上下文中使用

这些选项。相对时间表达式必须采用 PI System 时间格式（参

见下方示例）。  

 

按时间 相对时间 含义 

At or After -15m 返回当前时间之前 15 分钟的记录值。如果该时间不存在值，则返

回下一个记录值。 

After -2h 返回两小时以前的时间点之后的第一个记录值。如果恰好在该时间

存在值，则不返回该值。 

Exact -2h 返回当前时间之前两小时的记录值。如果该时间不存在值，则返回

“No Data”错误。 

Interpolated T+6h 返回当天 6:00:00 的插值时间。 
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注意：请不要为 By Time 选择 Not Supported、Time Range 和 Time Range Override 选项。这

些选项适用于基于时间范围计算的属性值（见下文）。 

按时间范围 — 检索聚合的结果 

 

 

按时间范围选项有： 

Average (time-weighted)、Count、Delta、Maximum、Minimum、Population 

Standard Deviation、Standard Deviation、Start Time、End Time、Total。 

如果选择 Total，将显示一个额外的下拉列表，用于指定执行计算的速率标记点或属性

的时间单位。度量单位是必需的，因为 Data Archive 始终假设速率标记点的度量单位

为单位/天。因此，选择正确的时间单位对于检索正确的结果至关重要。 

By TimeRange 检索的 By Time 字段中的选项有 Not Supported、Time Range 和 

Time Range Override。下表根据客户端应用程序正在提供的时间上下文的不同列出

了相应行为。  

 

按时间设置 含义 
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Not Supported 如果客户端应用程序发送一个时间范围，则考虑执行计算。如果客

户端应用程序发送时间点（非时间范围），则返回错误。  

Time Range 如果客户端应用程序发送一个时间范围，则考虑执行计算。如果客

户端应用程序发送时间点（非时间范围），则使用 Relative Time 

下指定的时间范围。 

Time Range 
Override 

在任何情况下都使用 Relative Time 下指定的时间范围。 

6.3.1 讲师指导活动 – 了解时间范围的值检索模式（可选） 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 区分时间段的检索模式：Not Supported、Time Range 和 Time Range 

Override。 

 

问题描述 

• 您正在测量温度，并希望获取过去一小时以及在 PI Vision 趋势中应用的时间

段内的最小值和最大值。  

 

方法 

打开 Demo 数据库并选择 Value Retrieval Demo 元素。  

1. 显示元素属性并获取其函数。 

属性名称 值 

Temperature 从现在起的实际值 
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Temperature.Min. 
TimeRangeNotSupported 

某时间段的温度最小值：由客户端（此处为 PSE）提供时

间范围。由于 PSE 不提供时间范围，因此会显示相应的

错误（该属性需要一个时间范围…）。 

Temperature.Min. 
TimeRange.1HR 

某时间段的温度最小值：如果客户端（此处为 PSE）提供

时间范围，则使用此属性。由于 PSE 不提供时间范围，

因此使用指定范围 (1hr)。 

Temperature.Min. 
TimeRangeOverride.1HR 

一小时内的温度最小值 

（根据三个最小值属性，有三个对应的最大值属性） 

2. （可选）从 PSE 的 Tools > Options > Time Context 中，设置 PSE 的时间范

围，例如过去五分钟。讨论值属性的变化。重置时间上下文（查询日期时间 = 

最新可用） 

 

单击桌面链接打开 PI Vision 并选择 Retrieval Modes Demo 显示。  

 

1. 显示元素属性并获取其函数。将时间段选择器设为 1h： 

 

 

属性名称 值 

Temperature 从现在起的实际值 

Temperature.Min. 
TimeRangeNotSupported 

某时间段的温度最小值：由客户端（此处为 PI Vision）提

供时间范围。PI Vision 时间范围为一小时。这就表示温度

最小值是指一小时内的温度最小值。 

Temperature.Min. 
TimeRange.1HR 

某时间段的温度最小值：如果客户端（此处为 PI Vision）

提供时间范围，则使用此属性。PI Vision 时间范围为一小

时。这就表示温度最小值是指一小时内的温度最小值。 
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Temperature.Min. 
TimeRangeOverride.1HR 

一小时内的温度最小值 

（根据三个最小值属性，有三个对应的最大值属性） 

 

2. 将时间段选择器设为 8 小时。 

属性名称 值 

Temperature 从现在起的实际值 

Temperature.Min. 
TimeRangeNotSupported 

某时间段的温度最小值：由客户端（此处为 PI Vision）提

供时间范围。PI Vision 时间范围为 8 小时。这就表示温度

最小值是指 8 小时内的温度最小值。 

Temperature.Min. 
TimeRange.1HR 

某时间段的温度最小值：如果客户端（此处为 PI Vision）

提供时间范围，则使用此属性。PI Vision 时间范围为 8 小

时。这就表示温度最小值是指 8 小时内的温度最小值。 

Temperature.Min. 
TimeRangeOverride.1HR 

一小时内的温度最小值 

3. 将开始时间设置为 y+22h，将结束时间设置为 t。这是今天午夜前两小时的时

间段。 

（昨天 22:00:00 – 今天 00:00:00）。 

 

属性名称 值 

Temperature 今天午夜的值（今天 00:00:00） 

Temperature.Min. 
TimeRangeNotSupported 

某时间段的温度最小值：由客户端（此处为 PI Vision）提

供时间范围。PI Vision 时间范围为两小时。这就表示温度

最小值是指今天午夜前两小时内的温度最小值。 

Temperature.Min. 
TimeRange.1HR 

某时间段的温度最小值：如果客户端（此处为 PI Vision）

提供时间范围，则使用此属性。PI Vision 时间范围为两小
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时。这就表示温度最小值是指今天午夜前两小时内的温度

最小值。 

Temperature.Min. 
TimeRangeOverride.1HR 

温度最小值针对今天午夜前一小时时间段（昨天 23:00:00 

– 今天 00:00:00） 
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6.3.2 讲师指导活动 – 将值检索模式应用于油罐液位属性 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 使用值检索模式可获得两个小时以前的 Tag 值以及过去两个小时的平均值。 

 

问题描述 

• 除了油罐中实际物质含量液位外，操作人员还希望查看 2 小时以前的液位水平

以及过去 2 小时的平均液位。  

 

方法 

打开 Velocity Terminals 数据库的库中的 Tank模板。 

选择 Attribute templates 选项卡。  

对于两个小时以前的值： 

1. 选择具有液位属性的行，并从鼠标右键上下文菜单中选择 New Child Attribute 

Template。 
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2. Attribute Name = Level.2HoursAgo 
Default UOM = percent 
DisplayDigits=2 
Data Reference = PI Point 

3. PI 标记点设置： 
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对于过去两个小时的平均值： 

1. 选择具有液位属性的行，并从鼠标右键上下文菜单中选择 New Child Attribute 

Template。 

2. Attribute Name = Level.2HoursAverage 
Default UOM = percent 
DisplayDigits=2 
Data Reference = PI Point 

3. PI 标记点设置： 

 

 

 

 

 

 

 

 

 

 

 

 

验证结果： 

1. 打开其中一个 Velocity Terminals 油罐（查看 Tank03，因为 Tank01 和 

Tank02 的液位变化太过频繁）。 

2. 选择包含液位属性和最近创建的两个子属性的行，然后从鼠标右键上下文菜单

中选择  趋向图。 

3. 设置开始时间= *-8h，结束时间= *，并单击  刷新按钮。 
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6.4 案例研究：PI Big Tires Co. 

在学习如何使用表达式分析前，我们先来熟悉一下将在 TCE 环境中模拟的轮胎生产过

程。  

6.4.1 讲师指导活动 – 了解 PI Big Tires Co. 的生产过程 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

 

活动目标 

• 了解轮胎生产过程模拟。 

 

以下是轮胎硫化机的工作原理： 

将原始轮胎逐个加载到轮胎硫化机。加载轮胎后，轮胎硫化机关闭，开始施加温度和

压力以轮胎进行热蒸和塑性。在热蒸时间过去后，轮胎硫化机打开，将轮胎卸载到冷

却单元，在该单元使用风扇对轮胎吹风直到轮胎达到特定温度。 

Internal and Mold Temperatures 和 Pressure 是分类“ Process Variables”下的属

性，它们的值在 TCE 环境下进行了模拟。 
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系统还会跟踪轮胎硫化机的非运行时间段。PI 标记点属性 Press Status 中还捕捉了

停机的原因（例如轮胎硫化机安装、维护或轮胎硫化机中无操作人员）。在轮胎硫化

机正常运行时，轮胎硫化机状态为“Running”。在 TCE 环境中，随机模拟停机时间

段。  

Lid Position 指示轮胎硫化机处于打开还是关闭位置。 

“Production”类别中的属性提供目前几天的生产信息：Tires Produced 是今天生产

的轮胎数（即自午夜起），Scrap Tires 是今天生产的不能出售的轮胎数，Reference 

Type 定义当前正在生产的轮胎种类。 

 

轮胎硫化机是生产过程中一个必不可少的部分，目前缺少关键绩效指标；我们将使用 

表达式分析从轮胎硫化机的过程数据中提取此信息。 
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熟悉轮胎硫化机的属性： 

1. 在 PSE 中打开 PI Big Tires Co. AF 数据库，在导航器中选择 Elements。 

2. 浏览元素层次结构：它包含 3 个位置（Houston、Montreal 和 Philadelphia 

(“Philly”)），每个位置中有四个轮胎硫化机。选择一个轮胎硫化机。选择 

Attributes 选项卡。按类别启用分组。 

 

 

 

3. 使用趋向图显示过去 48 小时生产的轮胎。标识在午夜重置为零的重置。 

4. 标识属性模板并将其打开（在导航器中选择 Library）。 

5. 浏览用于 Press Status 和 Lid Position 的枚举集。 
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6.5 *PI Analysis Service，表达式分析 

资产分析是随 AF 2014 (2.6) 一起发布的 PI Analysis Service 的新功能。资产分析可

让您基于 AF 资产创建和管理分析。分析是一个预定的计算，能够从 AF 层次结构的

任何层面的属性获得输入值，并将其结果输出到其他 AF 属性。  

资产分析采用三种类型的分析： 

• 表达式：用来创建功能强大的分析的多个函数。表达式使用性能方程式语法。 

• 汇总：一组选定属性的聚合计算。 

• 事件框架生成：指定触发开始和结束事件的条件。  

• SQC：使用统计质量控制 (SQC) 方法来监控属性值是否在预定范围内。 

 

资产分析提供了下列功能： 

• 历史化：当将输出属性映射到 PI 标记点后，会将计算结果存档在 Data 

Archive 中。 

• 回填/重新计算： 

回填：可以在更早的时期执行分析以便将 PI 标记点的数据映射到其输出。例

如：4 月 1 日创建了一个用于计算每日总消耗量的新分析。通过回填，将计算

过去一段时间内（例如 1 月到 3 月）的总消耗量并存储在输出 tag 的存档中。 

重新计算：如果计算的输入值发生变化，则可使用重新计算功能相应地更新计

算结果。 

• 安全性：可以配置和管理权限以限制访问分析和分析模板。 

• 预览和测试：在将分析投入到生产之前可以预览计算结果。  

• 计算依赖关系：可以将计算的结果用作其他计算的输入。 

• 调度选项：可以根据调度配置计算或根据事件执行计算。  

可以将每个分析与元素进行相关联，并且通过选择 Analyses 选项卡在该元素中直接

创建每个分析；但是，建议将分析与元素模板进行相关联。为此，选择相应的元素模

板，然后使用 Analysis Templates 选项卡（请参阅下图）。 



将分析添加到资产 

 

第 131 页 

 

 

 

可以在 Analyses 选项卡下的元素层面直接管理分析（如开始、停止和回填），或通过

使用导航器面板中的管理插件进行管理。请参阅下面显示了管理插件不同组件的简短

描述的屏幕截图。 
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6.5.1 表达式分析 

表达式分析可让您使用性能方程式 (PE) 语法和各种函数创建并调度计算。在详细讨论

表达式分析之前，请务必回顾一下表达式分析的语法（也称为性能方程式 (PE) 语

法）。 

6.5.2 表达式分析语法（PE 语法） 

表达式分析语法是用来在 PI System 套件的多个客户端和服务器产品上执行计算和过

滤数据的代数语法。除 PI Analysis Service 外，以下产品也使用此语法： 

• Data Archive，通过 PE 标记点来使用。 

• PI ProcessBook，通过使用 PI 计算数据集使用。 

• PI Datalink，通过使用过滤表达式或 PI 表达式来使用。 

• Notifications，通过使用 PI PE 触发条件来使用。 

 

当涉及到书写表达式时，此语法拥有三 (3) 个规则： 

1. AF 属性或 Data Archive Tag 名称和时间戳用单引号 (‘) 括起来： 

例如：‘Pressure’、‘CDT158’、‘*-1h’、‘03-Feb-2013 13:38’ 

2. 文本（字符串）或数字状态位于双引号 (“) 中： 

例如：“This is a comment.”、“OFF”、“Active”等。 

3. 数学运算符和 PE 函数书写如下。 

例如：+、-、*、^、TagTot() 和 FindGT() 等。 

可以在 PSE 帮助菜单下找到表达式函数引用指南。 
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6.5.3 指导活动 — 检出表达式函数引用 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概

念。您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会

提供指导。  

活动目标 

• 了解哪里可以找到分析表达式函数的相关信息。 

• 了解表达式分析语法的函数。  

方法 

可在下列位置找到分析表达式函数的相关信息：  

1. Analyses 选项卡（Elements 和 Element Templates）：选择 Demo AF 数据库并找到 

Analysis Demo 元素。选择 Analyses 选项卡。表达式函数列在右侧。根据功能使用下拉菜单

进行分离。 

 

 

2. PI System Explorer Help: Asset Analytics > Expression functions reference 

与讲师一起剖析表达式分析语法及其可用函数的亮点。 

• 您使用哪些函数来计算过去 8 小时的属性的时间加权平均值？ 

______________________。 

• 您要找到大于 100 的属性的总时间。您会使用什么函数？

___________________________。 

注意：可以将引用指南功能示例中所介绍的每个函数直接复制到记事本或其他 PI System 产品。 
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6.5.4 单独或分组活动 – 应用表达式分析语法 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领

域的学习效果。您的讲师会向您介绍相关说明，并在活动期间提

供必要的指导。 

练习目标 

• 了解如何对不同的计算和过滤问题应用表达式分析语法。 

问题描述和方法 

您可能要在记事本或其他文本编辑器（而不是下面的空间）中构建方程式，因此您可

以从帮助文件中剪切并粘贴。 

问题 您的解决办法… 提示 

获得 SensorX 属性的十分

钟“滚动”平均值 
 TagAvg() 

获得过去 24 小时的 

SensorY 属性的时间加权

总计，但仅在将计算中所

使用的值至少 80% 视为

“良好”时计算。 

 
TagTot() 

 

过去四天中 Mode 属性为

“Manual”的时间长度。 
 

TimeEQ() 

返回的时间量以秒

为单位。 

当 SensorX 属性大于或等

于 90 时显示“Overload”，

当介于 10 和 90 之间时显

示“Normal”（不包括边界

值），当低于或等于 10 时

显示“Empty”。  

 If... then… else 

 

先尝试自行完成本练习，然后再参考本书结尾的练习答案。 
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熟悉函数输入（可选） 

1. 打开 Demo 数据库并选择 Analysis Demo 元素。 

2. 选择 Analyses 选项卡 

3. 单击  新建分析图标。 

4. 在 Expression 选项卡中输入表达式。 

 

 
 

5. 不再需要分析，因此您可以单击 Check-out 撤销输入内容。 
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6.5.5 指导活动 — 设备整体效率 (OEE) 指标 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的

不同概念。您可以观看讲师执行的操作，也可以同时执行相同的步

骤。您的讲师会提供指导。 

活动目标 

• 创建和配置表达式分析。 

• 创建分析模板。 

• 回填分析。 

• 通过分析插件管理分析。 

问题描述 

管理层想要通过使用设备整体效率 (OEE) 跟踪轮胎硫化机的生产率。总之，在 1990 

年代中期开发的 OEE 可用于监控工厂的生产率和提高制造商流程的效率。OEE 包含

三个不同的指标：可用性、性能和质量。 

 

指标 描述 公式 

可用性 设备启动和运行的时间的百分比 操作时间/计划生产时间 

性能 实际产出与目标产出之比 总产出/目标产出 

质量 生产的良好单元的百分比  良好产出/总产出 

OEE 可用性*性能*质量 

 

方法 

指标表示一个范围为 0 … 1 的比率。我们还可以将其表示为范围为 0 … 100 的百分

比。我们将使用比率和百分比单位，以相应地换算数字。示例： 

当轮胎硫化机只有一半的时间可以使用时，可用性分数的比率为 0.5，对应于 50%。 

每台轮胎硫化机都拥有状态属性。每当轮胎硫化机处于运行状态时都可将其视为正在

运行；任何其他状态表明轮胎硫化机已出现故障。 

OEE 指标计算的时间基准应为当天，这表示从午夜开始到当前时间。 
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添加比率的度量单位 

已有存在比率的 UOM 类，其中包含百分比。我们来添加比率的其他度量单位。 

在 PI System Explorer 导航器中选择 Unit of Measure 后，导航到 UOM 类 Ratio。添

加名为 ratio 的新度量单位： 

 

 

注意：比率为 1 表示 100%。 
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添加分析模板 

如前所述，建议在模板层次直接配置分析。首先打开轮胎硫化机的元素模板，然后单

击 Analysis Templates 选项卡。在此窗口中（请参阅下图），您将能够设置在将相应

元素的新实例添加到 AF 结构时自动创建的分析。  

首先，输入分析的名称和有意义的描述（如 OEE 指标），然后使用单选按钮选择表

达式分析类型。  

 

注意：我们已选择在通过模板创建完分析后立即启用该分析。如果您不确信您的分析是否执行正

确的计算，请取消选中该选项。对于相关元素，可以稍后启动此分析。 
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输入表达式  

下一步是输入表达式，即将要执行的方程式。一个表达式可以占用一行或多行。资产

分析可让您将行的结果分配给变量；稍后，在其他行中可以使用此值。 

提示：利用变量可简化复杂的表达式；测试和调试将更轻松，因为您一次将只能对一个较小的表

达式求值。 

我们将使用第一行来计算 OEE 的可用性。首先提供变量的名称，如可用性。右侧窗

格列出了您可以用来构建方程式的所有可用函数的描述。  

我们如何获知轮胎硫化机今天运行的时间？ 

 ___________________________________________________。  

 

以何种方式返回时间值？ 

___________________________________________________。  

 

我们假设轮胎硫化机一直都在运行。我们如何获取自午夜以来直到现在的运行秒数？ 

___________________________________________________。  

 

这两个时间之间的比率应在 0 到 1 的范围内。 

要分配适当的工程单位，请使用函数 Convert。  

注意： Convert 函数将值的当前度量单位 (UOM) 转换为指定的 UOM。对于没有 UOM 的值，请

分配指定的 UOM。 

 

例如： 

Convert ('Outside Air Temperature', "degC") 
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完整的表达式为： 

Convert(TimeEq('Press Status','t','*',"Running")/DaySec('*'),"ratio") 

 

下面是与输入表达式有关的一些提示： 

• 提示 1：自动完成（又称智能感知）可以帮助您使用语法。 

 

• 提示 2：如果输入某些语法不正确的内容，则将出现一个弯曲的下划线： 

 

• 提示 3：如果单击右侧的 Functions，窗格将列出所有可用的函数。顶部的下

拉列表可用于过滤函数组（如 Date and Time）。选择一个函数，并单击绿色

的加号将其添加到表达式（不必键入该函数） 

 

 
 
 

• 提示 4：您可以添加备注说明您要做什么。备注以两个正斜杠 (//) 开头。换行

使用 Shift-Enter。  
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• 提示 5：如果单击右侧的 Attributes，窗格将列出所有可用的属性。上半部分可

用于在资产树中导航。选择一个属性并单击其中一个绿色的加号将其添加到表

达式（不必键入该函数） 

 

 
 

 插入 Relative： 

 

插入该属性时，不包含元素树中的路径： 

因此是指实际元素上下文中的属性。 

 

 插入 Absolute： 

 

该属性与绝对元素路径一起插入。指的是指定元素路径中的属性。  

 

通过在上方所示的资产树中进行导航，可从其他元素中选取属性。使用绝对路

径的一个例子是当属性具有一般含义时，例如某个地点的室外空气温度： 

'\Houston|OutsideAirTemperature’ 
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将输出映射到属性 

可以将表达式的输出映射到现有或新的属性。要将输出映射到现有属性，请单击 Map 

并选择相应的属性。我们可以将可用性计算的结果映射到新的属性，因此选择 New 

Attribute Template，这将打开 Attribute Template Properties 窗口。将名称设置为 

OEE Availability。 

 

 

切换到 Attributes Templates 选项卡并选择 OEE Availability 属性。将默认 UOM 设置

为 percent。分配新的属性类别“OEE 指标”。现在，在 Settings 下，可以选择 PI 标记

点作为输出。如果相应的 PI 标记点不存在，可以启用自动创建标记点功能；只需选中 

Settings下的 Tag Creation复选框即可。 

提示：如果输出属性的数据引用为标记点，则计算结果将存储在 Data Archive 中；因此，您将能

够在 PI Vision 或 PI ProcessBook 中查看其趋向图。此外，标记点也为 AF 提供了改进的性能。 
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注意：启用自动创建 Tag 功能后，您可以使用替代参数来命名标记

点。%Element%.%Attribute%.%ID% 是资产分析输出标记点的默认值。稍后，将会在课堂上介

绍替代参数。  

调度表达式 

现在，计算已经编写完成，因此可以随时调度执行计算。可以使用两个调度选项：周

期性或事件触发。  

• 事件触发调度是由事件所驱动：每当一个或多个输入属性收到一个新值时将执

行计算。您可以选择触发计算的输入属性。  

• 周期性调度基于时钟，您可以在配置窗口中指定周期和偏移量。我们可以调度

每分钟 (00h 01m 00s) 执行 OEE 计算。 
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测试表达式 

现在，计算已经编写完成和定义了调度，因此可以随时进行测试。Evaluate 按钮会根

据评估时（即现在）的值以及根据上次触发时的值执行表达式（在我们的示例中，在

当前分钟开始时）。这将帮助您确定结果是否有意义。由于我们通过模板工作，因此

您必须单击 Example element 后才能测试表达式。 

 

 

另一种比较好的方式是根据存档的值验证是否要运行您的表达；我们将此功能称为“预

览结果”。右键单击分析名称，并选择 Preview Results（请参阅下面的屏幕截图）。 

提示：您可以将结果表导出到电子表格或将结果表中的选定行复制到其他应用程序。 
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检入表达式 

在分析名称的左侧，显示以下图标 。这表明已修改分析，且需要检入以便使更改

生效。继续并单击 。 

检入时，Analysis Service 将为输出属性创建标记点并启动所有轮胎硫化机的分析。 

如果转至 Elements 插件并导航到其中一台轮胎硫化机，您将在 Attributes 选项卡下看

到，分析的输出属性 (OEE Availability) 是指根据模板中的设置创建的 Tag。如果属性

值为“Pt Created”，单击 Refresh按钮（满一分钟后），以便可以获得计算值。如果属

性显示“PI Point not found”，则选择 Create or Update PI Point。 

提示：通过右键单击父元素（即 Montreal）并选择 Create or Update Data Reference，可为所

有轮胎硫化机创建 PI 标记点；因此，您不需要逐个创建。 

 

管理分析（开始、停止、回填） 

Analyses 选项卡可让您管理分析。您甚至可以为特定元素创建新分析，但正如我们之

前所说的一样，我们建议使用分析模板。  

分析应自动启动，除非配置出错。您可以使用启动 ( ) 和停止 ( ) 按钮启动或停止分

析。下面是管理分析面板的屏幕截图。 
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分析可以为多种状态中的其中一种状态。分析名称左侧的图标表示其状态。请参阅下

表了解每个图标的含义。 

 

图标 含义 

 新分析 

 正在启动或停止 

 在  PI Data 

Archive 上运行 

 已禁用 

 错误 

 未知状态 

 

由于分析已开始，因此“OEE 可用性”属性现在应显示结果。您可能要等待几分钟或刷

新屏幕才能看到更新。 
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6.5.6 讲师指导活动 — OEE 指标 — 性能和质量 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

练习目标 

• 创建和调度表达式分析。 

问题描述 

创建分析来计算剩余两个 OEE 指标：性能和质量。在创建后，您将能够计算 OEE 评

分。 

方法 

使用刚创建的分析模板（OEE 指标），添加两个表达式来计算质量和性能指标。  

 

质量 

计算质量作为良好项目的净生产量或总生产量计数。该天生产的轮胎总数（包括报废

轮胎）在 Tires Produced下进行跟踪，每日不良质量项目在 Scrap Tires 属性下进行

跟踪。 

表达式： 

___________________________________________________________________ 。 

 

性能  

计算性能作为净生产量计数/预期生产量计数。通过 AF 属性 Tires Produced来跟踪每

日生产量计数；在 AF 属性 Production Target 下以 tires/hour来表示生产量目标。 

提示：由于生产量目标表达为轮胎/小时，因此您需要通过将生产量目标乘以在当天期

间过去的小时数得出预期生产量计数。 

有用的函数：小时 (‘*’) 和分钟 (‘*’) 

表达式： 

___________________________________________________________________ 。 
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OEE 评分 

作为可用性*性能*质量的结果计算。表达式： 

___________________________________________________________________ 。 

提示：可以将表达式的每个变量映射到输出属性。 

 

6.5.7 回填/重新计算 

从创建之时开始，分析就向其输出属性写入新数据。但也可以计算过去一段时间的数

据。有两个相关的选项可以控制现有数据的处理方式。 

例如：您在 2017 年 3 月 1 日创建了一个新分析，以计算从各种来源添加的热能消耗

量。包含总消耗量的指定输出属性将具有从该日期起的时间值。要获取 2017 年 1 月

和 2 月的值，可以使用回填功能。 

 

两个选项包括： 

1. Leave existing data and fill gaps：保留现有数据并且只回填缺失的数据。 

2. Permanently delete existing data and recalculate：回填新数据前先删除现

有数据。 

注意：  

• 用于处理现有数据的选项是 AF 2016 R2 的新功能。在之前的 AF 版本中，数

据永远不会被删除。必须在回填之前手动执行删除操作。 

• 回填/重新计算要求输出属性已映射到 PI 标记点。 

• 将回填数据添加到存档文件中。使用 2012 年以前的 PI Data Archive 版本时，

可能需要进行前期干预才能使回填工作正常进行（例如，PI 存档重新处理） 
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• 对于事件框架生成分析，系统会自动删除并重新计算数据（唯一允许的模

式）。请注意，这些事件框架上的注释将会丢失。 

6.5.8 指导活动 — 回填 OEE 指标 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的

不同概念。您可以观看讲师执行的操作，也可以同时执行相同的步

骤。您的讲师会提供指导。 

活动目标 

• 了解如何回填计算。 

• 熟悉分析插件并执行一些管理任务。 

问题描述 

管理层非常高兴看到 OEE 评分的实时更新，因此他们想要更多的详细信息。他们要

求您提供属于休斯顿工厂的所有轮胎硫化机上周的 OEE 评分的趋势图，在该工厂他

们最近已获得创新性技术。 

方法 

首先，确保 OEE 指标分析正在运行且没有出现任何错误。为此，您可以利用导航器

窗格下的 Management 插件。 

 

 

 

 

 

 

要回填分析，其中一个选项是浏览到相应的元素，然后右键单击所需的分析并选择 

Backfill/Recalculate。 
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但是，由于我们要回填属于多个元素的分析，只能逐个元素地回填，因此需要单击很

多次才能完成此任务。Analyses 插件提供了批量执行回填的可能性。您只需选择分

析，然后单击 Operations 窗格下的 Queue backfilling for selected analyses。接下

来，输入开始时间和结束时间，然后单击 Queue。 

 

 

6.5.9 提升分析的稳健性和可读性 

我们已了解如何写入分析以计算 OEE KPI。还有一些选项可使计算更加稳健并可提升

可读性。以下屏幕截图提供了关于如何避免除数为零以及如何将计算分配到更多步骤

来实现的例子。  

 



Building PI System Assets and Analytics with PI AF 

 

第 154 页 

 

 

以下两篇文章提供更多相关信息： 

 

基于资产的分析提示和技巧 

https://pisquare.osisoft.com/community/all-things-pi/af-library/blog/2016/08/30/tips-and-
tricks-for-asset-based-analytics 

 

KB01520 - 资产分析提示和技巧 

https://customers.osisoft.com/s/knowledgearticle?knowledgeArticleUrl=KB01520 
 
 

6.6 汇总分析 

汇总分析可让您根据与元素相关联的属性执行聚合或汇总计算。汇总分析的强大功能

在于能够针对元素的子元素执行聚合计算。  

例如，您可能需要计算造纸厂内一组电机的总能耗。为此，创建了一个父元素（造纸

厂）汇总分析，对其子元素（电机）的能耗属性取合计值。 

如果在设计和构建 AF 层次结构时使用类别，将在开始使用汇总分析类型时获益。这

是因为在配置汇总分析时，要在按名称或类别选择的计算中包含属性。 
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6.6.1 讲师指导活动 – 使用汇总比较各个工厂 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概

念。您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会

提供指导。 

活动目标 

• 配置和测试汇总计算。 

 

问题描述 

虚拟轮胎公司的管理层想要开始比较企业所有工厂之间轮胎硫化机的性能；您要设立

的第一个指标是质量好的轮胎的生产总量。 
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方法 

每个轮胎硫化机都拥有当天总生产量的属性和当天报废轮胎数的属性；但是，没有任

何属性保存所生产的质量良好的轮胎的数量，因此您将必须创建一个属性。  

我们开始创建 Good tires production counter 属性。由于您不想存档此中间计算的结

果，因此可以使用 AF 公式数据引用。 

在轮胎硫化机模板下，添加新属性并计算 Tired produced（表示总生产量）和 Scrap 

tires 之间的差异。此新属性应属于生产类别。 
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创建汇总分析 

现在，可以将重点转移到工厂的父元素。选择休斯顿工厂并转到 Analyses 选项卡，为

您的分析指定一个有意义的名称，然后选择 Rollup 分析类型。 

 

所有可用属性的列表将显示在右侧窗格上。现在，必须从该列表中选择汇总计算涉及

的属性。您可以通过筛选元素类别或模板缩小搜索范围。然后，您可以键入属性名称

或类别。匹配的结果将显示一个复选标记 ( )。 

注意：汇总可确定每次执行的输入属性，因此它自动包含满足选择条件的所有新属性。您不需要

在创建新元素时更新汇总配置。 
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选择汇总函数  

现在，您已选择汇总的属性，然后可以指定汇总分析将要运行的汇总计算的函数或类

型。可以选择以下六个可用的汇总函数： 

• Sum 

• 平均值 

• Minimum 

• Maximum 

• 计数 

• 中值 

由于我们要计算某个特定工厂所生产的轮胎总数量，因此应选择汇总函数 Sum。 

提示：您可以在汇总计算中选择多个函数，然后将每个函数映射到特定输出属性。 

将输出映射到属性 

选择函数后，可以将输出映射到属性。如果输出属性尚不存在，系统会提示您创建一

个新的输出属性。我们创建一个新的输出属性，并将其命名为 Total Good Production。 
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调度汇总计算 

最后，将需要调度计算。表达式分析类型同样具有的这两个调度选项，也适用于汇总

计算：事件触发和周期性。对于本练习，有必要在每次生产出质量良好的新轮胎时更

新结果，因此应选择事件触发调度。 

提示：在开始分析前，好的做法是单击“评估”按钮以预览结果。因此，您可以右键单击分析名

称，并选择 Preview Results；这将显示包含之前一段时间运行计算的结果的趋势图。这两个操作

将有助于您验证汇总计算。 

现在可以随时开始进行计算了！检入更改。 

注意：如果未创建 Total Good Production 属性的 PI 标记点，请使用鼠标右键上下文菜单的属性

中的 Create or Update PI Point 功能。  

检查计算的状态是否出现任何错误并验证是否正在更新输出属性。 
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6.6.2 小组问题 – 一个工厂，多个工厂 

 

以下问题旨在巩固已介绍的主要信息或发掘新的认识。您的讲师可能会让您

尝试独立回答问题，或让小组共同回答问题。 

目标 

• 将分析转换为分析模板。 

问题 

汇总计算只部署到了休斯顿工厂。您可以使用 AF 的哪些功能将其部署到其他工厂？

____________________ 

需要采取哪些步骤来实现此目的？ 

 

1. ____________________________________________________________ 。 

注 1：在 Convert Attribute to Template 对话框中，选中 Include Tag Creation 复选

框。由于尚未创建用于存储分析结果的 Tag，因此需要执行此操作。 

注 2：将 Total Good Production 属性的 PI 标记点命名模式设置为遵循默认模式，

即 %Element%.%Attribute%.%ID% 

 

2. ____________________________________________________________ 。 

 

附加题 

如何在一个列表中显示三 (3) 个有效生产总数计数器？ 

____________________________________________________________。 
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6.6.3 单独或分组活动 – 执行高级属性搜索（可选） 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领

域的学习效果。您的讲师会向您介绍相关说明，并在活动期间提

供必要的指导。 

练习目标 

• 您最近在资产层次结构的多个位置创建了包含字符串“Good”的属性。使用属性

搜索功能在一个列表中获得它们的所有值。 

方法 

1. 在 PSE 菜单中，选择 Search – Attribute Search… 

2. 在属性名称字段中输入 *Good* 。确保选中 Search Sub-Elements 选项。单击 

Search。结果：返回包含字符串“Good”的属性。单击 OK。 
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3. 单击搜索名称以在右侧填充搜索结果。 

6.7 在 PI Vision 中可视化计算结果 

6.7.1 讲师指导活动 – 可视化 OEE 指标计算结果 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 对轮胎硫化机重复现有的 PI Vision 显示  

• 可视化 OEE 指标计算结果。 

方法 

用另一个名称保存 PI Big Tire 轮胎硫化机的现有 PI Vision 显示。 

将有效的轮胎生产量计数器添加到现有趋向图。 

添加 OEE 指标趋向图 

 

重复 PI Vision 显示 

1. 在 PI Vision 概览页中打开 Big Tires Press 显示。  

2. 单击右上角的下拉链接，打开 Save As 菜单。 

 

3. 输入 Big Tires Press Training 作为显示名称并单击 Save 。 

注意：如果您已在 AF 中添加了数据库并且想要使用 PI Vision 访问，必须在 PI Vision 中更新允

许的 AF 数据库列表。有关更多信息，请参阅上面的“在 PI Vision 中可视化 AF 数据”。 
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将数据添加到趋向图 

1. 切换到 Modify Display 操作： 
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2. 在 Assets 窗格中，导航到 HOU.Press.01 

 

 

3. 在 Attributes窗格中，将 Good Tires 属性拖到具有 Tires Produced 计数器的

趋向图中。 

4. 配置趋向图，使其仅具有单个坐标。 

 

 

添加 OEE 指标趋向图 

1. 验证是否已在符号库中选择了趋向图。 
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2. 在属性列表中，选择 OEE Metric（OEE 指标）类别并将其拖动到显示画布。 
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7. 跟踪重要事件 

事件是重要流程或业务时间周期，用于表示可能会对您的操作产生影响的某些事情。

在 PI System 中，将事件称为事件框架。幸好有事件框架，您可以在这些事件的上下

文中分析 PI 数据，而不是通过连续的时间周期进行分析。事件框架使用户能够在 PI 

System 中轻松搜索他们试图分析或报告的事件，而不是按时间搜索。 

使用事件框架，PI System 可帮助您捕捉、存储、查找、比较和分析重要事件及其相

关数据。  

事件框架表示流程中您想要了解的事件，例如： 

• 停机跟踪 • 环境监控偏移  

• 流程偏移 • 产品跟踪批次 

• 设备启动和关闭 • 操作员换班 

 

下表列出了事件框架的一部分功能和优势： 

灵活性 

✓ 在同一事件内引用多个元素。  

✓ 支持 AF 元素上的多个重叠事件。  

✓ 捕捉任何事件；“批次”只是可捕捉事件中

的一种。 

强大的搜索功能  

✓ 按时间范围、事件类型或事件框架属性搜

索。 

✓ 可以配置最常用的搜索属性作为索引属性

以提高最终用户搜索的速度。 

可扩展性 ✓ 事件框架能够高度扩展。 

 

事件框架由三个特征定义： 

1. 名称。 

2. 开始时间和结束时间：定义事件的时间范围。 
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3. 上下文：事件属性和相关资产。 

7.1 跟踪生产停机时间段  

7.1.1 指导活动 — 停机跟踪 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的

不同概念。您可以观看讲师执行的操作，也可以同时执行相同的步

骤。您的讲师会提供指导。 

活动目标 

• 创建事件框架模板。 

• 配置事件框架触发条件。 

 

问题描述 

由于各种原因，轮胎硫化机经常停机，导致 PI Big Tires Co. 已落后于他们的生产量计

划。为了改善这种情况，他们想要在 AF 中使用事件框架来跟踪其在休斯敦、蒙特利

尔和费城的所有轮胎硫化机的停机时间段。  

 

维护工程师请您找出这些停机的根本原因。轮胎硫化机可以处于五种状态之一，每个

状态表示不同的严重性。  
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他们想要拥有由维护团队执行的调查记录。因此，应当可为每个停机事件框架确认并

保留单个注释。  
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方法 

1. 对于休斯顿的第一台轮胎硫化机，检查硫化机状态值的历史记录并手动创建一

个事件框架。设置名称、开始和结束时间以及元素引用。定义事件框架属性以

在停机开始时跟踪硫化机状态值（即问题的原因代码）。  

2. 创建相应的事件框架模板（将上一步中创建的事件框架转换为模板）。 

3. 从该事件框架模板为新的事件框架定义命名模式。  

4. 为休斯顿的第一台轮胎硫化机添加分析，以监控硫化机状态。区分不同的硫化

机状态值并将其与相应的严重性相关联。 

5. 使用输出表达式来获取并存储事件框架时间，以便使用 Excel Power Pivot 进

一步分析事件框架数据。 

6. 预览分析以评估是否正确设置触发器。  

7. 开始分析。 

8. 回填自今天午夜以来的时间的分析数据。 

9. 将分析纳入轮胎硫化机模板，以将分析应用于所有轮胎硫化机。 

10. 回填自今天午夜以来的时间的所有硫化机的分析数据。 

 

讲师将在讲师指导活动中展示这些步骤并让您跟着操作。 
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7.1.2 讲师指导活动 - 手动生成事件框架 

首先，我们将手动创建单个事件框架，以举例说明在轮胎硫化机停机时间段内我们想

要捕获的内容。 

我们先根据硫化机状态值确定休斯顿第一台轮胎硫化机 HOU.Press.01 的停机时间

段。  

1. 从导航器面板中选择 Elements，然后为 HOU.Press.01 选择 Attributes 选项

卡。 

2. 选择轮胎硫化机状态所在的行。从鼠标右键上下文菜单中选择 Time Series 

Data…，并显示过去两小时的值。 

3. 确定出现停机的时间段。它以不同于 Running 的值开头，再次以 Running 的

值结束。在下面的案例中，由于已计划维护，下午 1:22:05 之后轮胎硫化机便

没有运行，并且因为其他维护工作，下午 1:35:05 之前没有再次运行。 

 

 
 

在下表中填写您的案例的相关信息，然后关闭窗口。 

 

 上方示例： 您的案例： 

开始时间 13:22:05  

结束时间 13:35:05  

时间（单位：秒） 780  
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停机 

原因 
已计划维护  

 

4. 从导航器面板中选择事件框架，然后单击  按钮。为 Event 

Frame Template 选择 <none>。 

5. 对于名称，输入 Downtime Sample Period for HOU.Press.01。以 

hh:mm:ss 格式输入开始和结束时间。由于您没有指定日期，因此 PSE 将日期

假设为今天。 

 

 
 

6. 在 Referenced Elements 选项卡中，选择蓝色的 Add Element Reference 链

接，然后在 Single 部分中单击  按钮。 

7. 在元素浏览器中，导航到 Houston -> HOU.Press.01，然后单击 OK。 
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停机原因代码的事件框架属性 

8. 我们来跟踪轮胎硫化机停机的原因。这是问题开始时轮胎硫化机状态属性的

值。 

在 Attributes 选项卡上，单击蓝色的 New Attribute 链接。对于属性名称，输入 

Reason Code。对于值类型，从枚举集中选择 Press Status。对于 Data 

Reference，选择 PI Point。单击 Settings。 

9. 下拉列表提供 HOU.Press.01 的属性，选择 .\Elements[.]|Press Status。对

于 By Time Range，选择 Start Time。单击 OK。 

 

 
 

您将获得事件框架时间段开始的轮胎硫化机状态值，因为该值之前已记录。 

注意：如果重置值类型，请将其切换回轮胎硫化机状态。 

事件框架属性 

 

事件框架属性的通用格式为 .\Elements[.]|Attribute。 

属性引用以 .\Elements[.]| 开头，表示事件框架元素集合的主元素。.\ 是当前引用，[.] 是集

合的默认对象。竖线字符 (|) 用于将元素与属性名称分隔开来。  
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基于我们手动创建的事件框架创建一个新的事件框架模板。 

既然我们已经定义了要记录的轮胎硫化机停机的信息，接下来我们根据这些信息创建

一个模板。 

1.  您的更改 

2. 选择您创建的事件框架，并从鼠标右键菜单中选择 Convert > Convert To 

Template。 

 

 

 

3. 对于原因代码，保留  

.\Elements[.]|Press Status;TimeRangeMethod=StartTime 

单击 OK。 

 

4.  您的更改 
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7.1.3 讲师指导活动 - 最终确定事件框架模板 

我们来看看创建的事件框架模板，进行调整并最终确定要使用的模板。 

1. 从导航器面板中选择 Library，展开结构 Templates > Event Frame 

Templates，然后选择 Downtime Sample Period for 

HOU.Press.01Template。重命名为 Press Downtime。 

2. 通过 Naming Pattern 字段，您可以动态构建从模板创建的事件框架的名称，

从而使得每个事件框架拥有唯一的可识别名称。使用右侧的箭头 ( ) 展开可

用替代参数列表。下表中列出了最常用的参数： 

 

%ELEMENT% 引用的元素。在其中发生事件的

资产。 

%..\ELEMENT% 所引用元素的父元素的名称。要

检索更多的上级元素，请使

用 ..\ 表示，例

如 %..\..\Element%。 

%TEMPLATE%  事件框架模板的名称。 

%STARTTIME:yyyy-
MM-dd 
HH:mm:ss.fff% 

事件的开始时间和格式。 

 

3. 我们应设置什么样的命名模式使得停机事件的名称类似如下？ 

 
DownTime HOU.Press.01 (Houston) 2015-12-24 23:22:21 
 
_________________________________________________________ 
 

注意：如果没有设置 Naming Pattern（命名模式）字段，应将通过使用资产分析所创建的事

件框架命名为“分析名称 - 开始时间”（即 Press Downtime – 20140725 11:20:00）。 

4. 要跟踪操作员是否读取了事件框架，请启用  选项 
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5. 打开 Attribute Templates 选项卡。此处列出了我们之前定义的原因代码属性。 

6. 添加 Event Duration 属性（默认 UOM：second，值类型：Int32）。将根据

下一步要创建的分析来设置属性值。 

7. 生产一个轮胎大约需要 5 分钟的时间。根据轮胎硫化机停机的持续时间，可以

计算出轮胎硫化机运行过程中生产的轮胎数量。 

添加 Production Loss 属性（默认 UOM：tires，值类型：Double），将数据

引用设置为 Formula。要计算生产损失量，请用持续时间（单位：秒）除以 

300： 

 

 

8. 检入更改。 
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7.1.4 讲师指导活动 - 创建 EF 生成分析 

我们可以创建 EF 生成分析来跟踪轮胎硫化机的停机事件。将直接在 Houston’s 

press1 下进行创建。在我们验证其工作状态是否良好后，我们可以将分析转化为应用

于公司的所有轮胎硫化机的模板。  

配置事件框架分析的方式与配置表达式和汇总分析的方式类似。浏览到 Houston’s 

press1，然后在 Analyses 选项卡下选择 Event Frame Generation。为分析指定一个

有意义的名称和描述。 

事件框架分析基于事件框架模板，继续并选择下拉列表中的模板。 

提示：在创建 EF 生成分析前，确保事件框架模板对其可用。 
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触发条件（仅限开始触发条件） 

现在可以输入将触发开始事件和结束事件的条件：StartTrigger 和 EndTrigger。使用

前面所介绍的 PE 语法以表达式格式输入这些条件。 

如果一个条件可以同时触发时间框架的开始和结束，则只需要 StartTrigger 表达式。

如果表达式计算结果为 TRUE，则事件框架开始；如果表达式计算结果为 FALSE，则

事件框架关闭。例如，当油罐的液位上升超过阈值时可能会开始溢出事件，当油罐的

液位低于阈值时将会停止溢出事件。 

 

 

触发条件（开始和结束触发条件） 

如果开始条件和结束条件不同，则可以指定 EndTrigger 表达式： 

 

 

在具有开始和结束触发条件时，事件的结束仅取决于结束触发条件。因此在事件开始

后，当结束触发条件变为 True 时事件将结束，无论开始触发条件为 True 还是 

False。 
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提示：如果使用开始和结束触发条件，请确保表达式的计算结果不要同时为 TRUE，因为这可能

会导致事件框架的持续时间为零秒。尝试配置事件框架只使用 StartTrigger 表达式。 

例如，如果反应器中的温度上升，泡沫液位也相应上升。当温度再次下降时，泡沫液

位也下降，但有一定的时间延迟。 

您希望捕捉从温度过高到泡沫液位回到正常的时间： 
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定义轮胎硫化机停机的触发条件 

自 AF 2016 起，我们可以定义多个开始触发条件并将其与不同的事件框架严重性相关

联。这符合我们根据轮胎硫化机停机的原因使用严重性不同的事件框架这一要求。我

们来看一看第一种情况，轮胎硫化机由于 Planned maintenance 或 Press set-up而停

止运行。 

这种情况下用于启动事件的表达式为：  

_________________________________________________________.  

分配 Information 严重性级别。 

 

要输入开始和结束触发条件，请单击蓝色的 Add… 链接并从下拉菜单中

选择相应的选项。 

 

 

输入开始和结束触发表达式并分配严重性级别，如下所示： 

 

提示：使用 StartTrigger True  选项要求开始触发条件在创建事件框架前的设定时间间隔内保持 

True。这对于包含连续非步进数据的属性非常有用，可以防止输入数据中的峰值生成不需要的事

件框架。  
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在相应的事件框架属性中存储持续时间 

 

从 AF 2017 R2 开始引入了 EventFrame 函数，它允许以简单的

方式获得诸如事件框架持续时间等事件框架属性。  

 

 

将事件框架持续时间存储在事件框架的 Event Duration 属性

中。 

1. 要输入输出表达式，请单击触发条件部分顶部的蓝色 Add… 链接，然后从下拉

列表中选择 Output Expression 选项。 

2. 对于表达式，请输入 EventFrame("Duration") 

3. 单击右侧的蓝色 Map 链接，并选择 Event Duration 属性。 

 

 
 

调度事件框架分析 

最后一件事是调度事件框架分析。至于表达式和汇总，可以使用两个调度选项：事件

触发和周期性。对于本练习，将它作为事件触发进行调度。 

7.1.5 讲师指导活动 - 预览分析结果并开始分析 

您现在可以使用 Preview Results 功能来验证是否按预期生成事件。在分析列表中选

择 Downtime 分析。在鼠标右键上下文菜单中，选择 Preview Results。 

 

如果结果正常，请单击  签入更改。结果：分析将开始运行： 
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7.1.6 讲师指导活动 - 回填事件框架分析 

创建的分析将从现在开始监控轮胎硫化机的状态。但是，使用分析的回填功能，还可

以回填过去的时间段！这就意味着需要检查已存档的轮胎硫化机状态值，并相应地创

建包含过去日期的事件框架。 

要回填自午夜起的时间，请执行以下操作： 

1. 在分析列表中选择 Downtime 分析。在鼠标右键上下文菜单中，选择 

Backfill/Recalculate。 

 

 

2. 对开始时间输入 t（=今天午夜），对结束时间输入 a *（=现在）。单击 Start 

按钮。Backfilling 列将显示回填活动的进度。 

 

 

 

3. 回填完成后，切换到 General 选项卡，然后单击蓝色的事件框架链接。您将获

得与该元素关联的所有事件框架的列表。 

4. （可选）验证：第一个事件框架的开始时间是什么？  
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5. （可选）滚动浏览列表，查找手动创建的事件框架。将存在另一个由分析创建

且具有相同开始和结束时间的事件框架。选择手动创建的事件框架，并从鼠标

右键上下文菜单中选择 Delete…。不再需要此事件框架。 
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7.1.7 讲师指导活动 - 将分析转化为模板 

在将分析添加到模板（如轮胎硫化机模板）前，最常见的情况是客户直接在元素（如 

Houston’s Press01）上创建并测试分析。可以将分析添加到模板，因此您不需要在模

板层面再次配置。只需右键单击分析并选择 Convert to Template，如下图所示。然后

检入。 

注意：转换为模板不创建元素模板；只将分析添加到已经存在的元素模板。 

 

 

 

注意：分析将添加到从元素模板创建的所有资产。检入后分析将会自动启动。 
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7.1.8 讲师指导活动 - 回填事件框架 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

练习目标 

• 定义并保存可返回所有轮胎硫化机的停机分析数据的搜索。 

• 批量回填分析。 

• 了解回填选项。 

问题描述 

现在，您可以实时跟踪公司所有轮胎硫化机的停机事件。管理层不希望等到发生新事

件后才开始分析生产量损失的原因；他们希望您创建所有轮胎硫化机自今天午夜以来

的事件框架。 

 

方法 

 

使用导航器面板中的 Management 

 插件回填多个事件框架。  

一开始，将列出该 AF 数据库中的所有分析数据。 

 

 

要使用一组特定的分析数据（所有轮胎硫化机的所有停机分析数据），您可以定义并

保存仅过滤这些分析数据的搜索： 

1. 单击绿色的  符号以添加新的搜索： 

 



跟踪重要事件 

 

第 185 页 

 

2. 对于搜索名称，请输入 Press Downtime Analyses，然后在 Add Criteria 下拉

列表中选择 Template。 

3. 从 Template 下拉列表中，选择 Press Template\Downtime，然后单击 OK。

结果：右侧的分析数据列表列出 12 个分析数据（每个地点 4 个分析数据）。 

要对所有轮胎硫化机进行回填，请执行以下操作： 

 

1. 单击列表顶部的复选框，以选择所有轮胎硫化机。 

 

 

2. 单击蓝色的 Backfill/Recalculate 12 selected analyses 链接。确认将删除该时

间范围内的现有事件框架，然后单击 Queue 按钮。 
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请注意，在所需的确认方面：对于事件框架生成分析（不同于非事件框架生成分析背景下的回填

情况），系统会自动删除并重新计算数据。这是唯一允许的模式。请注意，这些事件框架上的注

释将会丢失。 

 

自动重新计算：（AF 2017 R2 及更高版本）   

如果您预计您输入的数据会延迟到达或顺序会变乱，则可以请求对分析进行自动重新计算。

Management 列表可用于为一个命令内的多个分析设置此选项。要在单个分析的基础上设置该选

项，请使用元素或元素模板的 Analyses 选项卡上的 Advanced Options。  
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7.2 使用 Event Frames 

事件框架存储在 AF Server 中。可视化客户端（如 PI Vision 和 PI Datalink）将访问 

AF 服务器来检索事件及其相关数据，为您提供用于分析重要事件的强大工具。 

注意：PI ProcessBook、PI BatchView 和 PI Manual Logger 不支持事件框架可视化。 

7.2.1 PSE 中的事件框架 

在本部分中，我们将了解如何在 PI System Explorer (PSE) 中使用事件框架。作为管

理员，您可以使用 PSE 搜索事件并进行分析。结果以实用的表格格式展现，具有甘特

图和属性列功能。此外，这是一种验证创建事件框架的快速方法。  

要访问 PSE 中的事件框架，请单击导航器面板下的事件框架插件。 

注意：与元素不同，它不能浏览事件。实际上，您必须搜索事件。 

下面的屏幕截图显示了事件框架插件的主要功能： 
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事件框架搜索结果 

下图列出了事件框架及其信息，如事件框架名称、甘特图、事件持续时间、严重性以

及开始和结束时间： 

 

 

 

显示事件框架属性 

默认情况下，结果窗口中不显示事件属性。  

右键单击并选择 Column Visibility，您将能够选择要显示的属性。  

 

 

提示：要更改列可见性，您还可以单击搜索结果标题行的设置图标 。 
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列 

（含义） 

列 

（标题图标） 

EF 行 

信息 
含义 

为模板 

  

将鼠标悬停在此列上可获得事件框架模

板。 

<空> 事件框架不基于事件框架模板。 

已锁定 

 
 

捕捉值：事件框架属性的值保存在 AF 中

（见下面的注释）。 

<空> 事件框架属性的值不保存在 AF 中（见下

面的注释）。 

已注释 

 
 

事件框架带注释。将鼠标悬停在此图标上

可获得注释。 

使用 EF 鼠标右键菜单选项 Annotate… 

可输入新注释。 

 

<空> 事件框架不带注释。 

使用 EF 鼠标右键菜单选项 Annotate… 

可输入新注释。 

未被确认 
 

 
可以确认事件框架。 

使用 EF 鼠标右键菜单选项 

Acknowledge… 可确认 EF。 

 

已确认事件框架。 

将鼠标悬停在此图标上可获得确认信息

（由谁、何时）。 

<空> 无法确认事件框架。 

在相应的事件框架模板（General 选项

卡）中定义是否可以确认事件框架  
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注意：您捕获值以在 PI AF 数据库的表中保存事件框架属性的值。这样可以提升性

能，因为 PI AF 不执行任何数据引用。如果您使用捕获到的值在事件框架中添加新属

性，则应重新捕获这些值，以确保捕获新属性的值。 

7.2.2 讲师指导活动 - 事件框架搜索、确认和注释 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

练习目标 

• 熟悉如何在 PSE 中搜索事件框架。 

• 确认和注释事件框架。 

问题描述 

您想要获得由“No Operator”根本原因触发的昨天晚上 10 点之后任何停机的详细信

息，以便可以在事件中添加注释并确认这些事件。 

方法 

使用 Event Frame Search窗口执行以下操作： 

1. 从事件框架搜索根的鼠标右键菜单中选择 New Search。 

2. 输入以下条件：开始时间：y+22h，事件框架模板：Press Downtime，元素名

称：Hou*，原因代码 = No Operator（您需要使用 Add Criteria 输入该内容） 

提示：可以逐一输入条件并且每次都单击 Search。如果输入更多的条件，则会获得与您

的条件匹配的更少的事件框架。当返回的事件框架符合所需范围时，单击 OK。 

3. 重命名范围缩小的搜索：Downtime Events No Operator after 10PM yesterday 
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背景：执行后，您的搜索及其条件将保存。使用搜索上下文菜单中的 Rename 为该搜索分

配描述性名称。要进一步细化现有搜索，同时保存现有搜索，请从搜索的上下文菜单中选

择 New Search，然后修改新的搜索。 

4. 添加 Reason Code和 Event Duration属性列。在每种情况下都要确认 

Reason Code 为 No Operator。 

5. 选择第一个事件框架并添加注释：“Bob was busy with representative from 

press manufacturer。” 

6. 选择所有在午夜之前开始的事件框架并一次性进行确认。 

7.2.3 单独或分组练习 – 事件框架搜索 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习效

果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。 

练习目标 

• 执行中级到高级的事件框架搜索。 

问题描述 

在 PSE 中执行以下事件框架搜索： 

1. 查找过去 12 小时蒙特利尔 press2 的所有停机事件。 

2. 添加列以显示 Production Lost 和 Reason code。 

3. 缩小搜索范围以查找持续时间超过 10 分钟的事件。 

4. 缩小搜索范围以查找由轮胎硫化机装配引起的停机。 

方法 

使用 Event Frame Search 窗口执行搜索。确保添加必要的搜索条件。 
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7.2.4 Excel 中带 PI DataLink 的事件框架报告 

探索与比较事件函数 

您可以使用 PI Datalink（2014 或更高版本）将事件框架从 AF 导入 Excel，然后创建

报告以查看和分析这些事件。数据透视表和数据透视图是用于汇总数据和更好地洞察

事件框架的比较好的 Excel 功能 

在 Excel 中的 PI Datalink 功能区下，可以找到用来将事件框架数据导入 Excel 的两个

函数（按钮）：浏览事件函数和比较事件函数。 

浏览事件函数每行返回一个事件，用于分析与同一 EF 模板共享的事件。  

 

此处：上面已经以黄色突出显示名为 Batch 1222 的事件框架的最高温度 (89.56)。 

 

如果事件框架拥有子事件，则也可以在父事件下面的进一步行中列出子元素。在下面

的示例中，有九个子事件框架（Material Add 1、Agitate、…）：  
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此处：已经以绿色突出显示子事件框架 Material Add 1 和 Agitate 的最高温度（12.45 

和 13.08）。 

 

第二个函数比较事件可让您比较层次结构事件，换句话说比较有子事件的事件。比较

事件函数同时显示父事件和子事件的属性。在下面的示例中，返回完整生产批次以及

第一个子事件框架 Material Add 1 和 Agitate 的最高温度： 
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7.2.5 讲师指导活动 – 使用 PI Datalink 创建事件框架报告 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 了解如何将事件框架数据导入 Excel。 

 

问题 

管理层希望回答有关停机事件的以下问题： 

• 造成停机的最常见原因是什么？ 

• 我们因停机事件而损失多少生产量？ 

找到这些问题的答案的最好方法是通过创建 Excel 报告将事件框架导入 Excel 电子表

格。Excel 提供了一些有用的商业智能工具，将有助于我们聚合数据以便管理层可以

做出决策。 

 

方法 

我们将使用 PI Datalink 导入事件框架信息，然后使用 Excel PowerPivot 和 

PowerChart 分析停机事件。 

 

构建停机分析报告 

对于本练习，您将使用位于 class\exercises 文件夹中的模板：Press DownTime 

Analysis.xlsx。该模板包含两个工作表；我们将事件框架数据导入 Raw Data 工作

表，这样可以通过数据透视表和数据透视图从 Report 工作表中读取。 

由于我们要分析全部基于同一 EF 模板的停机事件，因此可以在 PI 

Datalink 中利用 Explore 函数。转到 Raw Data 工作表，将光标设定在

单元格 A2 并单击 PI DataLink 功能区中的 Explore 函数。 
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配置浏览事件函数 

 

将会显示 Explore Events 窗格。此窗格

提供了用于优化事件框架搜索的多个字

段。此外，它还包含结果预览部分。  

对于 Search start和 Search end 字

段，在 Report 工作表上指出相应的单

元格（见下图）。  

在事件名称和元素名称中保留 *。  

 

注意：预计您不会获得尚未完成的事件

框架。要排除未完成的事件框架，请单

击 More Search Options并在搜索模式

下选择 entirely in range。  

 

选择要显示的七列；您也可以设置列顺序。实际上，列是事件框架属性。要执行分

析，需要以下列：  

 

确保您选中了 Event Duration 属性（向您提供秒数），而没有选中 Duration（将向您

提供格式为 hh:mm:ss 的时间，例如 0:06:30）。 

单击“确定”以在原始数据工作表中显示所有事件框架信息。  
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只通过查看此电子表格很难找出造成停机或生产量损失的最常见原因。通过使用 

Excel 工具数据透视表，我们将能够自动提取、整理和汇总事件框架数据。数据透视

表及其图形助理工具、数据透视图都非常灵活且易于创建。不需要公式！ 
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7.2.6 讲师指导活动 – 使用透视图汇总事件框架（可选） 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 使用 Excel 透视图功能汇总事件框架信息。 

 

创建数据透视表和数据透视图 

转到 Report 工作表，选择 Insert 功能区，然后选择 PivotCharts 选项来创建数据透视

表和数据透视图。 

 

 

 

在 ExploreEvents 函数已返回数据的 Raw Data 工

作表中选择单元格范围（包括标题行），作为数据

透视表的输入。 

然后，选择将数据透视表和数据透视图放置在 

Report 工作表中的位置。 

提示：如果想要稍后及时更正源数据，请选择数据

透视表的所有单元格（或选择 Analyse 功能区），

然后从 Analyse 功能区中选择 Change Data 

Source。  
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数据透视图字段现在应显示在 Excel 工作表中，并且应在所在的数据透视表中指定工

作表的范围，如下所示。 

 

 

 

选择数据透视表，然后查看 PivotTable Field 列表。这些字段根据原始数据工作表的

列名称所生成。  

要根据相应原因代码为事件框架执行停机分析，选择 Reason Code行并拖动到 

Values 区域。为原因代码应用的聚合为 COUNT，因为它们是非数字值。再次选择 

Reason Code行并拖动到 Rows 区域： 
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选择 Production Loss行并拖动到 Values 区域。为这些数值应用的聚合为 SUM。您

的数据透视表扩展出另一行，其中根据原因代码汇总了相应的生产量损失： 

 

提示 1：如果数据透视表字段窗格关闭并且您想要再次使用该窗格，请选择数据透视表的一个单

元格。在鼠标右键菜单中，选择 Show Field List。 

提示 2：要更改应用于您的数据的聚合，请选择字段上的下拉图标，并选择 Value Field 

Settings… 以选择其他聚合类型。 

 

让我们根据各个轮胎硫化机选项增强用于分析的数据透视表。  

数据的哪一列表示轮胎硫化机？ 

 

 

选择数据透视表中的一个单元格，并从数据透视表工具中选择 Analyze 功能

区。单击插入切片器，选择主元素并单击 OK。  
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此时即会添加主元素的切片器。它可用于选择要分析的一个或多个轮胎硫化机的任意

组合。检查各种组合（使用 Shift 键和 Ctrl 键选择切片器）：  

• 所有轮胎硫化机 

• 仅 PHI. Press01 

• 所有“编号 01”的轮胎硫化机（即 HOU.Press.01、MTL.Press.01 和 PHI. 

Press01） 

• 位于休斯敦的所有轮胎硫化机 

 

 

数据透视表和数据透视图将更新以显示导致大多数停机事件的原因代码。在上面的屏

幕截图中，很明显在观察的时间段内，计划的维护已造成休斯顿轮胎硫化机的大多数

生产量损失。 
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7.3 跟踪生产偏移时间段 

7.3.1 单独或分组练习 – 跟踪失控的控制器 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

练习目标 

• 回顾创建事件框架分析的步骤，开始创建事件框架模板用于分析配置和测试。 

问题描述 

流程控制团队关心的是报废轮胎的数量，并且想要更深入地调查生产状况。他们要求

列出加载阶段且盖子已合上的期间内部温度超过 25℃ 的时段。  

流程控制团队要想开始解决问题，他们可能要通过监控其他周期的内部温度和压力行

为的方式跟踪这些不良事件，直到轮胎硫化机的盖子打开。此外，他们还想知道在发

生每个事件期间的最高温度和压力。  

根据观察，出现问题之前 3 分钟的压力和内部温度行为可以为他们提供有用的信息，

可以帮助他们找出与正常生产过程之间存在偏差的原因。  

PI Big Tires 公司将这些事件称为“失控事件”。事件名称应提及相关的轮胎硫化机、开

始时间以及目前生产的轮胎种类。示例： 

OOC HOU.Press.02 2018-02-21 10:25:00 (Winter-Tire Production) 
OOC MTL.Press.02 2018-02-21 08:41:30 (Motorcycle-Tire Production) 

方法 

以 2 到 3 名学生为一组，完成下表，讨论对监控轮胎生产周期所需步骤的共同理解并

检测失控情况。在失控情况下，内部轮胎硫化机温度在轮胎硫化机的加载阶段过高。 

关于获得目前生产的轮胎种类的提示： 

从 AF 2017 R2 开始，事件框架命名模式允许使用事件框架属性中的值。如果事件框架具有名为 

ProductType 的属性，则命名模式中的 %@ProductType% 将向您提供该事件框架属性的值。  
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在下表中的空白位置填写。  
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设计事件框架模板 

模板名称 1. 命名模式： 

属性 
1. 名称：____________________。 

2. 名称：____________________。 

属性配置 

最大压力的属性： 

UOM：______________________ 

DR 设置 _________________________ 

最大温度的属性 

UOM：______________________ 

DR 设置 ___________________________ 

引用类型的属性 

UOM：______________________ 

DR 设置 ___________________________ 

在元素上创建事件

框架分析 

StartTrigger  

EndTrigger  

调度  

子根本原因事件框架  生成子根本原因事件框架 

测试  评估   预览结果 

回填 回填过去 24 小时 

通过 PSE 验证事件

框架 

事件框架搜索 
定义搜索条件以获得过去两小时 HOU.Press.01 

的失控事件。 

事件框架属性 
在事件框架搜索结果中添加属性以获得最大内部

温度和最大压力 

将分析转换为模板 

元素模板  在模板中分析。 

分析插件 
 分析开始 

 分析状态 
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 回填所有轮胎硫化机（可选） 

注意：在继续查看下一页中的解决方案之前，请尝试自行完成此练习。 

7.3.2 讲师指导活动 - 回顾失控事件的步骤  

 

我们提供了以下信息来与讲师讨论您的解决方案。您还将在讲师指导活动中

执行这些步骤。  

 

 

 

设计事件框架模板 

模板名称 

命名模式：  

OOC %Element% 
%STARTTIME:yyyy-MM-dd HH:mm:ss% 
(%@Reference Type%-Tire Production) 

启用 Can Be Acknowledged 选项。 

属性 1 

名称：Maximum Pressure 

UOM：PSI 

数据引用配置： 
.\Elements[.]|Pressure; 
TimeRangeMethod=Maximum 

属性 2 

名称：Maximum Temperature 

UOM：ºC 

数据引用配置： 

.\Elements[.]|Internal Temperature; 
TimeRangeMethod=Maximum 

属性 3 

名称：Reference Type 

UOM：<none> 

值类型：Tire References 

数据引用配置： 

.\Elements[.]|%Attribute%; 
TimeRangeMethod=StartTime 
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在元素上创建事件

框架分析 

StartTrigger 
'Curing Phase'="Loading" and 'Internal 

Temperature'>25 and 'Lid Position'="Closed" 

EndTrigger 'Lid Position'="Open" 

严重性 严重 

子根本原因事件框

架 

生成子根本原因事件框架 

 

 

调度 事件 – 触发的任何输入 

测试  评估   预览结果 

回填 

回填过去 24 小时，然后验证回填状态： 
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通过 PSE 验证事

件框架 

事件框架搜索和事

件框架属性 

为事件框架搜索输入以下搜索条件： 

1. Starting After *-4h 

2. Template= Out Of Control 

3.  Element Name= HOU*1 

4. 取消选中 All Descendants 

（否则，还将在单独的行中返回根本原因事

件） 

单击 Search按钮。 

要显示事件框架属性，请单击  按钮以自定义

搜索结果的各列。单击 Select Attributes… 添

加最大压力、最大温度和引用类型 

 

 

单击 OK。将搜索 (Event Frame Search X) 的默认名称重命名为 OOC Houston Press 

1 Last 4 hours。 

记录两个所选事件框架的开始时间和结束时间以及两个最大值（不要选择尚未完成的

事件框架）。在下一练习中，我们将看到 PI Vision 中如何显示这些事件框架的信息。  

 

将分析转换为模板 

元素模板  在模板中分析。 

分析插件 

 分析开始 

 分析状态 

 回填所有轮胎硫化机（可选） 
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7.4 PI Vision 中的事件框架 

PI Vision 在显示中发现与资产相关的事件，并在专用的 Events 选项卡下列出它们。

显示的时间范围和持续时间确定了所列出的事件的时间段。如果该时间段存在任何事

件框架，则这些事件框架的图标左上角将有一个小蓝点。单击该图标可从 Assets 窗格

显示切换到 Events 窗格显示： 

 

 

 

其中列出了开始和/或停止时间位于该时间段的资产的所有事件框架： 
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如果选择一个事件框架并单击鼠标右键，可显示三个选项： 

 

Apply Time Range： 

将所选事件的时间范围应用于

显示中的所有符号。  

 

Event Details： 

打开专门的屏幕，用以分析、

确认事件以及添加注释 

 

按名称或类型比较类似事件： 

打开另一个 Browser 选项卡，

在一个“重叠”趋向图上比较多

个事件的流程数据。 

 

 

By Name 按名称比较事件时，事件比较屏幕最多显示 11 个拥有相同名称、

事件框架模板和引用资产的事件。 

By Type 按类型比较事件时，事件比较屏幕最多显示 11 个拥有相同事件框

架模板和引用资产的事件。 

 

更改显示的时间范围时，事件列表将自动刷新。取消选中 Automatically refresh the 

list 按钮可避免在更改显示的时间范围时搜索。 
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7.4.1 讲师指导活动–使用 PI Vision 可视化事件 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 查看失控时 Houston.Press.01 的流程数据  

• 分析失控事件详细信息 

方法 

• 切换显示时间范围以显示多个失控时间段的数据。 

• 显示特定失控事件的详细信息以获得相关资产信息。 

 

更改显示时间范围 

1. 在 PI Vision 概览页中打开 Big Tires Press 显示。 

2. 切换到事件列表显示  

3. 若要仅获得 OOC 事件，请编辑搜索条件以及事件类型过滤器 = Out Of 

Control 

注意：如果您未完成先前章节中的失控事件活动，仍然可以为停机事件框架执行此活动。 

4. 将时间范围设置为过去两小时：在开始时间字段中输入 -2h。左侧的 Now 按钮

应当仍为绿色，因此结束时间为当前时间。 

由于时间范围从一天降为两小时，因此事件列表将变小（必须启用 

Automatically refresh the list）。 

 

5. 选择一个失控事件并从鼠标右键菜单中选择 Apply Time Range。显示时间范

围调整为事件的时间范围。为其他事件重复此过程。 
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获得事件详细信息 

1. 从所选事件的鼠标右键菜单中选择 Event Details。 

2. 查看休斯顿轮胎硫化机 01 的相关属性。获得压力和内部温度的最小值和最大

值。  

3. 单击返回控件  返回到轮胎硫化机显示。 

 

7.4.2 讲师指导活动 - 使用 PI Vision 比较类似事件 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 在一个趋向图（重叠趋向图）中显示多个事件的流程数据以进行比较 

• 使用 PI Vision 的各种功能突出显示特定事件框架并隐藏所选事件框架以获得

更好的比较效果。 

方法 

打开第二个浏览器选项卡进行事件比较。 

通过突出显示和隐藏事件框架自定义显示。 

 

1. 根据需要调整时间范围，以便可以获得以前记录的事件框架。增大或减小开始

时间（从 -2h 到 -3h 或到 -90m）。更改时间范围时，事件列表将变小或变大

（必须启用 Automatically refresh the list）。 

左侧的 Now 按钮应当仍为绿色，因此结束时间为当前时间。 

2. 从鼠标右键菜单中选择 Compare Similar Events By Type。将为事件比较添加

一个额外的浏览器选项卡。 

事件比较可以显示最多 11 个趋向图（包括一个选定的趋向图）的数据。 
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3. 选择一个事件框架，将其隐藏。选择一个事件框架并从鼠标右键菜单中选择 

Hide Event，将其从显示中移除。（可以在 Events list 窗格或 Gantt Chart窗

格中执行该操作）  

 

 
 

4. 移除除内部温度和压力外的所有趋向图。 

要移除趋向图，请单击  图标。 

添加熟化阶段的趋向图。要添加描记线，请展开 HOU.Press.01 元素下的属性

结构并拖动 Curing Phase 属性  
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5. （可选）保存该显示。 
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8. 充分利用 AF 功能 

8.1 AF 对象安全性 

从 AF 版本 2.7 开始，我们实施类似于 Data Archive 安全性的安全性模型。该模型依

赖 Windows 集成安全性进行身份验证，但也会自行利用 AF 身份标识和映射对 AF 对

象进行身份验证。 

在 AF 版本 2.6 及之前版本中，AF 中的权限基于 Windows 用户和组进行设定。 

8.1.1 AF 身份标识和 AF Mappings 

AF 身份标识代表 AF 服务器上的一组访问权限。每个 AF Mappings 都是

从 Windows 用户或组指向 AF 身份标识。  

内置 AF 身份标识包括管理员、工程师和 World 

AF 服务器上会根据特定安全性要求创建 AF 身份标识并为这些 AF 身份标识授予 AF 

服务器资源（如元素集合或对象）的权限。  

 

使用 AF 映射，Windows 用户和组可映射到 AF 身份标识： 

  

注意：最好为 Active Directory (AD) 组而非单个 Windows 用户定义 AF Mappings。由于直接维

护单个用户帐户缺乏效率，因此建议只在例外情况下对用户映射。 
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映射到 AF 身份标识的 Windows 组的成员会自动获得该 AF 身份标识的访问权限。  

例如，Active Directory (AD) 组 Engineering Team 会映射到 Engineers，所以该 AD 

组中的所有成员都拥有元素集合的读取/写入权限。 

如果存在多个身份标识，用户会根据其映射到的所有 AF 身份标识获得权限。在下方

的示例中，Bob 拥有来自 PI AF 身份标识 1 和 PI AF 身份标识 2 的所有权限。 

 

 

 

内置 AF 身份标识： 

 

AF 身份标识 描述 

管理员 默认情况下，此身份标识拥有对 AF 服务器上每个集合和对象的所有访问

权限，包括所有数据库。无法修改或删除该权限。  

建议仅对少数用户限制访问此身份标识。 

工程师 除 Admin (a) 权限以外，此身份标识具有与管理员相同的权限。此身份标

识也无法删除 AF 数据库。 

建议对正在定义资产数据库的用户限制此身份标识。应创建其他身份标识

以缩小在 AF 中的访问范围。 

World 此身份标识拥有对 AF 服务器的每个集合和对象的读访问权限。更多信息

见下文。  
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World 身份标识： 

默认情况下，World 身份标识映射到 Windows Everyone 用户组： 

 

 

默认情况下，World 身份标识具有所有项目的读取权限。无法修改或删除 World 身份

标识。但可以删除 World 身份标识的映射以及 World 身份标识的权限。 

 

 

8.1.2 AF 访问权限 

可以授予所有 AF 对象的访问权限。示例： 

 

 

  



Building PI System Assets and Analytics with PI AF 

 

第 222 页 

 

下表说明可以分配给 AF 层次结构中所有对象的 AF 身份标识的访问权限。 

 

访问权限 缩写 定义 

读取 r 使用户能够查看对象。  

写 

w 使用户能够创建和修改对象。例外情况是，事件框架和

传送也需要对创建这些内容的元素模板具有写数据权

限。 

如果用户没有 AF 数据库的写权限，则不能在此数据库

内修改任何对象，不管该对象的特定权限是什么，都是

如此。 

读/写  使用户能够读取和写入相关对象。 

读数据  rd 使用户能够读取元素的属性值（非配置项）。 

写入数据  
wd 使用户能够修改元素的属性值（非配置项）。另外，此

权限还控制着用户是否可以创建或修改事件框架。 

订阅  秒 使用户能够订阅和取消订阅通知。 

订阅其他  so 使用户能够为其他用户订阅和取消订阅通知。 

删除  日 使用户能够删除对象。  

执行  

x 使用户能够执行大多数与分析案例相关的操作。 

仅在 Pimsoft SigmafineTM 数据核对中使用。PI 

Analysis Service 不会使用此权限。需要写入权限才能修

改、运行和停止资产分析。 

管理  

a 能够修改对象的安全性设置或所有者。还可以对已检出

到其他用户的对象强制执行取消检出，以及锁定和解锁

事件框架。 

 

可以为单个 AF 对象或对象集合分别设置权限。在创建新对象时，除了子元素外，可

使用集合安全性作为默认安全性。在创建子元素时，父元素的安全描述符将成为其默

认安全性。 
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8.1.3 AF 安全性层次结构 

下图显示了 AF 服务器中 AF 对象的结构。层次结构中的每个安全 AF 对象（元素、事

件框架和通知等）都有关联的安全描述符，安全描述符中含有该对象的访问权限信

息。 

同一类型的所有 AF 对象都属于一个集合。例如，数据库中的每一个 AF 元素都属于

该数据库的“元素”集合。各个集合也有关联的安全描述符，安全描述符中含有访问权

限信息。 
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8.1.4 AF 服务器安全性 

设置 AF 服务器的安全性 

要打开 AF 服务器的 Security Configuration 窗口：在工具栏中，单击 Database 按

钮。在 Select Database 窗口中，单击 Edit Security 按钮。  

或者，单击 AF 服务器属性按钮  打开 AF Server Properties窗口，然后单击 

Aliases 字段下方的蓝色 Security 链接。Security Configuration 窗口显示定义的访问

权限，并且您可以更改它们。  
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AF 服务器的 Items to configure列表包含以下项目： 

 AF Server 

 联系人集合  

 通知联系人模板集合 

 身份标识集合 

 映射集合 

 数据库集合（整个 AF 层次结构） 

 分析集合（整个 AF 层次结构） 

 分析模板集合（整个 AF 层次结构） 

 类别（整个 AF 层次结构） 

 元素集合（整个 AF 层次结构） 

 元素模板集合（整个 AF 层次结构） 

 … 

安全性配置可用于添加、移除或更改 AF 身份标识的权限。  

• 可以取消选中/选中项目以控制您即将应用的更改的范围。  

• 可以根据需要修改列出的其中一个 AF 身份标识的权限，或者添加或移除身份

标识。  

• 子权限选项定义与权限继承有关的处理方式。  

 

设置 AF 数据库的安全性 
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要打开 AF 数据库的 Security Configuration 

窗口：  

在工具栏中，单击 Database 按钮。在 

Select Database窗口中，右键单击 

Databases 列表中的数据库，然后选择 

Security。 
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在 Security Configuration 窗口的 Items to Configure列表中，选中所选的数据库和

每个集合。  

 
 
 

AF 数据库的 Items to configure 列表包含以下项目： 

 AF 数据库 

 分析集合 

 分析模板集合 

 类别 

 元素集合 

 元素模板集合 

 … 

安全性配置可用于添加、移除或更改 AF 身份标识的权限。可以取消选中/选中项目以控制您即将

应用的更改的范围。可以根据需要修改列出的其中一个 AF 身份标识的权限，或者添加或移除身

份标识。子权限选项定义与权限继承有关的处理方式。 

 

设置 AF 集合的安全性 
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可以配置 AF 层次结构中多个标记点上的集合（元素集合、事件框架集合、模板集合...）的访问

权限。可以在服务器级别或数据库级别设置它们。如果在服务器级别设置，分配给服务器中的身

份标识的权限也会分配给每个数据库中的相同身份标识。 

 

AF 对象安全性 

可以为身份标识设置特定访问权限，这些权限不同于从数据库中的任意对象（或对象组）和集合

中的 AF 层次结构内的其他地方继承的默认设置。 
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权限继承 

更改元素的访问权限时，以下内容适用于子元素的访问权限： 

引用类型 行为 

复合 子项和父项的访问权限始终相同。 

弱 绝对不会继承访问权限。 

父 – 子 在父项上设置访问权限时，Security Configuration 窗口中的 Child 

Permission 设置取决于使用的选项 

 

  

选项 描述 

Do not modify child 
permissions 

防止将为当前对象或集合设置的访问权限复制到 AF 层次结构

中的子集合与对象。 

AF 服务器 2.5 及更早版本的默认设置 

Update child permissions for 

modified identities 
对于每一个在 Security Configuration 窗口的 Items to 

Configure列表中选定的项目，复制所有已在 Identities列表中

修改其访问权限的身份标识的全部子集合与对象的访问权限。 

AF 服务器 2.6 及更高版本的默认设置。 

Replace child permissions for 
all 

identities 

对于每一个在 Security Configuration窗口的 Items to 

Configure列表中选定的项目，将 Identities 列表中的每一个身

份标识的所有子权限都替换为父访问权限。 

提示：在应用此选项之前，检查 Items to Configure 列表中的

所有项目的访问权限设置，以避免无意间在集合层次结构中覆

盖可能在其他地方应用的自定义权限！ 
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UOM 数据库安全性 

AF 度量单位 (UOM) 数据库可在所有 AF 数据库之间进行共享。不能为单个 UOM 或 UOM 类设

置权限。只能为整个 UOM 数据库设置权限。  

要打开 UOM Security Configuration 窗口：  

在“导航”窗格中，选择 Unit of Measure。 

在工具栏中，单击 UOM Security 按钮。 

 
 
 

 

安全性提示 

服务器级别的管理员权限提供对每个对象的访问权，与其安全性设置无关。 

如果您想编辑某个元素，需要具备对元素集合以及特定元素的写入权限。 

资源库对象（例如模板、枚举集、UOM 和引用类型）始终有读权限，与其

安全性设置无关 

拒绝设置会覆盖任何已许可的允许权限 
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8.1.5 讲师指导活动 - AF 对象安全性 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概

念。您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会

提供指导。  

练习目标 

• 创建 AF 身份标识并将其用于映射到 Windows 用户帐户。 

• 为 AF 数据库和 AF 元素分配权限。 

问题描述 

Velocity Terminals 雇佣了一位新实习生 Sheila (student04@PISCHOOL.INT)。为了

防止未授权读访问和意外更改，工程主管必须更改 AF 数据库的安全性： 

出于保密原因，只有指定的 Windows 用户才应能够读取 Velocity Terminals 的数据。

除了管理员和工程师，只有实习生应当能够读取数据。 

Sheila 应该无法亲眼见到悉尼或东京的油罐。当然，如果实习生浏览到分发或接收部

门，应该只能看到属于蒙特利尔的油罐。 

她将对 Tank01 做一些研究；因此，她应该能够编辑此油罐的数据和配置。 

注意：为了避免对 Velocity Terminals 生产数据库产生负面影响，请对 AF 启动 AF 数据库执行以

下步骤！ 

方法 

1. 单击 AF 服务器属性按钮 ( ) 以打开 AF Server Properties 窗口。Identities 

和 Mappings 选项卡：添加新的 Interns AF 身份标识并将 student04 帐户映

射到其中。 

 

2. 单击数据库按钮 ( )，为 AF 启动数据库选择 Security： 

• 要移除 World 身份标识的权限： 

选中 World 身份标识，然后单击  按钮。 
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• 要为 Interns 身份标识添加 Read 和 Read Data 权限： 

单击  按钮，选择 Interns 身份标识。 

取消选中 Allow All，然后启用 Read 和 Read Data  

选择 Update child permissions 选项并单击  按钮。 

3. 对于位于蒙特利尔的 Tank01 元素… 

• 要为 Interns 身份标识添加读取/写入和读取/写入数据权限： 

 

从 Tank01 元素中选择 Security...。 

选择 Interns 身份标识。 

启用 Read/Write 和 Read/Write Data 

• 选择 Do not Modify Child Permission 选项，并单击  按钮。 

 

4. 对于东京和悉尼元素… 

• 移除 Interns 身份标识的所有权限： 

 

从 Sydney 元素中选择 Security… 

选择 Interns 身份标识。 

单击  按钮 

选择 Update child permissions 选项，然后单击  按钮。 

（对 Tokyo 元素执行相应的操作）。 

 

验证 

1. 最大化 PI System Explorer (PSE)。 

 

2. 打开第二个 PI System Explorer (PSE) 实例以连接该实习生的帐户： 

 

 
 

按下 Shift 键，右键单击 Windows 任务栏中的 System Explorer 图标，然后选

择 Run as a different user。提供 student04 凭证。 

（可选，以改善区别）如果需要，调整窗口大小并将其放在第一个 PSE 窗口

的前面。  
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3. 第二个 PSE：单击数据库按钮 ( )。在 Select database 窗口，单击 

AF 服务器名称旁边的  按钮。 

 

4. 当前连接的是 pischool\student04。注意 pischool\student04 的有效身份标识

权限是 (Interns | World) 

 

5. 单击 OK。选择 AF 启动数据库并验证油罐的权限。尝试更改 Tank01 和 

Tank02 的描述符。  
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8.2 AF 属性特性 

创建属性时，有四个相关特性（Configuration Item、Excluded、Hidden、

Indexed）。您可以选择为每个元素属性设置这些特性。对于通过模板派生的元素，除

了 Exclude 特性外，不能更改其他属性特性： 

 

 

 

Configuration Item 可以将 Configuration Item特性分配给具有恒定值的表示资产固有

特性（如设备序列号）的属性。在 PI System Explorer 中，配置属

性都标有铅笔图标 ( )。 

更改了配置项的属性值后，PI System Explorer 将自动检出该属

性。要提交更改，需要 。  

Indexed Indexed 属性是为了快速搜索结果和检索值而优化的属性。您只能

为值存储在 AF 数据库中的属性添加索引。这意味着您无法为从 PI 

标记点数据引用或链接表引用获取值的属性添加索引。 

Excluded 

（AF 服务器 2015 中的

新增内容） 

如果元素模板中不是所有属性都适用，则可将不适用的属性排除。 

例如：仅某些油罐具有第二层容器涂层。为具有一层涂层的油罐将

第二层涂层的材料属性设置为 Excluded 特性。 

Hidden 

（AF 服务器 2015 中的

新增内容） 

如果属性用于保留中间结果，则 Hidden特性非常有用（例如随后

可以通过 PI 标记点数据引用检索表查找结果或单独用于填充替换参

数中的 Tag 名称）。 

 



充分利用 AF 功能 

 

第 235 页 

 

8.2.1 讲师指导活动 - 使用属性特性 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 为特定使用案例分配属性特性。 

 

问题描述 

油罐的容量属性被视为表示 Velocity Terminals 的油罐的固有特性的常量。除了设备

本身发生变化外，值将始终相同。如果容量有变化，应当在 AF 中检出和检入序列。  

对于 Velocity Terminals 的每个地点（蒙特利尔、悉尼、东京），仅第一个油罐具有

专门的夜班操作员。添加属性及操作员名称，它们仅应存在于油罐 Tank01、Tank05 

和 Tank08。  

Velocity Terminals 过程值的 Tag 命名约定是在 Tag 名称结尾加缩写“.PV”。缩写应当

在 AF 属性中定义，但该属性不应显示在 PI 可视化工具或 PI System Explorer 搜索

中。 
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方法 

在 AF 中打开 Velocity Terminals 数据库并导航到库中的油罐模板。（请不要再使用 

AF 启动数据库。） 

选择 Capacity 属性并 

启用 Configuration 

Item 特性 

 

添加值类型为 

String，默认值为 

Bob 的 Night Shift 

Operator 属性。 

 

 

添加值类型为 String 

的 PVCode 属性，启

用 Hidden 特性并输

入默认值 PV。 

 

 

检入新属性。 

切换到元素并选择 Tank01。将 Capacity 从 20,000 更改为 22,000。注意，Tank01 元

素已签出。它在资产树  中进行了相应标记。如果选择该元素，PI System 

Explorer 状态行会显示已检出元素的详细信息： 
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单击工具栏中的“撤消检出”按钮  退回到初始设置。 

 

注意，PVCode 属性标记为隐藏 。对蒙特利尔的以 P* 开头的所有属性执行

属性搜索（search > Attribute Search）。不返回 PVCode。 

对 Locations 下的 Night Shift Operator 属性执行属性搜索。 

选择没有夜班操作员的油罐行（Tank02、Tank03、Tank04、Tank06、Tank07、

Tank09、Tank10）： 

 

 

选择属性并设置 Excluded。单击 OK。该更改适用于所有选定的属性。更改位于东京 

(Akane) 和悉尼 (Alex) 的第一个油罐的名称： 

 

单击 Check-In。然后单击 Refresh。现在，搜索仅返回 Tank01、Tank05 和 Tank08 

的非排除属性。 

单独选择油罐元素并观察 Night Shift Operator 中显示的内容。 
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在 Tools > Options 下，选择 General 选项卡并取消选中 Show Excluded Attributes 

选项。单击 OK。再次单独选择油罐并观察现在 Night Shift Operator中显示的内容。 

8.3 AF 高级模板设计 

8.3.1 属性模板中的替代参数 

替代参数是属性模板中用于 PI 标记点数据引用的变量。AF 在创建元素时解析替代参

数。例如，替代参数 %Element% 将解析为属性的元素名称。  

例如，在卡车模板中，将速度属性 Tag 配置为 %Element%.%Attribute%.PV。通过此

模板创建 Truck1 后，AF 会尝试查找名为 Truck1.Speed.PV 的 Tag。 

 

 

 

注意 PI 标记点数据引用属性模板的默认配置：\\%Server%\%Element%.%Attribute%.  

 



充分利用 AF 功能 

 

第 239 页 

 

 

替换参数也可以在表查找和字符串生成器数据引用中应用。 

8.3.2 定义替代参数 

AF 支持许多替代参数，它们可在属性模板中使用。下表列出了最常用的替代参数。 

参数名称 替代参数 

%Attribute%  此数据引用所属的属性的名称。  

%Description%  保留该数据引用的属性的描述。  

%Element%  
此属性所属的元素的名称。对于事件框架，这指主要引用元

素的名称。  

%..\Element%  
属性所属的元素的父元素的名称。要检索更多的上级元素，

请使用 ..\ 表示，例如 %..\..\Element%。  

%Server%  

创建属性的计算机的默认 Data Archive 的名称。运行 PSE 

的计算机的默认 Data Archive。  

注意：%Server% 参数不会解析为 AF 数据库所在的计算

机。%Server% 参数可以根据 AF 客户端中的默认值解析为

不同的 Data Archive。  

下表列出了用于事件框架命名模式的替代参数。 

参数名称 替代参数 

%EventFrame%  属性所位于的事件框架的名称。  

%..\EventFrame%  
属性所位于的事件框架的父事件框架的名称。要检索进一步

的父级，可以使用 ..\ notation，如 %..\..\EventFrame%。  

%StartTime%、%

EndTime%   
本地开始或结束时间（如果可从时间上下文获取）。  

%UtcStartTime%

、%UtcEndTime% 

协调世界时 (UTC) 开始或结束时间（如果可从时间上下文获

取）。  
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另请参阅本书结尾的“附录 A：替代参数”。关于替换参数的用法，AF-EF 数据引用中

的替换语法指南是比较实用的文档。可从 PI Square 获取该文档（地址为：

https://pisquare.osisoft.com/thread/11188），副本位于文档类文件夹中  

https://pisquare.osisoft.com/thread/11188
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8.3.3 讲师指导活动 - 替代参数和 Tag 自动创建 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领域的

学习效果。您的讲师会向您介绍相关说明，并在活动期间提供必要的

指导。 

 

 

目标 

• 使用 AF 属性替代参数。 

• 演示自动创建 Tag。 

问题描述 

Velocity Terminals 的每个油罐上均已安装新压力传感器。您必须在 AF 结构中将压力

属性添加到这些油罐中；但是，尚未创建 PI Tag。您的仪表制造部的同事告诉您，此 

Tag 配置应与其几周前创建的名为“MyPressureTag”的测试 Tag 相似。  

Velocity Terminals 希望您在此项目中对创建的 PI Tag 使用有意义的命名方法；他们

希望将这些 Tag 命名为类似于： 

Montreal-Tank01.Pressure.PV 

由于我们公司的工作场所遍布全球，因此最好是使用国际压力单位 (Bar) 

方法 

将新属性添加到 Tank 模板，将其命名为 Pressure，然后使用 Bar 作为默认 UOM。  

选择 PI Point 作为 Data Reference，然后单击 Settings 以配置它。 

在 Tag Name下，应写入什么？ 

 
___________________________________________________________________

。 

 

由于尚未创建这些 Tag，请选中 Tag Creation，然后单击省略号 (…)。由于您的仪表

制造部的同事已配置收集压力数据的 Tag，您可以继续导入其设置（参见下图）。  

提示：您可以在 Tag Creation Settings 对话框中配置 Tag 设置（PointSource、InstrumentTag、

位置代码等）；但是，导入工作 Tag 的设置会节省一些时间。 
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您可能已看到，Tag 的工程单位 (engunits) 是 PSI。由

于要在 AF 中显示属性（以 Bar 为单位），因此可以利

用 AF 的动态单位换算功能。选择 psi 作为 Source 

Units。  

 

 

 

 

 

 

检查油罐：现有油罐显示什么值？  

________________________________。 

 

为现有油罐创建 Tag 要怎么做？  



充分利用 AF 功能 

 

第 243 页 

 

_________________________________。 

 

8.3.4 高级替代参数 

替代参数不仅可以解析为 AF 对象（比如属性）的名称，还可以解析为属性值。 

再次假设以 Velocity Terminals 为例。假设 Tag 名称始终按以下 Tag 命名方法构建： 

15Tank01TS.PV 

LocationCodeEquipmentNameMeasurementType.DataType 

其中   

LocationCode = 位置代码（例如：蒙特利尔的位置代码是 15） 

Equipment Name = 设备名称（例如：TANK01） 

MeasurementType = 度量类型（例如，温度传感器的度量类型为 TS） 

Data Type  = 数据类型（例如：PV 表示进程值） 

 

此方法可以确定 Tank01 的温度具有名为 15TANK01TS.PV 的 Tag。请记住，替代参

数可让您按以下方式在模板级别配置温度属性：在 AF 层次结构中新建的所有油罐都

会自动查看其映射到正确 Data Archive Tag 的温度。此处的理念是，将所有必需信息

放入此结构中的某个位置，以使属性可以根据它在层次结构中的位置重建 Tag 名称。

上述 Tag 命名方法的解决方案是，在城市名称元素下添加 ID 属性。 

 

然后，可以使用以下配置字符串构建级别属性： 

\\%Server%\%@..\|SiteID%%Element%TS.PV 
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读取替代参数 

可以将上述 %@..\|SiteID% 替代参数读取为：“为我提供父元素的 SiteID 属性值。” 为

更好地了解上述配置字符串，请参阅下表： 

 

符号 定义 示例 

%[…]% 将表达式视为替代参数。 
%Element%、%Attribut

e% 

。 向下导航一级。 %@.\<ChildElement>|<Attribute>% 

.. 向上导航一级。 %..\..\Element%、%..|Attribute% 

\ 引用元素。 %..\Element% 

| 引用属性。 %..|Attribute%、%@|<Attribute>% 

@ 
引用对象的值（而非其名

称）。 
%@..\..\|<Attribute>% 

 

  

mailto:%25@./%3cChildElement%3e%7C%3cAttribute%3e%25
mailto:%25@../../%7C%3cAttribute%3e%25
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8.3.5 讲师指导活动 - 在模板属性中使用替代参数 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的

不同概念。您可以观看讲师执行的操作，也可以同时执行相同的步

骤。您的讲师会提供指导。 

练习目标 

• 组合替代参数以将 Data Archive Tag 自动映射到 AF 属性。 

问题描述 

Velocity Terminals 将在接下来的几个月购买提供多个油罐的其他设施。在将这些额外

的资产添加到实际 AF 层次结构中时，他们将在这些新位置实现相同的 Tag 命名方

法，并想要节省时间。 

他们想要在 AF 中使用替代参数加速创建额外的资产。为证明切实可行，您需要将新

的温度属性模板添加到油罐模板中，以便使用替代参数自动查找正确的 PI Tag。 

再次查看速度终端门户，您可在电子表格中找到下表： 

地点 
地点 

ID 

蒙特利尔 15 

悉尼 23 

东京 44 

方法 

1. 在每个位置下创建显示其 ID 的属性（提示：您可能要使用场所模板以及表和表查找数据引

用）。 

2. 将温度属性添加到油罐模板中。使用替代参数，以便根据预期 Tag 命名方法自动构建 Tag 名

称。 

3. 通过浏览罐验证新的配置字符串。 

额外提示 

将一个（隐藏）属性添加到油罐模板，显示油罐温度的 PI 标记点名称。使用字符串生

成器组合 Tag 名称。应用隐藏属性。 
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注意：当引用属性值时，PI 标记点数据引用中使用的替代参数与字符串生成器中的语法之间存在

差别。 

%@..\|SiteID% 在 PI 标记点引用中有效，但对于字符串生成器，必须为“..\|SiteID”。 

有关更多信息，请参阅《PI System Explorer 用户指南》(PI System Explorer User Guide) 2015 

版第 124 页中“配置数据引用”(Configuration of data references) 一章中的“字符串生成器数据引

用”(String Builder data references)。 
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8.3.6 字符串生成器数据引用 

字符串生成器数据引用允许您使用替代参数和函数来操纵值和输出字符串。  

可使用字符串生成器数据引用的某些情况如下：  

✓ 合并字符串（元素名称 + 属性名称 + 值）。 

✓ 格式化日期和数字。 

✓ 构建指向元素和属性的路径。 

✓ 解析存储在 PI tag 中的操作员注释。 

✓ 将元素信息显示为属性。 

注意：由于此数据引用支持替代参数，因此在模板中使用时，会在运行时替换值。 

 

 

字符串生成器可让您使用 Related Attribute Values 上下文菜单处理层次结构中任意位

置的字符串（参见下图）。 
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8.3.7 讲师指导活动 - 使用字符串生成器数据引用 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的

不同概念。您可以观看讲师执行的操作，也可以同时执行相同的步

骤。您的讲师会提供指导。 

 

在类似如下内容的字符串中创建包含信息的新属性：  

Tank01 is located in Montreal, level is at 99.8% 

 

方法 

1. 在导航器面板中，选择 Library 部分。打开 Tank 元素模板。 

2. 添加 Tank Level Information 属性，值类型= String，数据引用= String 

Builder。 

3. 使用 String Builder Data Reference 对话框构建字符串 
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注释 1：要以请求的格式（小数点后面有一位数）显示液位值，请使用字符串生成器中的 

Format (real,format) 函数。格式遵循性能方程式 (PE) 风格的语法，如  "%3.1f"。小数点

之前的数字表示输出的最少字符总数，以空格补齐；小数点后面的数字表示小数点后显示

的位数。 

注释 2：您可以在单行上构造表达式，使用分号分隔其词条。但也可以将每项内容单独置

于一行，从而避免使用分号，使表达式的结构更加清晰（见上图）。 

4. 切换到其中一个罐元素并根据需要验证属性字符串。如有必要，请更正 String 

Builder 定义。 

5. 单击 Check-In  
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8.3.8 模板继承和基础模板 

元素模板的功能强大，能够设置基础模板。在创建基础模板后，即可将其用于创建大

量派生模板。在派生模板中创建元素后，此元素包含基础模板和派生模板中的所有属

性。 

 

• 从油罐元素模板创建的元素有三个属性：Diameter、Height 和 Fill Level。   

 

• 从搅拌油罐元素模板创建的元素有五个属性：Diameter、Height、Fill Level、

Mixer Speed 和 Mixer Blade Size 

 

基础模板最适用于对包含一组共有属性和一些不同属性的元素建模。例如，如果您有

一组油罐，某些油罐有两个阀门，某些有一个阀门，您可以为一个阀门的水槽模型创

建元素模板，然后将该模板用作两个阀门的油罐模型的基础模板。可在常规选项卡中

为元素模板设置基础模板；或者，可以在创建时通过右键单击基础模板来设置基础模

板，然后选择 New Derived Template。 
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要从 PSE 库中查看模板继承树，只需按继承顺序组织这些模板。 
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8.3.9 讲师指导活动 - 使用派生的元素模板 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 为具有用于测量 CO2 的附加传感器的特殊罐创建派生模板 

• 使用派生模板以供应特殊罐中液位属性的 PI 标记点引用。 

在 Tank10 中进行了两次修改，这意味着在以下详细信息方面罐偏离正常值： 

 

• 有一个用于测量 CO2 的附加传感器。Tag 名称为： 

Tank10CO2.PV 
 

• 现在液位传感器具有其他名称。名称不再为 Tank10LI.PV，而是  

Tank10LEVEL.PV 
 

这意味着该名称没有遵循正常名称模式 %Element%LI.PV。名称模式必须

为 %Element%Level.PV（或：%Element%%Attribute%.PV）。 

方法 

为具有附加传感器和不同液位属性命名模式的特殊罐创建元素模板。 

 

1. 打开 Velocity Terminals 数据库的库中的 Tank 模板。  

2. 在 Tank 模板上下文菜单中，选择 New Derived Template 

 

3. 将新元素模板重命名为 Special Tank。 
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CO2 的附加属性（PI 标记点：Tank10CO2.PV） 

4. 在 Attributes Templates 选项卡上，添加新的属性模板 CO2： 

  

默认 UOM = percent (Ratio) 

值类型= Double 

DisplayDigits=2 

数据引用 = PI Point 

 

5. 单击 Settings… 输入 PI 标记点名称。使用替代参数基于元素和属性名称定

义标准命名模式。使用 PVCode 属性字符串。 

您写入什么内容？ 

 
___________________________________________________ 

 

6. 将源单位从 <Default> (%) 更改为 %。 

 

7. 在导航器中，切换到 Elements。选择 Tank10 并将模板从 Tank 更改为 

Special Tank。 

 

 
 

8. 验证 Tank10 是否具有 CO2 属性，值来自 PI 标记点 Tank10CO2.PV。 

 

液位的属性覆盖（PI 标记点：Tank10LEVEL.PV） 

9. 在 Attributes Templates 选项卡上，添加新的属性模板 Level ： 

  

默认 UOM = percent (Ratio) 

值类型= Double 

DisplayDigits=2 

数据引用 = PI Point 
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10. 单击 Settings… 输入 PI 标记点名称。使用替代参数基于元素和属性名称定

义其他命名模式。使用 PVCode 属性字符串。 

您写入什么内容？ 

 
___________________________________________________ 
 

11. 将源单位从 <Default> (%) 更改为 %。 

12. 要定义此限值，请选择 Level 属性并单击上下文菜单中的 Limits…。按正

常罐的相同方式设定限值： 

 

13. 在导航器中，切换到 Elements。选择 Tank10 并验证 Tank10 的 Level 属

性的 PI 标记点是否为 Tank10Level.PV 

14. 检入更改。 

 

显示基于继承的元素模板 

15. 打开 Velocity Terminals 库中的 Element 模板。在上下文菜单中，选择 

Arrange By > Arrange By Template Inheritance。结果：在 Tank 下面显示 

Special Tank。 
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8.3.10 单独或分组练习 – ABC 矿用卡车（高级模板设计，可选） 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

练习目标 

• 为 AF 设计模板，以使用模板继承。 

 

• 在这些模板中创建使用 PI 标记点数据和公式数据引用的元素。 

问题描述 

您在为 ABC 矿业公司安装 Data Archive 和 AF 服务器，并且您目前主要关注的是其

卡车队。 

 

ABC 矿业公司有八 (8) 辆矿用卡车： 

ID Model 车牌号 Gas Tank Capacity 

SP1 矿车 CA HYK427 210 美加仑 

SP2 矿车 CA HRZ648 210 美加仑 

SP3 矿车 CA HBB139 210 美加仑 

SP4 超级运载 CA HAR990 317 美加仑 

SP5 超级运载 CA HEED21 317 美加仑 

SP6 超级运载 CA HQB932 317 美加仑 

SP7 矿用越野 CA HOT263 500 美加仑 

SP8 矿用越野 CA HEE563 500 美加仑 

 

所有矿用卡车都有一些通用度量项： 

测量值 单位 Data Archive Tag 
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里程表 

（自上次燃料箱装满后

的英里数） 

英里 SP1.Trip、SP2.Trip … SP8.Trip 

Gas Tank Level 加仑 SP1.GasLvl、SP2.GasLvl … SP8.GasLvl 

油位 公升 SP1.OilLvl、SP2.OilLvl … SP8.OilLvl 

胎压  psi SP1.TireP、SP2.TireP … SP8.TireP 

将这些度量项通过无线电发送回调度部门进行实时更新。 

超级运载卡车和矿用越野车捕获到更多数据： 

测量值 单位 Data Archive Tag 

GPS – 经度 Seconds (“) SP5.GPSLong… SP8.GPSLong 

GPS – 纬度 Seconds (“) SP5.GPSLat… SP8.GPSLat 

 

GPS 读数以秒 (“) 为单位（在平面角 UOM 类中，其中度数、分钟数和秒数之间存在

特定关系）。已假设度数和分钟数。 

ABC 矿业公司想要了解各运载车辆的燃油效率，以英里/加仑 (MPG) 为单位（双精

度）。  

您的任务是配置必需的模板、元素和属性来支持 ABC 矿业公司卡车队监控系统。 

 

方法 

1. 使用 Import from File… 导入 Truck Identification 和 Truck Model 

Specifications 表。XML 文件位于 

C:\Class\Exercises\03_ABCMiningCompany 
 

2. 为没有 GPS 的卡车创建元素模板 General Truck。 

 

3. 根据刚刚创建的模板创建名为 SP1 的元素。 

 

4. 根据刚刚创建的模板创建另一个名为 SP2 的元素。 

 

5. 在 General Truck 模板中定义四种度量的属性（里程表、燃料箱液位、油位、

轮胎压力）。在 SP1 和 SP2 中验证是否从正确的标记点接收到这些数据。 
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6. 定义您可从 Truck Identification 表读取的数据的属性（车牌号、型号）。  

 

7. 定义您可根据卡车的型号从 Truck Model Specifications 表读取的数据的属

性（燃料箱容量、标称油位、标称胎压）。 

 

8. 为带 GPS 的卡车创建派生的元素模板 Truck with GPS（超级运载卡车、矿用

越野车）  
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9. 在 Truck with GPS 模板中定义 GPS 度量的属性（GPS 纬度、GPS 经

度）。 

 

10. 使用 PI Builder 为其余卡车批量创建元素。验证卡车的属性是否正确。 

 

 
 

 

11. 通过在各类别中对属性分组实现对属性分类，通过选中属性配置面板右上角的 

 复选框将这些属性显示在这些组中。 

 

类别 属性 

燃料箱 燃料箱容量、燃料箱液位 

身份标识 车牌号、型号 

油 实际油位、标称油位 

胎压 实际胎压、标称胎压 

行程数据 行程表 

 
 

12. 添加新的 UOM 类 Fuel Efficiency，并且将度量单位 MPG 用作其标准单位。 

 

13. 添加燃油效率的属性，数据引用 = 公式。对于燃油效率计算，会报告自装满后

的英里数和当前油位，因此可以计算 mpg（每加仑英里数）。 

提示：公式：里程表 / （燃料箱容量 – 燃料箱液位） 
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14. （可选）还可以完成各车辆的范围计算，以英里为单位（燃油效率 * 剩余的燃

油）。 

 

15. （可选）使用以下公式添加一个额外的度量单位 Liter per 100 km （缩写：

l/100km） 

MPG = 235 / l/100km 
l/100km = 235 / MPG 

以升/百公里为单位显示燃油效率（L/100 km）。为了从 MPG 换算到该单位，

在指定换算时将使用公式选项）。 

 
 
 

先尝试自行完成本练习，然后再参考本书结尾的练习答案。 

 
 

关于属性类别 

类别可用于对 AF 对象（如元素、属性或表）分组，以帮助管理这些对象。要将属性添加到类

别，只需从属性配置面板的“类别”字段选择一个或多个类别，或者可以编写类别名称。如果该类

别尚不存在，则会显示提示询问是否创建此类别。 

  



Building PI System Assets and Analytics with PI AF 

 

第 262 页 

 

8.4 AF 和未来数据（可选） 

Data Archive 2015 引入存储未来数据的功能，该功能可用于处理时间戳在 2038 年 1 

月以前的数据。1970 年 1 月仍然是所有 Tag 的最早时间限制。 

 

 

 

当存储不按时间顺序连续收集的数据时，应当使用未来 Tag。例如，过程或操作数据

应当保留在历史 Tag 中，因为它是实时测量和收集的。另一方面，任意一个时间范围

内的预告或任何形式的预测数据则更适合使用未来 Tag。 

 

未来数据和分析 

您可以将未来的数据输入到分析中。您还可以通过在分析中指定输出的未来时间戳，

使用分析来产生未来的数据。 
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8.4.1 高级配置选项（Analysis Service 2015 的新增内容） 

对于任何调度的分析，输出值的默认时间戳是触发时间。对于周期性调度，触发时间

为调度的评估时间，对于事件触发的调度，触发时间为指定属性更改值的时间。  

使用高级选项，可以指定分析输出值的时间戳。 

 

 

选项 行为 

Trigger Time 默认值。某一调度指定的时钟时间或某一输入值更改的时钟时

间。 

Execution Time 分析计算值的时钟时间。 

Relative to Trigger Time： PI 时间表达式指定的时间。输入有效的时间表达式，如相对于触

发时间或固定时间的时间。未来的相对时间将会创建具有未来时

间戳的事件。对于映射的输出标记点，这就需要未来的 PI 标记点

（可用于 Data Archive 2015）。  

Automatic Recalculation 如果您预计您输入的数据会延迟到达或顺序会变乱，则可以请求

对分析进行自动重新计算。Management 列表可用于为一个命令

内的多个分析设置此选项。 

 

Relative to Trigger Time 选项何时有用？ 

您需要工厂在 24 小时（昨日午夜 – 今日午夜）内原材料消耗情况的每日汇总。资产

分析用于计算总和。但由于工厂正在运营中，无法在 10 - 15 分钟的延迟内准备好所
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需的所有输入数据。安排在每日凌晨 12:15 进行分析，将 Relative to Trigger Time 选

项设为 T（今日午夜），以便输出结果在午夜盖上时间戳（尽管汇总工作将在 15 分钟

后完成）。  
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8.4.2 讲师指导活动 – 具有未来数据的 AF 属性（可选） 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概

念。您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会

提供指导。  

 

活动目标 

• 创建引用具有未来数据的 Tag 的属性。 

• 使用资产分析计算预告数据。 

• 了解 PI Processbook 中具有未来时间戳的 AF 属性值的显示。 

问题描述 

我们跟踪 ABC 矿业公司的卡车从矿山运送到火车站以便进一步运输的材料量，从而将

其与目标生产计划相比较。每隔 4 小时在 Tag SP?.Load 中报告矿用卡车已运送的每

日累积材料总量。ABC 矿业公司的生产管理部门计算接下来四小时的预期负载，这些

值在 Tag SP?.LoadSim 中提供。 

您的任务是计算接下来四小时内的累积材料量。这些计算应当存储在未来 Tag 

SP?.DeliveryPlan 中，以便以卡车为基准比较实际运送的材料量和相应的预告运送

量。 

 

方法 

跟随讲师的指导，观看他/她执行步骤来模拟如何创建计划数据并在 General Truck 模

板中创建 AF 属性，从而在 PI Processbook 显示中实现相应的可视化。 

 

创建计划数据 

使用 AF 分析，我们将通过将接下来四小时的预期负载累加到卡车的当前负载上，每

四小时计算一次新的负载运送量预告。  
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为常规卡车模板创建属性 

• 在 System Explorer 中，选择 Library 部分，在 Element Templates 部分打开 

General Truck 模板。  

• 选择右侧的 Attribute Templates 选项卡。要将这三个属性与剩余属性相隔离，

请添加属性类别 Material Delivery。  

• 按下表配置属性。Load.Next4Hours 属性应当为 Load 属性的子元素： 

 

 

 

属性名称 默认度量单位 值类型 数据引用 设置 

Load ton (Mass) Double PI 标记点 %Element%.%Attribute% 

Load.Next4Hours ton (Mass) Double PI 标记点 %Element%.LoadSim 

Delivery Plan ton (Mass) Double PI 标记点 %Element%. DeliveryPlan 

对于属性类别，在所有情况下均设置为 Material Delivery。 

 

Load： 

实际累积卡车负载（以天为基准单位） 

Load.Next4Hours: 

接下来 4 小时的预期负载 

Delivery Plan： 

预测累积卡车负载（以天为基准单位） 
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计算接下来 4 小时的预期负载 

• 在 System Explorer 中，选择 Library 部分，在 Element Templates 部分打开 

General Truck 模板。  

 

• 选择右侧的 Analysis Templates 选项卡并创建新的分析模板 Load Delivery 

Forecast（表达式类型）。 

 

以下计算规则适用： 

计算时间 计算 结果时间戳 

00:00:00 该天的初始预告是接下来四

小时的预期负载  

04:00:00 

04:00:00、 

08:00:00 等， 

直到 16:00:00 

预告是实际负载加上接下来

四小时的预期负载 

08:00:00、 

12:00:00 等， 

直到 20:00:00 

20:00:00 由于累积是按天计算，因此

值在午夜重置为 0。 

00:00:00 

 

表达式是什么样的？ 

_____________________________________________________________

。 

 

• 将 Output Attribute设置为 Delivery Plan。 

 

• 我们想要每 4 小时执行一次计算，结果将使用未来四小时的时间戳写入。将 

Scheduling 设置为 Periodic。单击 Configure 以设置四小时间隔。不指定偏移

量，因此在整点执行计算。 

 

要写入具有未来时间戳的结果，请选择 Advanced… 并将 Relative to Trigger 

Time 设置为 *+4h。检入。 
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• 在导航器窗格中，选择 Management 以列出 8 辆卡车的所有分析数据。 

 

• 启用顶行的复选框以选择所有分析。选择 Backfill checked analyses 操作。将 

Start（开始时间）设置为 y，End（结束时间）设置为 *。然后单击 Queue 开

始回填过程。 
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完成回填后，按如下所示验证结果： 

• 在 Elements of the ABC Mining Company 数据库下打开其中一台卡车。 

 

• 选择具有 Delivery Plan和 Load属性的行并选择鼠标右键上下文菜单中的  

趋向图。 

 

• 设置开始时间= y，结束时间= *+4h，并单击  刷新按钮。验证具有预告值

的趋向图曲线： 

 

 

 

提示：对于一些卡车，实际负载和相应的计划数据值可能紧挨在一起。可以通过拖动一个矩形放

大趋向图。要退回到初始缩放比例，请单击  刷新按钮。 
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8.4.3 单独或分组练习 - 具有未来数据的属性的 Processbook 显示（可选） 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

 

• 在 Processbook 中打开 ABC Mining Trucks Material Delivery.PDI 文件（位于 

class\exercises 文件夹中）。  

 

• 在 View of the Processbook（Processbook 的视图）菜单下，启用 Element 

Relative Display，打开 Element Relative Display 窗格。  

 

• 单击 Find and Add New Element Contexts 按钮，打开 Element Search 对话

框。  

 

• 选择 ABC Mining Company AF 数据库并使用名称搜索模式 SP* 搜索卡车。  

 

• 从搜索结果列表中选择八台卡车 SP1 – SP8 并单击 OK。  

 

• 选择其中一台卡车。趋向图显示过去 24 小时到未来 24 小时时间段的数据：  
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9. 通知重要事件 

Notifications 是 Asset Framework 中的一项功能，可针对系统中需要特别关注的状况

实时向用户发出警示。可以采取相应的措施，以积极主动地预防或解决当前状况所面

临的问题。信息通过电子邮件发送，或传输到 Web 服务。 

通知的接收方（“订阅者”）可选择确认通知。如果需要采取措施的情况没有及时得到

确认，则可以再次发送通知。  

通知用途的示例包括： 

• 温度超出正常范围 

• 设备关闭 

• 运行时计数器已过，指示需要维护 

• 材料供应量低于临界最低水平 

注意：在 AF 2016 R2 版本中对 Notifications 进行了修订。在之前的版本中，Notifications 有不

同的概念，现在称其为“旧版 Notifications”。将 PI System 升级到 2016 R2 后，可使用专门的迁

移工具将现有的旧版 Notifications 迁移到新概念。 

9.1 Notifications 简介 

使用 AF 2016 R2 时，在 AF 中生成新的事件框架即可触发通知。在通知规则中定义

触发条件。  

事件框架生成可能与不同的源相关。可以通过资产分析、Event Frame Generator 

(EFGen) 接口、自定义 AF SDK 应用程序或手动创建的方式执行。  
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9.1.1 通知组件 

 

PI Notifications Service 

PI Notifications Service 实时处理 Asset Framework (AF) 中定义的事件框架并向外发

送电子邮件和 Web 服务通知。从 AF 服务器 2016 R2 安装工具包安装该服务。 

 

通知规则选项卡 (PI System Explorer) 

可以为个别元素定义通知规则，或创建通知规则模板。在 PI System Explorer 中，用

于配置通知规则的用户界面位于元素和元素模板的专用选项卡中： 
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注意：PI System Explorer 导航器（左下角）中不再显示 Notifications 条目。 

定义包括触发条件、在通知规则中添加订阅者、设置消息格式以满足组织需求。 
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管理插件 (PI System Explorer) 

• 允许管理 AF 服务器中的分析和通知规则。 

 

9.2 投递事件 

Notifications 的投递通道提供将警示投递给订阅者的机制。执行 Notifications 的标准

安装后，以下投递通道可用： 

• 电子邮件 

 

电子邮件投递通道支持通过 SMTP 邮件服务器发送包含通知警示的电子邮件。 

  

• Web 服务 

 

Web 服务投递通道支持通过调用 Web 服务的某个方法来向其提供信息。 
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注意：较早版本的 AF 中的旧版 Notifications 也支持 OCS 和自定义投递通道。但是 AF 2016 R2 

中的新版 Notifications 不支持这两种投递通道。 

9.2.1 电子邮件投递通道 

可通过电子邮件投递通道的设置来配置主 SMTP 服务器和备份 SMTP 服务器以转发

电子邮件，以及警示的“发件人”电子邮件地址。IT 部门应该说明将哪些服务器和端口

用于主 SMTP 服务器和备份 SMTP 服务器。对于“发件人电子邮件”，该地址不需验

证，因此可以设置为任何所需的地址（例如 PINotifications@domain.com）。在大多

数情况下，不应启用 Allow contacts to set sender email。 

注意：在培训云环境 (TCE) 中，使用 notifications@pischool.int。  

 
 

设置电子邮件投递通道之后，大多数电子邮件地址应该由 Active Directory (AD) 提

供。如果 AD 没有包括所有需要的电子邮件地址，可以在 PSE 的 Contacts 部分中创

建额外的电子邮件。  

  

mailto:PINotifications@domain.com
mailto:notifications@pischool.int
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9.2.2 讲师指导活动 - 电子邮件投递配置和签出 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 了解电子邮件投递所需的设置。 

方法 

1. 在 PSE 中，选择导航器中的 Contacts 并导航至 Tools > Delivery Channel 

Plugins，然后从 Email Delivery Channel Plug-In 上下文菜单中选择 

Settings。 

 

 

 

2. 对于培训云环境 (TCE)，邮件服务器安装在 PISRV01。 

注意：仅为 pischool.int 域中的某些用户帐户配置 PISRV01 上的邮件服务器。 
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3. 单击 Test… 按钮以发送测试电子邮件至 student01@pischool.int。 

 

 

 

4. 启动 Microsoft Office Outlook 并验证测试电子邮件的接收情况。 

注意：如果您首次启动 Outlook，您将收到提示，请求您为 student01、student02 和 student03 

输入密码。输入密码（为所有三个帐户输入相同密码），选择选项以保存密码并单击 OK。 
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9.2.3 Web 服务投递通道 

通过 Web 服务投递通道，Notifications 可以通过调用 Web 服务的某个方法来与其联

系以及向其提供信息。要使用该投递通道，必须可以在 Web 服务器上使用 Web 服

务。 

关于 Web 服务 

可以在网络上通过 Web 服务在两个电子设备之间通信。在大多数情况下，该服务托管在 Web 服

务器上，并且为其客户端提供方法。这些方法通常会等待来自一个客户端的传入信息，然后压缩

数据，并且最终将数据返回相同的客户端，或者将该信息传递给另一个客户端。 

有很多商用的 Web 服务可供使用，而且很多开发环境提供了模板和其他工具，可用于

开发自定义 Web 服务。 

示例：自定义 Web 服务可以处理收到的信息并在客户维护系统中生成相应的工作订

单： 
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9.3 配置通知 

配置通知规则的工作包括指定触发条件、在通知规则中添加订阅者、设置消息格式以

满足组织需求。 

1. 选择用于创建通知规则的元素或元素模板 

2. 创建新的通知规则： 

a. 定义通知的触发条件 

b. 添加订阅者 

c. 设置通知消息的格式 

3. 测试通知 

 

 

 

注意：如果您为个别元素创建了通知规则，可以使用 Convert to Template 功能将范围扩展到相

应的元素模板。 
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9.3.1 触发条件 

通知规则定义了确定哪些事件框架生成将触发新通知的条件。 

通知规则有两种可能的触发条件模式： 

• 分析 

• 事件框架搜索 

 

使用 Analysis 模式在特定分析生成的事件框架上触发通知规则。 

 

 

 

使用 Event Frame Search 模式，根据事件框架的名称、模板和类别触发通知规则。

在 Event Frame Search 模式下，您可以从下拉列表中选择一个已经配置的事件框架

模板，然后为将触发通知的事件框架配置名称和类别。名称可以包含事件框架搜索支

持的通配符。 

 

 

 

在这两种模式下，您可以使用事件框架属性值添加其他触发条件。可以为通知规则触

发条件中指定的事件框架模板的任何属性任意指定条件。例如，如果您的事件框架模
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板定义了诸如“停机时间”的事件，但您只需要关于“非计划”停机时间的电子邮件，则可

以配置一个属性值条件，其中“停机时间”事件框架模板上的“原因代码”属性具有一个表

示“非计划”停机时间的值。 

 

 

注意：通常在工作中，衡量成功的标准是产量。对于 Notifications，生成的警示越多，

Notifications 使用失败的频率就越高。如果向某收件人提供过多警示，则她/他可能无法对其中每

一个警示给予适当的关注或响应。这会导致执行无效，因为所有警示都将变成收件人的噪音。  

 

9.3.2 讲师指导活动 - 构建事件框架创建分析 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 构建用于监控罐液位的分析并在液位超出限值（过低或过高）时创建事件框架 

问题描述 

我们将针对 Velocity Terminals 的油罐配置通知。一旦油罐液位超出目标运行液位

（过低或过高），此通知将予以告知。只有包含 HC1500 的油罐需要通知，因为该产

品的数量不当会导致问题发生。如果油罐几乎是空的，则内部涂层会遭到腐蚀并需要

处理。如果油罐几乎是满的，则存在材料溢出并造成环境破坏的风险，这更为关键。 

提醒限值违规的电子邮件应包括液位值和温度值，因为评估油罐内液体的状况时需要

这些信息。  
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方法 

首先，我们将在 Tank Element Template 下创建分析以在液位超出限值时创建事件框

架。在接下来的活动中，将关联和配置通知规则。  
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事件框架模板 

1. 在 PSE 中打开 Velocity Terminals 数据库，在导航器中选择 Library，然后在 

Event Frame Templates 下选择 New Template。 

2. 对于名称，输入 Tank Level Excursion 

3. 对于描述，输入 Tank Level Outside Operational Targets 

4. 对于命名模式，输入  

 
%TEMPLATE% for %ELEMENT% (%STARTTIME:yyyy-MM-dd HH:mm%) 

 

创建事件框架时，事件框架名称采用什么格式？ 

 
____________________________________________________________ 

 

 

5. 选中 Can Be Acknowledged 选项 

6. 单击 OK。 
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事件框架属性模板 

7. 选择 Attributes Templates 选项卡。选择 New Attribute Template。 

8. 添加液位、温度、产品和液位偏移的属性 

 

属性 

名称 

UOM 数据 

引用 
值 

类型 

设置… DisplayDigits 

Level 百分比 PI 标记点 Double .\Elements[.]|%Attribute%; 
TimeRangeMethod=StartTime 

2 

液位偏移 <none> <none> String  无 

Product <none> 字符串创

建器 

String .\Elements[.]|%Attribute%; 无 

Temperature 摄氏度 PI 标记点 Double .\Elements[.]|%Attribute%; 
TimeRangeMethod=StartTime 

2 

 

提示 1：一旦您输入 Level 属性，可以使用复制和粘贴功能创建另一个 PI 标记点属性，编辑该属

性可创建 Temperature 的属性 

提示 2：您可以手动输入 Product 属性的设置。或者，从菜单中选择一个属性值，然后进行相应

的编辑。确保设置与上述信息完全匹配。 

 

液位偏移属性用于指示是否超过上限或下限。配置相应事件框架生成的分析

时，将稍后定义此属性值的设置。  

9. 检入 
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违反限值时事件框架生成的分析 

10. 从 Element Templates 中选择 Tank 

11. 选择 Analysis Templates 选项卡，然后单击 Create a New Analysis 

Template。 

12. 对于名称，输入 Limit Monitoring 

13. 选择分析类型 Event Frame Generation 

14. 对于示例元素，选择其中一个油罐（例如 Tank01）。 

15. 对于 Event Frame template，选择 Tank Level Excursion： 

 

 

16. 将 Start Trigger 1 重命名为 Too High。输入表达式：’Level'>'Level|HiHi’ 

 

将严重性设为 Critical。 

 

17. 添加新的开始触发条件，将名称设置为 Too Low。输入表达式： 

'Level'<'Level|LoLo' 
 

将严重性设为 Major。 

 

18. 当液位发生变化时，我们希望检查是否超过了任何限值。因此，将 Scheduling 

设置为 Event-Triggered。 

注意：调度会定义评估触发条件的频率。如果此选项为 Event-Triggered，则只要触发表达式中的

属性发生变化，便会评估触发条件。如果属性是 PI 标记点数据引用，则通常采用这种方式执行 

Analytics。如果属性属于其他数据引用（例如表查找），则使用 Periodic。 
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19. 单击 Advanced Event Frame Settings...，并选中 Save Trigger name to event 

frame attribute。单击 Map Attribute 并选择 Level Excursion 属性。单击 

OK。 

 

 

注意：可以忽略警告 

“The selected attribute template will be converted to a Configuration Item and any existing 
configuration of the attribute template will be lost.” 
 

20. 检入。 
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模拟液位高于限值 

注意：Tank01 液位的模拟每 10 分钟循环该值一次，存在超过下限和上限的情况。您可以等待一

段时间，以使所需的值自动更改，或者您可以通过手动输入来强制更改值。请注意，手动输入值

可能会过早被来自接口的新值替换，用以启动事件框架 

21. 选择 Elements – Velocity Terminals - Locations - Montreal - Tank01 

22. 选择 Level 属性 – Settings 

23. 取消选中 Read-Only。 

24. 选择产品属性并将其更改为 HC1500（稍后我们需要该值）。 

25. 检入。 

26. 对于液位属性，在 Value 中输入 98 

验证超过限值时事件框架的生成 

27. 在导航器面板中选择 Elements，导航至 Tank01 并选择该元素。 

28. 在 General 选项卡上单击蓝色的事件框架链接。 

 

 

提示：您应有 Tank01 的事件框架。如果没有任何事件框架，则原因可能是该油罐实际上已经超

出限值。重新输入一个值。  
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29. 单击结果的标题行中的齿轮图标 。 

单击 Select Attributes。单击  图标，添加油罐液位偏移事件框架模板中的

四 (4) 个属性。单击 OK。这四个选定的属性将扩展该列表。单击 OK。 

 

 

 

9.3.3 讲师指导活动 - 配置通知规则 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 创建通知规则（与上一练习中的事件框架分析相关联）。 

• 定义通知的触发条件。 

• 添加要收到通知的订阅者。 

• 接收签出电子邮件。 

 

方法 

下一步，我们将创建通知规则，它与上一活动中的分析相关联。将配置通知规则，以

在发生新事件且材料为 HC1500 时触发通知。 
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1. 从 Element Templates 中选择 Tank。选择 Analysis Templates 选项卡，然后

选择 Limit Monitoring 分析。 

2. 单击蓝色链接以创建新的通知规则模板 

 

 

3. 在 Notification Rule Templates 选项卡上，将名称更改为  

Critical Level Notification 

4. 在 Trigger 部分中，选择蓝色的 View/Edit Trigger 链接。 

5. 选择该链接以添加属性条件  

6. 添加 Product Equal HC1500。单击 OK。 

 

 

7. 在 Subscriptions 部分中，选择蓝色的 View/Edit Subscriptions 链接。 

8. 展开 student01，以便生成电子邮件并将其拖进 Subscriptions 部分。单击 

OK。检入。 

 

 

9. 为 student01 启动 Outlook。  

10. 将 Tank01 的液位属性值更改为 99，以验证您是否收到电子邮件。 
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注意：稍等一会儿，以便系统发出电子邮件。甚至可能需要一到两分钟才能收到电子邮

件。  
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9.3.4 触发条件选项 

定义触发条件时，可设置以下选项： 

 

 

 

重新发送间隔 

在此时间间隔之后，PI Notifications Service 将发送额外的警示，直到与通知规则匹配

的事件框架得到确认或被关闭。 
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不重复间隔 

在此时间间隔内，PI Notifications Service 不发送与同一通知规则相关的类似警示。 

 

 

 

可以确认事件框架 

用于确认事件框架的选项；还可以相应地修改事件框架模板。如果已将事件框架模板

配置为待确认，系统会自动选择此选项。 

 

严重性选项 

此选项仅适用于事件框架生成分析。如果您为分析配置了多个开始触发条件，则可以

选择在以下时间接收通知： 

• 当前触发条件的严重性高于到目前为止遇到的任何触发条件的严重性时。 

• 当前触发条件的严重性高于上一个触发条件的严重性时。 

• 每次符合触发条件时，无论其相对于之前其他触发条件的严重性如何。 
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9.4 设置待投递信息的格式  

Notifications 软件含有完整的格式工具，可以用于定义电子邮件警示中所包含信息的

格式。 

全局默认格式 

系统提供一种可用作默认格式的全局格式。可以编辑或重命名全局格式，但无法删除

它。可以添加其他格式。要访问全局默认格式，请导航到 Tools -> Global Formats。 

 

 

自定义投递格式 

要为特定的通知规则编辑或添加特定的自定义投递格式，请选择蓝色的 Message 

Formats 链接。可通过相应的图标来区分这些格式： 
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9.4.1 讲师指导活动 - 设置默认通知电子邮件的消息格式 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 为电子邮件消息投递准备消息格式模板。 

方法 

1. 在 PSE 中，导航至 Tools > Global Format。 

2. 选择 Global Default Email 所在的行（颜色变为浅蓝色），然后单击上方的复

制  图标。将新格式重命名为“含表格的默认电子邮件”。 

 

关于格式化消息 

Formats 窗口的右侧显示 Content 部分，可用于在消息中添加额外的内容。在“内容”窗格中，只

需拖放或双击所需的内容即可将其添加到消息中。在 Global Format 部分中，只能添加通用内

容。配置特定通知规则或通知规则模板的 Message 选项卡时，可以添加特定内容。 
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3. 选择“含表格的默认电子邮件”格式，并且对格式化进行修改，以便表格可用于

组织与通知相关的信息。（参见下图） 

 

要添加一个表，请使用上方的屏幕截图中突出显示的控件。添加超链接时，请

选择该选项以将链接作为文本发送： 

 

 
 

我们将能够使用该链接并在 PI Vision 中打开相关显示。向组织机构以外的没

有 PI Vision 访问权限的某个人发送电子邮件时，使用此选项来发送屏幕截

图。 

注意：本课中的培训云环境 (TCE) 中使用的邮件服务器不支持在电子邮件中包含屏幕截

图！ 

 

4. 要执行测试发送操作，请单击  按钮。 

对于电子邮件地址，请输入 student01@pischool.int： 
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5. 单击 OK。 

9.4.2 讲师指导活动 - 设置罐液位偏移通知的消息格式 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 根据消息格式模板构建通知消息。 

方法 

我们希望为提醒超过限值的电子邮件定义特定格式，以发送给收件人。消息格式包括

一个表，其中包含液位和温度值。消息还应提供进入 PI Vision 的链接，以允许在超过

限值后的一段时间内进行确认和显示。  

1. 从 Library -> Element Templates 中选择 Tank，打开 Notification Rule 

Templates 选项卡。 

油罐液位偏移 – 含表格的电子邮件 

2. 在 Subscriptions 部分单击蓝色的 Manage Formats 链接。选择  Default 

Email with Table 所在的行（颜色变为浅蓝色），然后单击上方的复制  图

标。将复制的格式重命名为 Tank Level Excursion - Email with Table。 



Building PI System Assets and Analytics with PI AF 

 

第 298 页 

 

 

 

3. 在右侧的 Content 窗格中，拖放或双击适当的信息，以将其添加到表格中。表

格的第二行应显示液位信息，而第三行则应显示温度信息。完成后，单击 

OK。 

 

4. 在 Notification Rule 选项卡的 Subscriptions 部分，单击蓝色的 View/Edit 

Subscriptions 链接。 

5. 在 student01 所在的行中，选择 Configuration 列中的 Tank Level Excursion 

- Email with Table。单击 OK。检入。 

6. 向 Outlook 验证新的通知电子邮件是否有新的请求格式。 
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9.5 确认通知 

确认通知可确认已读取重要通知并对其采取了相应的行动。 

注意：使用“确认”功能的先决条件是选中了事件框架模板中的 Can be Acknowledged 设置。 

确认方法 

可通过以下两种方式进行确认： 

• 在 PI System Explorer（事件框架搜索结果）中显示事件。选择上下文菜单功

能 Acknowledge… 

 

 
 

确认后，红色感叹号  变为 。将鼠标悬停在 OK 上方时，可获得关于谁

在何时进行确认的信息。 

 

 
 

  

• 在 PI Vision 中打开相应的事件详细信息显示。单击该事件框架的“确认”链接。 

要显示相应的事件详细信息，请单击通知电子邮件中的“事件详细信息”链接，

或使用 PI Vision 中的事件搜索选项。 
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9.5.1 讲师指导活动 – 添加备注和确认事件 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

蒙特利尔的 Tank01 对该工厂的整个运营都至关重要。如果油罐中的材料液位不适当，则 

student01 负责在问题中添加备注，并确认该通知以记录所采取的行动。 

 

活动目标 

• 阅读 Tank01 的最新通知电子邮件中的信息，并在 PI Vision 中打开事件详细

信息 

• 输入当前液位状态的备注并确认该警示。 

 

方法 

6. 在 Outlook 中，打开 Tank01 的最新通知电子邮件。 

（如果电子邮件是刚刚才收到的，那么液位很可能尚未恢复到正常水平，因为

它之前已经超过了限值。） 

7. 单击蓝色的 Events Details Hyperlink 链接。该事件的详细信息页面将显示在 

PI Vision 中。 
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8. 如果液位仍然超出限值，则该事件仍在继续进行当中。在这种情况下，结束时

间显示为 In Progress。如果您继续观察该显示一段时间，趋向图中覆盖的时

间跨度将会增加，直到液位恢复正常（PI Vision 更新速率为 15 秒）。 

 

 

 

9. 通过在趋向图下方的列表中选中或取消选中趋向图行，可以对其执行添加和删

除操作。  

 

10. 在备注字段中添加文本，然后单击 Add 按钮以输入。 
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11. 单击 Acknowledge 按钮以确认该事件。PI Vision 中会显示有关待发送通知、

备注和确认的信息。 
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9.5.2 讲师指导活动 - 验证确认流程 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

练习目标 

• 比较 PI Vision 和 PI System Explorer 中通知警示的备注和确认流程。 

方法 

1. 打开 PI System Explorer，并在导航器中选择事件框架。 

2. 从 Event Frame Searches 上下文菜单中选择 New Search… 

3. 将 Search 设置为：Starting After 

4. 将 Search Start 设置为：*-30m 

5. 将 Template 设置为：Tank Level Excursion。单击 Search。 
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6. 单击结果的标题行中的齿轮图标 。 

单击 Select Attributes。单击  图标以添加全部四 (4) 个属性。单击 OK。这

四个选定的属性将扩展该列表。单击 OK。 

 

 

7. 将默认搜索名称重命名为 Tank Level Excursions Last 30 Minutes 

8. 验证 Product = HC1500 的事件框架是否有注释图标。如果将光标悬停在注释

图标上方，将显示 Notification sent to 1 subscriber(s)。 

 

 

9. 验证 PI System Explorer 中是否显示上个练习中的备注和确认信息。 

10. 要在 PI System Explorer 中确认警示，请选择事件框架列表的一行或多行。从

上下文菜单中选择 Acknowledge… Acknowledge 列中的图标从 

Unacknowledged 变为 Acknowledged 。 
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9.6 添加联系人 

可以在 PSE 的导航器面板中的“联系人”部分中定义联系人。联系人会在通知消息被触

发时收到这些消息。此部分定义各种可以通过 Notifications 创建和使用的联系人对象

类型。 

9.6.1 联系人的 Active Directory (AD) 访问权限 

Notifications 通常从配置的域 AD 数据库获取联系人及其地址。这样一来，管理员在

使用 Notifications 之前，无需再花费大量时间去输入所有潜在的订阅者及其联系人的

信息。  

每个 AF 服务器都可提供用于指定域和联系人子文件夹的选项，以及访问 Active 

Directory 和检索联系人姓名所需的帐户。默认情况下，使用运行 AF 服务器应用程序

服务的帐户访问 Active Directory。可在 AF Server Properties 对话框中配置 AD 访问

权限（在导航器中选择 Contacts 后，转到 Tools > Active Directory Properties）。 

 

默认情况下，使用虚拟帐户  

NT SERVICE\AFService 安装 AF 服务器。但可以更改 AF 服务器服务帐户。如果 AF 

服务器的服务帐户没有读取 Active Directory 所需的权限，将不会在联系人列表中检索

任何联系人姓名。如果将 Active Directory 安全设置配置为允许 AF 服务器服务帐户读

取 Active Directory，这就是最简单的选项。 

在 Active Directory Domain Name 文本框中，输入将从中为 PI Notifications Service 

联系人检索联系人姓名的 Active Directory 域的完整 DNS 名称。 
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在 Active Directory Contact Sub-Folder 文本框中，输入包含此域中联系人列表的文件

夹的路径。在较大的 Active Directory 域中，可在子文件夹中组织联系人。使用子文件

夹可以更快地检索 Active Directory 联系人列表。 

9.6.2 搜索联系人 

因为 AD 数据库通常都非常大，所以只能通过搜索结果来获取联系人信息。要搜索联

系人，可单击“联系人”部分下方的  按钮，或者使用搜索字段。星号 (*) 可以

在该搜索中作为通配符使用。如果采用培训云环境 (TCE)，则搜索 student* 将返回所

有学员 AD 用户（student01、student02、student03、student04）。 
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9.6.3 指导活动 – 添加联系人信息 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概

念。您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会

提供指导。 

活动目标 

• 为通知创建新的联系人。 

问题描述 

对于 AD 中没有条目的学员，可一次输入一位自定义联系人。对于需要接收通知，但

是不在公司中的供应商或其他联系人而言，这很适用。自定义联系人适用于所有 AF 

数据库。 

方法 

在 PSE 中添加自定义联系人： 

1. 要创建自定义联系人，请从导航器面板中选择 Contacts。 

2. 从工具栏中选择 New > New Contact，并在联系人 Name 中输入您的姓名。 

3. 右键单击该联系人，并选择 New Delivery Endpoint 

4. 输入投递终端名称（例如 <your name> at Work）。在 Delivery Channel 下拉

列表中，选择 Email。 

填写您的工作电子邮件地址并检入更改。 

 

5. （可选）为家庭电子邮件地址输入第二个投递终端。 
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注意：在培训云环境 (TCE) 中，pischool.int AD 中实际上只有部分电子邮件地址可用于发送电子

邮件。请参阅本书结尾的“练习”部分中的相应信息。  

9.6.4 Notifications 组 

Notifications 组是未排序的投递终端集合，其中包括 Active Directory 接收人。如果将

通知配置为向 Notifications 组发送消息，则会同时将消息发送给该组的所有成员。  

9.6.5 Notifications 逐级呈报小组 

逐级呈报小组是延迟的投递组，只有在过了称为逐级呈报期的特定时间段并且未满足

确认要求的情况下，才会收到关于通知的警示。确认功能会在后面的章节中讨论，但

是此功能可以通知 Notifications 服务器联系人已确认警示。 

通知警示发送到列表中的第一个联系人。如果未在指定时间内确认通知，则按顺序向

逐级呈报小组的剩余成员发送通知消息，直到确认通知实例。 

构建逐级呈报小组与构建组非常类似，因此它们都可以包含在订阅者的通知区域中。

请注意，如果将逐级呈报小组添加到不需要确认的通知中，那么他们永远不会收到警

示。  

9.6.6 将联系人订阅到通知 

要保留通知的订阅者，请导航到选定元素或选定元素模板的 Notification Rules 选项

卡，然后单击 Subscriptions 窗格中的 View/Edit Subscriptions。 

要向现有通知添加联系人、终端或组，请将其拖放进 Subscriptions 列表。要删除订

阅，请选择订阅所在的行，然后单击顶部的 Unsubscribe 图标。 

9.6.7 动态电子邮件交付终端（从 AF 2017 R2 起） 

您可以将电子邮件投递终端配置为属性的值。此功能提供了更多的灵活性，这种情况

下，通知电子邮件可以发送到不同收件人而不对通知规则模板进行更改。 

  



通知重要事件 

 

第 311 页 

 

9.6.8 讲师指导活动 - 使用动态电子邮件交付终端（可选） 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

练习目标 

• 创建分析以根据当前时间定义电子邮件地址。 

• 切换通知电子邮件的收件人  

问题描述 

为了平衡负责处理油罐液位偏移的人员的工作量，应采用以下规则，根据实际时钟时

间将通知电子邮件发送给不同的电子邮件地址： 

 

 

注意：上述规则可能不是典型的真实情况，但之所以选择这些规则是为了在课堂培训期间方便检

出。 
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方法 

 

创建分析，以根据时间设置电子邮件地址 

 

1. 打开 PI System Explorer 并导航至 Tank 元素模板。创建新分析 Email 

Address Setting。 

映射输出时，请选择该选项以保存输出历史记录。将值类型设置为字符串。调

度时选择 30 分钟的时间段，没有偏移量。 
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提示： 

• '..\|SiteID’ 是指油罐（即工厂）的父元素中的属性 SiteID 

• 按 Shift-Enter 可换行。 

• 请勿用空格表示变量名称。 

• 要检查分析，请选择某个示例元素并运行 Preview Results。 

• 要获得通知电子邮件地址的初始值（仅每 30 分钟计算一次），请切换

到 Management 选项卡并在最后一小时执行回填。 
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创建引用“通知电子邮件地址”属性的动态终端并创建相关订阅。  

 

1. 在导航器中选择 Library，然后打开 Tank 元素模板的 Notification Rule 

Templates。 

2. 单击蓝色的 View/Edit Subscriptions 链接 

3. 在 Contacts 部分展开 Dynamic Endpoints，并从属性列表的下拉菜单中选择 

Notification Email Address。在 Endpoint Name 中输入 Dynamic 

Notification Email Address。单击 Create 按钮。 

 

 

注意：可以忽略警告 

“Value must be a valid email address at delivery time.”  
 

4. 选择现有订阅所在的行，然后单击顶部的取消订阅  图标。 

5. 在 Contacts 部分展开 Dynamic Endpoints，并将 Dynamic Notification 

Email Address 拖曳到 Subscriptions 列表。单击 Configuration 列中的下拉图

标，并选择 Tank Level Excursion - Email with Table。 

6. 单击 OK 以退出 View/Edit Subscriptions 对话框。 

7. 检入更改。 

8. 验证是否按预期执行电子邮件交付。（需要让系统保持运行一段时间）。  
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9.6.9 讲师指导活动 –按逐级呈报顺序发送通知警示（可选） 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

练习目标 

• 将多个联系人分配给逐级呈报小组 

• 了解并应用适用于逐级呈报小组的选项。 

• 了解适用于逐级呈报小组的通知顺序。 

问题描述 

您想要变更策略，即一旦超过液位限值即告知组织内的人员。为了避开过渡期，您希

望在重新配置系统时暂停过渡期内的通知电子邮件。 

当油罐液位超过限值时，两名操作人员（即油罐操作员和安全工程师）可处理这种情

况。应先通知油罐操作员。如果他在 5 分钟内没有采取任何措施，则应通知安全工程

师。请不要再向 student01 发送电子邮件。 

使用以下电子邮件地址： 

罐操作员： student02@pischool.int 

安全工程师： student03@pischool.int 

请注意，如果您在本地语言环境中执行此练习，则不支持与 student02 和 student03 对应的本地

语言帐户的电子邮件地址。  

方法 

1. 打开 PI System Explorer，并在导航器中选择 Management。选择 Notification 

Rules 类型。 
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注意：此处显示的状态仅基于通知规则配置。状态不提供关于通知是在运行中还是出现错误的信

息。 

2. 启用标题行中的复选框，以选择十 (10) 个罐的所有通知，然后单击 Disable 

selected notification rules。 

提示：通过选择包含规则的行的任意组合，可以启动或停止选定规则。 

3. 在导航器中选择 Contacts。 

4. 右键单击 Escalation Teams 文件夹并选择 New Escalation Team，以新建名

为 Tank Personnel Escalation Team 的逐级呈报小组。 

5. 在右侧的 Contacts 窗口中，选择 Contacts > New Search… 搜索名称= 

student*  的联系人 

6. 展开 student02 并将电子邮件地址 (student02 - Email) 拖动到呈报列表区域

（开始时为空）。为 student03 重复执行相同的步骤。选择 5 分钟的逐级呈报

周期。如果警示未被确认，请勿重复逐级呈报顺序。  
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7. 在导航器中选择 Library，然后打开 Tank 元素模板的 Notification Rule 

Templates。 

8. 单击蓝色的 View/Edit Subscriptions 链接 

9. 在 Contacts 部分展开 Escalation Teams，并将 Tank Personnel Escalation 

Team 拖曳到 Subscriptions 列表。单击小组名称的下拉图标以展开小组成

员。为两位成员选择 Tank Level Excursion - Email with Table。 

10. 选择其他订阅所在的行，然后单击顶部的取消订阅  图标。 

11. 单击 OK 以退出 View/Edit Subscriptions 对话框。 

12. 检入更改。 

13. 在导航器中选择 Management。采用和停止通知前同样的方式启动通知。 
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针对不同逐级呈报选项设置的问题 

假设您已设置为在未确认的情况下重复逐级呈报三 (3) 次。如果操作员没有采取任何

措施且违规超过一小时，将发出多少封电子邮件？何时发送最后一封电子邮件？ 

答案：发送了 _____ 封电子邮件，最后一封电子邮件是在问题开始出现后 ______ 分

钟发送的。 

 

了解逐级呈报顺序（可选） 

一段运行时间（> 30 分钟）后，Tank01 和 Tank02 将出现多次超过新液位限值的情

况。  

注意：罐液位的模拟再次重复相同的模式。循环时间取决于具体油罐。Tank01：10 分钟，

Tank02：30 分钟，Tank03…Tank10：> 几小时。  

1. 在导航器中选择事件框架。 

2. 我们已在先前的活动中创建名为 Tank Level Excursions Last 30 Minutes 的

事件框架搜索。 

使用此搜索列出最近的事件框架（如果之前的活动仍然显示，则单击 PI 

System Explorer 工具栏中的刷新按钮）。 

3. 为 Tank02 的下限违规选择一个已完成的事件框架（结束时间不为空）。从上

下文菜单中选择 Annotate…。Annotations 将列出电子邮件顺序。 

 

 

 

提示：单击齿轮图标  可显示包含描述信息的列，以获取关于已发送电子邮件的更多详细信

息。  

4. 为 Tank01 选择一个已完成的事件框架。您能否说明为何没有发送任何逐级呈

报？ 
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9.7 通过 Web 服务投递通知 

9.7.1 Web 服务 

通过 Web 服务投递通道，Notifications 可以通过调用 Web 服务的某个方法来与其联

系以及向其提供信息。要使用该投递通道，必须可以在 Web 服务器上使用 Web 服

务。 

关于 Web 服务 

可以在网络上通过 Web 服务在两个电子设备之间通信。在大多数情况下，该服务托管在 Web 服

务器上，并且为其客户端提供方法。这些方法通常会等待来自一个客户端的传入信息，然后压缩

数据，并且最终将数据返回相同的客户端，或者将该信息传递给另一个客户端。 

有很多商用的 Web 服务可供使用，而且很多开发环境提供了模板和其他工具，可用于

开发自定义 Web 服务。http://www.webservicex.net/ 网站提供了 Global Weather 

Web 服务之类的样本，有助于了解 Web 服务。  

在 PSE 中通过导航器面板的 Contacts 部分新建 WebService 类型的 Delivery 

Endpoint 时，会通过 Notifications 完成向 Web 服务发送信息所需的配置。  

9.7.2 Web 服务示例：工作订单生成器 

这是一个用作自动工作订单生成器的自定义 Web 服务。假定设备的某个部分需要维护

时会触发通知。通过 Web 服务，通知会将所有所需的信息传递给维护系统，这样就可

以生成工作订单。在本次培训中，将名为“WorkOrderGenerator”的 SQL Server 数据

库用作维护系统。该数据库托管在本地 SQL Server 实例中。应该可以在以下 URL 中

使用 Web 服务： 

http://localhost:85/WorkOrderGenerator2013/Service1.asmx 

 

http://www.webservicex.net/
http://localhost:85/WorkOrderGenerator2013/Service1.asmx
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9.7.3 讲师指导活动 – 验证 Web 服务功能（可选） 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领域的学习效

果。您的讲师会向您介绍相关说明，并在活动期间提供必要的指导。  

练习目标 

• 了解工作订单生成器的示例 Web 服务的功能 

方法 

通过 NewWorkOrder 方法，用户或应用程序只需要提供以下信息，就可以在 SQL 

Server 数据库中创建新的工作订单条目：设备名称、故障类型，以及要采取的操作。  

在 Web 服务的网页中，单击 NewWorkOrder 方法，在 EquipmentName、

FailureType 和 ActionToTake 字段中输入内容，然后单击 Invoke 按钮。如果显示以

下内容，则表示已成功生成工作订单。再次请注意，Web 服务不适合用于用户交互。 

<?xml version=”1.0” encoding=”UTF-8”?> 
<int xmlns=”http://localhost/”>1</int> 

可以继续操作并查询 WorkOrderGenerator SQL Server 数据库，以确认是否已在系统

中成功创建新的工作订单。 

 

1. 打开 Internet Explorer 并转到： 

http://localhost:85/WorkOrderGenerator2013/service1.asmx 

（收藏夹下还有一个链接） 

2. 单击 New Work Order。输入参数： 

http://localhost:85/WorkOrderGenerator2013/service1.asmx
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a. 在 EquipmentName 中输入 Reactor1 

b. 在 FailureType 中输入 Pressure Too High 

c. 在 ActionToTake 中输入 Check Pressure Relief Valve 

3. 单击 Invoke。记录返回的工作订单号。 

4. 重新打开该页面（再次单击收藏夹链接），并选择 

GetEquipmentNameFromWorkOrder。输入上一步的工作订单号并提交。 

5. 打开 SQL Server Management Studio 并连接到 PISRV01。  

6. 展开  

Databases > WorkOrderGenerator > Tables > dbo。WorkOrderGen 表。 

7. 在鼠标右键上下文菜单中，执行 Select Top 1000 Rows。 

8. 找到最后一个条目，以验证是否添加了新的工作订单条目。 

9.7.4 讲师指导活动 – 创建 WebService 投递终端（可选） 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领域的学习效

果。您的讲师会向您介绍相关说明，并在活动期间提供必要的指导。  

练习目标 

• 熟悉工作订单生成器的 Web 服务投递终端的创建。 

方法 

要在 PSE 中添加自定义投递终端，请执行以下操作： 

1. 从导航器面板中选择 Contacts。 

2. 从 Delivery Endpoints 文件夹的鼠标右键上下文菜单中选择 New Delivery 

Endpoint。输入名称 Work Order 以及描述，并选择 Web 服务投递通道。签

入。 

3. 输入 Web 服务地址  

http://localhost:85/WorkOrderGenerator2013/service1.asmx 

并单击 Get Web Services 

4. 从 Web 方法下的下拉选项中选择 NewWorkOrder。 

http://localhost:85/WorkOrderGenerator2013/service1.asmx
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5. 检入。 

9.7.5 讲师指导活动 – 创建自动工作订单（可选） 

 

本活动为单人或小组活动，旨在最大程度地强化您在特定主题领域的学习效

果。您的讲师会向您介绍相关说明，并在活动期间提供必要的指导。  

练习目标 

• 设置不同类型的通知订阅者。 

• 演示 Notifications 如何将 PI System 信息提供给工作订单系统。 

问题描述 

除了通过发送电子邮件提醒用户，您还希望在工作订单数据库中为关键的油罐液位事

件创建新条目。  

方法 

要在 PSE 中添加其他投递终端的订阅，请执行以下操作： 

1. 从导航器面板中选择 Library，然后导航至油罐元素模板。打开 Notification 

Rule Templates 选项卡。 

2. 在 Subscriptions 部分中单击蓝色的 View/Edit Subscriptions 链接。 
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3. 在 Contacts 部分展开 Delivery Endpoints，并将 Work Order 拖曳到 

Subscriptions 列表。系统通知您必须配置 Web 服务：  

4. 单击扳手图标并使用拖放功能来设置三 (3) 种 Web 服务方法的参数：  

a. 在 EquipmentName 中，设置 Tank name:Value At Start Time 

（从元素模板属性：Tank） 

b. 在 FailureType 中，输入 Event Frame:Name 

（从元素模板属性） 

c. 在 ActionToTake 中，输入 Level Excursion:Value At Start Time 

（从元素模板属性：Tank level Excursion） 

 

 

5. 单击 OK。 

6. 检入更改。 

 

要验证工作订单条目，请执行以下操作：  

运行一段时间后，Tank01 和 Tank02 将出现多次超过新液位限值的情况。  

1. 在导航器中选择事件框架。 

2. 列出名为 Tank Level Excursions Last 30 Minutes 的搜索的事件框架（如果

之前的活动仍然显示，则单击 PI System Explorer 工具栏中的刷新按钮） 

3. 选择新的事件框架。从上下文菜单中选择 Annotate…。Annotations 将列出已

发送给两 (2) 名订阅者的通知。 

 

4. 打开 SQL Server Management Studio 并连接到 PISRV01 并再次访问 

dbo.WorkOrderGen 表内容。验证是否添加了新的工作订单条目。 
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注意：工作订单数据库接受不超过 50 个字符的事件框架名称。如果名称过长，则表中不显示任

何条目。 
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9.7.6 单独或分组练习 – ABC 矿业公司通知（可选） 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题领域的学习

效果。您的讲师会向您介绍相关说明，并在练习期间提供必要的指导。  

练习目标 

• 创建新分析以检测胎压问题（实施到常规卡车模板中） 

• 创建新分析以检测燃料箱液位下限问题（实施到常规卡车模板） 

• 区分卡车问题不同的根本原因 

• 创建相应的通知规则（应用到常规卡车模板）  

• 创建自定义格式，以提供关于通知电子邮件中的问题的详细信息 

问题描述 

ABC 矿业公司希望设置两类警示，这些警示会在稍后配置，以发送电子邮件至值班经

理 (student01@pischool.int)。 

在以下情况下需要向 ABC 矿业公司管理层发出警示： 

• 胎压低于或高于标称压力值超过 3 Psi 已逾 5 分钟。此问题的严重性为“关

键”。 

• 如果任意车辆的燃料箱所剩的燃料不足 50%，则需要注意安排这些车辆返回加

油站。 

此问题的严重性为“严重”。 

方法 

要构建可以应用到所有类型的车辆分析和通知规则模板，目标元素模板必须可用于所

有车辆（本示例中是基本模板常规卡车）。 

1. 使用以下属性创建新的事件框架模板卡车操作问题：实际胎压、燃料箱液位和

问题根本原因。 

2. 创建新的分析模板胎压监测。 

3. 创建新的分析模板燃料箱液位监测。 
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4. 创建新的通知规则模板 Truck Problem Notification，并且只要出现基于 

Truck Operation Issue 模板的新事件框架，即使用 Event Frame Search 选

项生成通知。使 student01 订阅它。 
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5. 复制全局默认电子邮件格式并更改新格式卡车问题电子邮件，以便发送采用下

列格式的电子邮件： 

 

 

 

使用以下有关设置电子邮件字段的信息： 

 

 

6. 为发送给 student01 的电子邮件分配卡车问题电子邮件格式。 

7. 检入。 
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10. AF 最佳做法 

以下建议根据现有的 AF 安装经验提供了有关如何最佳设置 AF 资产结构的一些指

导。 

请注意，在现实生活中无法遵循所有这些建议！ 

 

• 所有元素都应基于模板 

即便该模板一开始没有任何属性 

更容易维护 

• 同一级别的所有元素都应该是相同的类型 

企业是第一级，工厂是第二级，区域是第三级等。 

更容易使用来自子元素的相对引用 

• 不要只考虑自下而上的方法 

尝试实现精心设计的结构，计划 AF 模型的实用性 

• 元素属性和分析的类别 

整理大量属性/元素 

搜索元素和属性的快速方式 

• 始终明确设置度量单位 

PI 标记点属性：设置 tag 的源单位 

公式：设置所有变量和结果的单位 

分析：使用 Convert() 函数 

避免使用默认值 
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• 使用继承的模板 

允许灵活性，但保持标准化 
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• 创建特定于用户的不同视图 

使用元素引用 

 

 

 

 

 

 

• 使用枚举 

限制可在 

属性中输入的选择 

 

 

 

• 使用属性的层次结构 

不同级别的组详细信息或聚合 

 

 

 

 

• 使用所有数据引用 

表查找包含和适用于字符串生成器的许多选项 

 

• 将关系数据保存在关系数据库中 

将 AF 表链接到结果和视图 

使用缓存和参数  
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https://pisquare.osisoft.com/community/all-things-pi/af-library 

 

为提升您的 AF 技能，请访问 PI Square 中的 AF 社区库！  

社区库里有大量的提示和技巧、显示、层次结构和模板。了解其他人的工作内容、寻

求反馈或协作，并开始探索如何使用 PI AF 解决您的业务问题。 

要了解有关 AF 最佳实践的更多信息，请浏览 AF 社区库中提供的基于资产的示例工

具包！基于资产的 PI Example Kits 旨在帮助您了解如何将基于资产的 PI 应用于行业

特定的常见业务目标。 
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11. 最终练习 

11.1 TxLake Windfarm：对您的资产建模 

11.1.1 讲师指导活动 – 了解风电场模拟 

 

在本节课中，您将执行一项学习活动，探索本章或本部分中展示的不同概念。

您可以观看讲师执行的操作，也可以同时执行相同的步骤。您的讲师会提供指

导。 

活动目标 

• 浏览模拟风电场运行情况的 PI 标记点 

• 浏览 Excel 电子表格中提供的信息 

• 浏览 SQL 数据库表格中提供的信息 

 

PI 标记点 

1. 打开 PSE 中的 TXLake Windfarm AF 数据库，在导航器中选择 Elements。

数据库为空。 

2. 在 PSE 菜单中，选择 Search > Tag Search。搜索名称模式为 

WPU_TXLKE001* 的 Tag，从第一个风力涡轮机中获得标记点。结果：列出

六个 Tag，所有 Tag 均具有最新值。记录工程单位以便日后参考。 

 

Tag 名称 AF 属性名称（已建议） 单位 

WPU_TXLKE001.GenWatts 功率  

WPU_TXLKE001.RotorRPM 转子速度  

WPU_TXLKE001.WindDir 风向  

WPU_TXLKE001.WindSpd 风速  
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WPU_TXLKE001.YawMotorAmps 偏航电机安培数  

WPU_TXLKE001.YawPos 偏航位置  

3. 从另一个风力涡轮机中搜索 Tag。 

注意：可以在 C:\Class\Exercises\04_TxLake Wind Farm\TxLakeWindFarm_Tags – 

2014.xlsx 中找到所有 Tag 的汇总以供您参考。 

风力涡轮机型号信息（可从 Excel 电子表格获取） 

4. 可以在以下文件中找到风力涡轮机型号： 

C:\Class\Exercises\04_TxLake Wind\FarmTxLake\WindFarm_WPUModels – 
2014.xlsx 

 

要将此信息存入内部 AF 表格，有两个选项： 

• 按步骤从 Excel 电子表格中导入数据。请参阅下面的“答案”一章中的“答案：如

何将数据从 Excel 文件导入到 AF 表格”。 

• 手动创建表格结构，然后将电子表格中的内容复制粘贴到 AF 表格 

a) 在导航器中选择 Library，创建新表格，名称：WPU Models 

Specifications 

b) 选择 Define Table 选项卡并按如下所示定义表格结构： 

 

c) 复制 (Ctrl-C) Excel 电子表格中包含数据的单元格（不包括标题行），

在 AF 表格中选择一行并粘贴 (Ctrl-V) 内容。 
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5. 可以在以下文件中找到单个风力涡轮机： 

C:\Class\Exercises\04_TxLake Wind\FarmTxLake\ TxLakeWindFarm_WPUs - 
2014.xlsx 

安装和维护日期（可在 SQL Server 表中查看） 

6. 打开 SQL Server Management Studio 2014，连接到 SQL Server PISRV01。 

7. 展开数据库，展开 WindFarmMaint。 

8. 在 dbo.TxLakeMaint 表格的上下文菜单中，选择前 100 行。每个涡轮机有一行。找到

具有安装日期和上次维护日期的列。在接下来的活动中，我们会将该表格中的信息链

接到 AF。 
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11.1.2 单独或分组练习：在 AF 中对风电场建模 

 

本练习为单人或小组练习，其目的是最大程度强化您在特定主题

领域的学习效果。您的讲师会向您介绍相关说明，并在练习期间

提供必要的指导。  

练习目标 

• 设计完整的 AF 数据库。 

• 选择最佳的工具来有效地执行所需的任务。 

• 了解从 Excel 电子表格导入数据和链接 Microsoft SQL Server 表之间的差别。 

• 了解 AF 属性类别。 

 

问题描述 

您的风力农场中有 50 个风力涡轮机，并且已经为它们构建 Data Archive Tag。工程

师们觉得各种电子表格中的数据值得关注。您在 Microsoft SQL Server 中也保存了维

护数据。如今需要使用通用的模板将所有数据集成到 AF 中。 

方法 

主要使用 PI Builder 工具来创建资产数据库。很多工作都在 Microsoft Excel 中完成。 

这是为本次练习预配置的电子表格：TxLakeWindFarm_WPUs.xlsx 

本练习中使用的 Data Archive tag 已经创建。 
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对资产建模 

1. 选择 TxLake Windfarm AF 数据库。它将用于表示风电场。 

2. 应创建一个顶级元素，在这个元素下您将会创建所有风力涡轮机（也就是风力

农场）。 

 

 

3. 配置风力涡轮机模板并基于该模板为第一台风力涡轮机创建一个元素。 

 

 

 

4. 创建两个 AF 表：WPU Models Specifications（从 

TxLakeWindFarm_WPUModels 电子表格获取关于四个风力涡轮机模型的信

息）和 WPUs Identification（从 TxLakeWindFarm_WPUs 电子表格获取关

于五十个涡轮机的信息）。这两个文件均位于 C:\Class\Exercises\04_TxLake 

Wind Farm 文件夹中 

提示：可以在练习解决方案部分找到关于如何将数据从 Excel 文件导入到 AF 表的信息。 

5. 配置必要的属性以对两个表中可用的数据进行建模。 

6. 创建并配置必要的属性模板，以便对 Data Archive Tag 

(TxLakeWindFarm_Tags.xlsx) 中的实时数据进行建模。 

7. 打开 TxLakeWindFarm_WPUs.xlsx 电子表格，查看该风力农场有多少个涡轮

机，然后使用 PI Builder 在空白电子表格中创建 AF 元素。按照相同的模板，

风力涡轮机命名为 WPU_TxLKE001，以此类推。 

8. 打开 PSE 来验证是否已创建风力涡轮机。 

file:///C:/Class/Exercises/04_TxLake%20Wind%20Farm
file:///C:/Class/Exercises/04_TxLake%20Wind%20Farm
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提示：因为 Tag 命名方法包括风力涡轮机名称，所以可以在模板中使用替代参数来填充 PI 标记

点数据引用。 
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导入 SQL Server 数据 

9. 创建新的 AF 表格，并将其链接到风力农场维

护系统（Microsoft SQL Server 数据库：

WindFarmMaint） 

· 在 Table Properties 下，选择 Link。在 

Connection 下拉菜单中，选择 <Build> 

· 使用 Microsoft OLE DB Provider for SQL 

Server 驱动程序。 

· 输入在本次练习开头时记录的 Microsoft SQL 

Server 实例名称。 

· 使用 Windows 身份验证。 

· 输入在本次练习开头时记录的 Microsoft SQL 

数据库名称 

 
 

 
 
 
 
 
 
 
 
 

· 链接到 TxLakeMaint 表格 (SELECT * 

FROM TxLakeMaint)。 

 

 

 

 

10. 创建和配置必要的属性模板，以便对从 Microsoft SQL Server 关系数据库提供的数据进行

建模。 

11. 创建属性类别，以对属性进行逻辑分组。 

 

关于属性类别 



最终练习 

 

第 341 页 

 

类别可用于各种 AF 对象，例如属性。可使用属性类别对属性进行统一分组，这样就可以更容易

地对 AF 模型的属性进行查看、搜索或执行聚合。在 PI ProcessBook 或 PI Datalink 之类的客户

端应用程序中，类别并未广泛使用。但是特定的分析（例如汇总计算）会利用该功能。 
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添加分析 

12. 添加属性以显示上一个小时的平均发电功率 (kW)。这是最近一小时瞬时发电量属性的移

动平均 (.GenWatts Tag)。不需要存档此计算的结果。 

13. 添加属性，以使用以下公式来显示 WPU 效率或产出 (%)。应该对该计算的结果进行历史

记录，且应每分钟执行计算。回填前 10 个风力涡轮机的 1 小时的数据。 

功率 / 额定功率 * 100 

14. 使用汇总分析计算为整个风力农场生成的总功率，单位为兆瓦。  

 

跟踪重要事件 

15. Lake 风力农场的工程师希望追踪高速的风，了解阵风（速度超过 90 mph 的风）的持续

时间对于性能分析很重要。另外，工程师需要知道在阵风其间生成的平均转子转速和最大

功率。回填所有风力涡轮机的上一个小时的事件。 

 

可视化数据（可选） 

16. 完成 PI ProcessBook 显示 TxLakeWindFarm_WPUStatus.pdi 并且使其与元素相关，以

监控 TxLake 风力农场的风力涡轮机。 

17. 使用 PI Vision 可视化高风速事件。 
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12. 练习答案部分 

12.1 培训云环境 (TCE) 

包含 Microsoft Azure 虚拟计算机的云中有一个专门的设置，可使用它来完成本课堂的

练习。该设置由以下两个计算机组成：PIDC.PISCHOOL.INT（域控制器）和 

PISRV01.PISCHOOL.INT（应用程序服务器）。本培训在 PISRV01 上执行。  

本培训可用的 Windows 域帐户有：student01、student02、student03 和 

student04。在本地化环境下，必须使用以下帐户： 

德语：de-student01、de-student02、de-student03、de-student04 

西班牙语：es-student01、es-student02、es-student03、es-student04 

法语：fr-student01、fr-student02、fr-student03、fr-student04 

日语：ja-student01、ja-student02、ja-student03、ja-student04 

韩语：ko-student01、ko-student02、ko-student03、ko-student04 

葡萄牙语：pt-student01、pt-student02、pt-student03、pt-student04 

俄语：ru-student01、ru-student02、ru-student03、ru-student04 

中文：zh-student01、zh-student02、zh-student03、zh-student04 

交换服务器经过配置，支持以下学员帐户：student01@pischool.int、

student02@pischool.int、student03@pischool.int 和 notifications@pischool.int。 
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12.2 练习答案：应用表达式分析语法  

问题 解决方案 提示 

获得 SensorX 属性的

十分钟“滚动”平均值 

TagAvg(‘SensorX’, ‘*-10m’, ‘*’) TagAvg() 函数获取 Tag 在给

定时间段内的平均值。 

获得过去 24 小时的 

SensorY 属性的时间加

权总计，但仅在将计算

中所使用的值至少 80% 

视为“良好”时计算。 

IF  
PCTGood(‘SensorY’, ‘*-24h’, 
‘*’)>=80 

THEN TagTot(‘SensorY ‘, ‘*-24h’, 
‘*’) 

ELSE NoOutput() 

或者 

TagTot(‘SensorY ‘, ‘*-24h’, ‘*’, 80) 
 

 

If… Then… Else… 语句可以

在 PE 语法中使用。 

PCTGood() 函数获取 Tag 的

“good”值的百分比。 

TagTot() 函数获取 Tag 在给定

时间段内的时间加权总计。 

过去四天中 Mode 属性

为“Manual”的时间长

度。 

TimeEQ(‘Mode’,’t-4d’,’t’,”Manual”) TimeEQ() 

返回的时间量以秒为单位。 

当 Level 属性大于或等

于 90 时显示

“Overload”，当介于 10 

和 90 之间时显示

“Normal”（不包括边界

值），当低于或等于 10 

时显示“Empty”。 

If ‘SensorX’ >= 90 then 
“Overload” else if ‘SensorX’ <= 10 
then “Empty” else “Normal” 

If… Then… Else… 要求存在 

ELSE 子句。 
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12.3 练习答案：ABC 矿用卡车  

分步解决方案 

1. 从位于 C:\Class\Exercises\03_ABCMiningCompany（或者讲师指定的位置）

的文件 ABCMiningCompany_Tags.xlsx 创建练习所需的 Tag。 

（使用培训云环境 (TCE) 时则不需要） 

 

2. 创建两个表格，卡车模型规格和卡车识别号。 

如果不想手动输入，也可以从文件 

C:\Class\Exercises\03_ABCMiningCompany\Truck Identification.xml 和 

C:\Class\Exercises\03_ABCMiningCompany\Truck Model Specifications.xml 导入

表格。要导入表格，请选择 File > Import from file。在 Library > Tables 下验

证结果： 
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3. 创建基本模板。在 PSE 中，选择 Library > Templates > Element Templates > 

New Template。 

 

4. 将模板命名为“General Truck”。 
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5. 选择 Attribute Template 选项卡。 
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6. 右键单击白色区域，然后选择 New Attribute Template 或在菜单中选择 New 

Attribute Template 按钮。 

 或者单击  

7. 为所有卡车创建标准属性。 
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属性 类型 数据引用 UOM 设置 

Actual Oil Level Double PI 标记点 升 %Element%.OilLvl 

Actual Tire 
Pressure 

Double PI 标记点 psi %Element%.TireP 

Gas Tank Capacity Double 表查找 美制加

仑 

SELECT [Gas Tank 
Capacity] FROM 
[Truck Model 
Specifications] 
WHERE Model = 
@Model 

Gas Tank Level Double PI 标记点 美制加

仑 

%Element%.GasLvl 

License Plate String 表查找  SELECT [License 
Plate] FROM [Truck 
Identification] 
WHERE ID = 
‘%Element%’ 

Model String 表查找  SELECT Model 
FROM [Truck 
Identification] 
WHERE ID = 
‘%Element%’ 

Nominal Oil Level Double 表查找 升 SELECT [Nominal 
Oil Level] FROM 
[Truck Model 
Specifications] 
WHERE Model = 
@Model 

Nominal Tire 
Pressure 

Double 表查找 psi SELECT [Nominal 
Tire Pressure] 
FROM [Truck 
Model 
Specifications] 
WHERE Model = 
@Model 
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Tripmeter Double PI 标记点 英里 %Element%.Trip 

8. 使用 GPS 数据为卡车模型创建派生模板。 

 

9. “Truck with GPS Data”模板由“General Truck”基本模板派生而来。 

 

10. 将“GPS Latitude”和“GPS Longitude”的属性模板添加到“Truck with GPS Data”

模板： 

 

属性 类型 数据引用 UOM 设置 

GPS Latitude Double PI 标记点 seconds %Element%.GPSLat 

GPS Longitude Double PI 标记点 seconds %Element%.GPSLat 
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11. 签入并刷新“浏览”窗口，如果在左侧的树形结构中右键单击 Elements 

Template，则可以按照模板继承来排列模板。可以通过这种方法来查看模板之

间的关系。默认为按名称排列。 

 

 

12. 为 ABC 矿业当前操作的八辆 (8) 卡车创建单独的元素。根据含有车辆列表的

初始表格来命名这些元素。 
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13. 验证在代表适当的模型每一个元素中是否已包含所有预计的字段。下图中显示

了卡车 SP1，以供参考： 

 

14. 验证是否已根据 PI 标记点更新所有属性。例如，“Gas Tank Level”基

于 %Element%.GasLvl，但是 Tag 应该作为 SP1.GasLvl 列出，并且应该用适

当的“元素 ID”替换 %Element% 

 

15. 添加新的 UOM 类 Fuel Efficiency，并且将度量单位 MPG 用作其标准单位。 
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16. 将 Fuel Efficiency 计算添加到基本模板。如提示中所述，可以使用“燃料箱液

位”、“单程里程计”和“燃料箱容量”来计算“燃料效率”。将 MPG 指定为 Default 

UOM。 

 

 

17. 将另一个度量单位 Liter per 100 km（缩写：l/100km）添加到 UOM 类 Fuel 

Efficiency。 

按照如下所示输入公式： 
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18. 将 Fuel Efficiency (European Units) 添加为 Fuel Efficiency 的子属性。分配 L 

per 100 km 作为默认 UOM。使用 Formula Data Reference，并且引用 Fuel 

Efficiency。将 Result UOM 设置为 MPG: 

 

 

 

19. 将此单位添加到基本模板，签入模板，然后验证元素是否已添加 Fuel 

Efficiency 属性。 
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12.4 答案：如何将数据从 Excel 文件导入到 AF 表  

以下步骤介绍了如何从 Excel 文件（在本例中为 

TXLakeWindFarm_WPUModels.xlsx，位于 c:\class\Exercises\04_TxLake Wind 

Farm 文件夹）导入数据 
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分步解答（64 位 PI System Explorer） 

在 PI System Explorer 中，导航到 AF 表或按照创建 AF 表中的说明创建表。 

1. 在 Library 窗格中，展开 Tables 节点，然后选择 New Table。 

此表的详细信息将在右侧窗格中显示。  

 

2. 单击 Import。 

即会打开相应的窗口。 

 

3. 单击 Build。 

即会打开 Data Link Properties窗口。 

  

4. 在 Provider 选项卡上，根据您所使用的 Microsoft Office 版本选择提供程序，

然后单击 Next. 。 

 

Office 2007 及更高版本：选择 Microsoft Office 12.0 Access Database 

Engine OLE DB Provider。  

注意：虽然我们具有 Excel 2016 (16.0.4266.1001)，但不要选择 Microsoft Office 16.0 

Access Database Engine OLE DB Provider 

javascript:CVPortal.components.lcContent.loadDoc(null,%20%7b%20docid:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9',%20filename:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9.xml'%20%7d);
javascript:CVPortal.components.lcContent.loadDoc(null,%20%7b%20docid:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9',%20filename:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9.xml'%20%7d);
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5. 在 Connection 选项卡上，指定以下内容，然后单击 OK。 

 

数据源 

工作簿的位置和文件名： 

c:\class\Exercises\04_TxLake Wind Farm\TXLakeWindFarm_WPUModels - 
2014.xlsx 
 

用户名 

已获得数据库或工作簿读取权限的用户的登录凭证。保留 Admin，密码空白。 

 

6. 在 Access permissions列表的 Advanced 选项卡上，选择 Share Deny 

None。 

 

7. 在 All 选项卡上，选择 Extended Properties 值，然后单击 Edit Value。 

 

Edit Property Value 窗口将打开。输入：Excel 12.0 

 

8. 要验证电子表格是否可访问，请返回 Connection 选项卡，然后单击 Test 

Connection。  

9. 如果设置有效，则会显示 Test connection succeeded 消息。 

 

要关闭此窗口并返回 PI System Explorer，请单击 OK。  

 

10. 要定义从电子表格返回的数据，请在 Query 字段中输入 SQL 查询。要关闭此

窗口，单击 OK。 

 

在查询行中输入：SELECT * FROM [Models$] 

 

11. 要查看结果数据，请检查 Table 选项卡。如果正确指定了查询，该选项卡就会

包含显示结果的表。  

 

12. 要保存您的更改，请右键单击表节点，并选择 Check In。  

 
 

分步解答（32 位 PI System Explorer） 
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1. 在 MS Excel 中打开 .xlsx 文件并另存为 Excel 97-2003 工作簿 (.xls)。  

 

2. 按照与上面相同的步骤操作。 

 

在 Provider 中，选择 Microsoft Jet 4.0 OLE DB Provider 

对于 Excel 97 – 2003，在 Extended Properties 下，输入 Excel 8.0 
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13. 资源 

13.1 培训选项 

OSIsoft 培训页面位于 https://learning.osisoft.com。  
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13.1.1 讲师指导培训 

在我们的公共培训场所举行讲师指导培训 - 我们的传统项目 - 在 OSIsoft 培训中心通

过多种语言的课程学习 PI System！ 

 

在您所在地开展讲师指导培训 - 我们的个性化项目 - 根据您的时间安排，在您所在地

使用您拥有的数据学习定制课程并获得培训！ 

13.1.2 在线培训 

小型私人在线课程 - 我们最新的项目 - 根据您的日程表安排，在您的办公室或家中使

用您拥有的数据学习 PI System！有关更多信息，请转到 

https://pisquare.osisoft.com/community/Master-PI 

 

按需学习：YouTube 频道 - 随时随地学习 - 任意观看 YouTube 中的 1000 多个免费视

频，学习 PI system！您可以获得各种主题的播放列表，以帮助您了解培训主题。 

 

培训云环境 (TCE)：培训云环境可以让您访问云端的工作中的 PI System。它们由 

Microsoft Azure 虚拟计算机托管。这些环境通常与我们的一个在线课程相关，它们可

以帮助您完成课程材料动手实验。每个培训云环境都有不同数量的虚拟计算机，它们

的持续时间因与之相关的在线课程而异。  

 

13.2 OSIsoft 社区 

PI Square 是 OSIsoft 的社区。在此社区中，您可以联系  

• 其他 OSIsoft 员工和客户 

• PI 开发人员俱乐部，为您的开发项目提供帮助 
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13.3 技术支持 

建议您访问技术支持网站 http://techsupport.osisoft.com。 

 

 

 

该网站提供了诸多选择。  

• 可从下载中心下载您的公司有相关许可的任何内容。  

• 您可以查看 OSIsoft 路线图，了解最新版本和预告发布日期以及新版本或产品

的功能等信息。  

• 您可以登录并查看支持案例，包括目前未解决的案例以及先前已解决的案例。  

• 您还可以搜索知识库，尝试自行解决可能存在的任何问题。 

OSIsoft 技术支持的电话号码和电子邮件地址： 

• 电话：(01) 510 297-5828（美国）或搜索 

https://techsupport.osisoft.com/Contact-Us/ 查看您当地的联系电话。 

• 电子邮件：support@osisoft.com 

• 在联系技术支持之前，请收集以下信息： 

o 产品名称和版本号。  

o 使用 SMT 中的 Operation> Version 选项确定 PI 版本和版次号。  

http://techsupport.osisoft.com/
https://techsupport.osisoft.com/Contact-Us/
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o 如下所示获得计算机平台信息（CPU 类型、操作系统和版本号）： 

▪ 在 Windows 上，右键单击“我的电脑”图标并选择“属性”选项

卡。 

▪ 在 UNIX 中，键入 uname -a 

o 记下开始出现困难的时间并准备报告该时间的消息日志内容。消息日志

位于 SMT 中的 Operation> Message Log Viewer 选项中。  

o 您可能还需要提供适用时间范围的 PIPC 日志。此日志位于 

\\pipc\dat。 

13.4 其他问题 

关于许可的问题，如果您在美国，可以登录 http://www.osisoft.com > Contact Us > 

US Sales 查找销售人员。如果您在美国以外的国家/地区，可以登录 

http://www.osisoft.com > Contact Us > International Sales 查找销售人员。 

如果对现有支持问题有疑问，请致电 510 297-5828 联系技术支持部门或者访问 

http://techsupport.osisoft.com > My Support > My Calls。 

如有未解决的培训问题，请联系讲师或发送邮件至 learning@osisoft.com。 

对于所有其他问题，请发送邮件至 customerservice@osisoft.com 联系客户服务团

队。 

 

http://www.osisoft.com/
http://www.osisoft.com/
http://techsupport.osisoft.com/
mailto:learning@osisoft.com
mailto:customerservice@osisoft.com


本文档中使用的软件版本 

 

第 363 页 

 

14. 本文档中使用的软件版本 

以下列表介绍了此版本的课程中使用的软件版本。 

软件 版本 

Windows Server  2016 

Data Archive 服务器 2018 SP2 (3.4.425.1435) 

PI System Management Tools 2018 (3.6.3.30) 

AF Server 2018 SP2 (2.10.5.9050) 

PI System Explorer 2018 SP2 (2.10.5.9050) 

PI Analysis Service 2018 SP2 (2.10.5.9050) 

PI Notifications Service 2018 SP2 (2.10.5.9050) 

PI Vision 2017 R2 SP 1 (3.3.1.0) (*) 

PI Web API 2017 R2 SP1 (1.11.0.640) 

PI Datalink 2019 (5.5.0.0) 

PI ProcessBook 2015 R2 SP2 (3.6.2.271) 

Microsoft Office（64 位） 2016 

Microsoft SQL Server（64 位） 2014 (12.0.2000.8) 

(*) 表示在本课程的 2018A 版中升级的 
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15. 附录 A 替代参数 

定义替代参数  

下表中列出了替代参数。加粗项目是常用的“名称”替代参数。  

 

参数  将替换为此对象的名称：  

%..\Element%  
属性所属元素的父元素的名称。要检索进一步的父级，可以

使用 ‘..\’ 表示法，如 %..\..\Element%。  

%|Attribute%  保留该数据引用的根属性或属性模板的名称。 

%..|Attribute%  
属性所属的父属性的名称。要检索进一步的父级，可以使用 

‘..|’ 表示法，如 %..|..|Attribute%。  

%@Attribute% 
所引用属性的值。要检索进一步的父级，可以使用 ‘..|’ 表示

法，如 %@..|..|Attribute%。 

%\Element%  属性所属的根 AF 元素的名称。  

%<环境变量>%  
匹配的系统环境变量的值。例如，%COMPUTERNAME% 

可替换为执行数据引用的计算机的名称。  

%Analysis%  分析的名称（如果可通过上下文获取）。  

%Attribute%  此数据引用所属的属性的名称。  

%AttributeId%  此数据引用所属的属性 ID。  

%Database%  属性所属的 AF 数据库的名称。  

%Description%  此数据引用所属的属性的描述。  

%Element%  属性所属的 AF 元素的名称。  

%ElementDescription%  属性所属的元素的描述。  

mailto:%25@..%7C..%7CAttribute%25
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%ElementId%  此数据引用所属的元素 ID。  

%EndTime%  本地结束时间（如果可从时间上下文获取）。  

%Model%  模型的名称（如果可通过上下文获取）。  

%Server%  属性所属的 AF 数据库默认 Data Archive 的名称。  

%StartTime%  本地开始时间（如果可从时间上下文获取）。  

%System%  属性所属的 PI System 的名称。  

%Time%  本地时间（如果可从时间上下文获取）。  

%UtcEndTime%  
协调世界时 (UTC) 结束时间（如果可从时间上下文获

取）。  

%UtcStartTime%  
协调世界时 (UTC) 开始时间（如果可从时间上下文获

取）。  

%UtcTime%  协调世界时 (UTC) 时间（如果可从时间上下文获取）。  

.\ 当前引用 

[.] 
父集合的默认对象。例如，.\Elements[.] |Temperature 从

当前引用的元素集合的主元素中返回温度属性。 

[@filter=text] 

文本中的搜索字符串（如 Tank*）与给定过滤器相匹配。支

持的过滤器有：@Name、@Index、@Template、

@Category、@ReferenceType、@Description、

@Type、@UOM。 

[@Index=#] 从集合结果中返回位置 # 的结果。 

有关完成的列表，请参阅《PI System Explorer 用户指南》(PI System Explorer User 

Guide) 2015 版第 124 页中“配置数据引用”(Configuration of data references) 一章中

的“数据引用中的替代参数”(Substitution parameters in data references)。 
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16. 修订历史 

修订 检查人员 描述 

2010 Martin Bryant “使用 AF 构建 PI System 资产和分析”课程工作簿

的初始版本。 

2012 Linda Payne 在某些课程开展之后进行修订，以包括讲师提供的

注释。 

2012b Louis-Philippe Pagé-Morin 修订以包括 2012 版的新功能  

2014 Alejandro Molano AF 2.6 更新，增加了基于资产的分析章节、事件

框架章节和使用 PI Coresight 和 PI Datalink 的 

EF 可视化。 

2015 Linda Payne、Gerhard 

Polenz 
已使用矿用卡车应用程序替换 Pizza 运载车辆，针

对基于 Azure 的学习设置进行了更新 

2015a Linda Payne、Gerhard 

Polenz 
针对 PI Server 2015 进行了更新 

修订了章节 AF 对象安全性术语，增加了未来数据

章节 

2015b Gerhard Polenz 修订了练习 6.2.3（数据透视表），更改了 9.6 章

（现在由 AF 分析创建未来数据）， 

增加了章节 12.6.“如何从 Excel 中导入数据” 

2016a Gerhard Polenz 2016 软件升级。 

重新编写了与 Coresight 有关的部分，修订了 EF 

相关练习，属性特征、属性特性、多个资产视图、

ACE 可选 

2016b Gerhard Polenz 2016 R2 软件升级。 

重新编写了 Notification 部分 

2016c Gerhard Polenz 新的 TCE VM 安全性，新的学员密码 

2017 R2 Gerhard Polenz 2017 R2 软件升级，Coresight->PIVision 
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2018 Gerhard Polenz 基于 Windows 2016 Server (PISRV01) 的 TCE，

增加了 DisplayDigits，删除了 PE、Totalizer 和 

ACE 章节 

2018A、 

2018A2 

Gerhard Polenz 细微更正 

2018A3 Gerhard Polenz 虚拟课堂环境的备注 
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